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The HOT Toolbox is designed to provide the OSM Community with a repository of training materials,
complete with step-by-step guides developed by the HOT training team. The material covers everything
from setting up mobile devices to exporting OSM data for quality control and analysis. In addition to
consolidating HOT’s extensive training materials, this toolbox curates a large amount of other OSM
resources that support mapping projects; from software guides to guidelines on running mapathons.
HOT’s training materials are uploaded under a CC by 4.0 license which means they are free to use and
adapt - we simply ask that you credit HOT and maintain a Creative Commons License. Learn more
about Creative Commons and free use here.
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1.0 Introduction to Designing a Mapping Project

In this section, Project Managers will find guides, tools and resources to design a mapping project in-
cluding:

• Considerations and question guides for determining project factors such as scope, scale, and
logistics;

• Resources for selecting hardware;
• Guides and materials for planning workshops/trainings.

There is no one way to collect data in the field and it will vary by context. However, there are some essen-
tial topics and questions all project managers and OSM communities should consider when Designing
and Coordinating a Mapping Project.

• 1.1 Defining Needs and Requirements poses questions to answer when defining the scope of the
project, such as purpose, geographic scale, and what features to map, as well as ensuring that
the project takes into account the various contexts and stakeholders involved in the project.

• 1.2 Safety, Security, and Logistics for Field Operations contains guiding questions to help plan
for project logistics and security concerns. As all field operations involve some level of risk and
can involve many moving parts, it is vital to conduct a safety, security, and logistics review before
beginning field work on any project, regardless of experience.

These first two sections provide guiding questions and considerations, however, it is important to under-
stand that each project will have different variables that might not be covered. When designing a project,
be sure to use past experience, consult with other organizations, and meet with stakeholders to ensure
that you are covering all variables.

• 1.3 Selecting Hardware provides a guide on the various hardware, such as phones and laptops,
that could be needed for a project. Additionally, HOT has provided lists of specific models that
have been used in HOT field projects that have proven suitability.

• 1.4 Trainings and Workshops covers the requirements for running trainings as well as providing
resources such as example agendas and materials to provide.

Further resources and reading

In addition to this Toolbox, there are several guides that were developed to help teams in the project
planning process, some of which were borrowed from to develop this Toolbox.

• Open Mapping for the SDGs - Humanitarian OpenStreetMap Team (HOT) published a guide for
launching and growing open mapping initiatives at the national and local levels to achieve the Sus-
tainable Development Goals (SDGs). This guide can be found at: https://hotosm.github.io/gpsdd-
documentation/

• Open Cities Project Guide - the World Bank Global Facility for Disaster Reduction and Recovery
(GFDRR) and Humanitarian OpenStreetMap Team (HOT) published a guide that can be down-
loaded at http://www.opencitiesproject.org/guide/.

• Participatory Mapping Toolkit - Humanitarian OpenStreetMap Team (HOT) published a guide
for open mapping projects in the context of refugees. The full toolkit can be downloaded at
https://www.hotosm.org/downloads/Toolkit-for-Participatory-Mapping.pdf
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1.1 Defining Needs and Requirements

This section includes guiding questions and considerations that Project Managers and OSM communi-
ties should take into account when beginning a project including:

• Factors to consider when deciding what to map;
• Contexts that could impact planning and preparation;

• Considerations to make for involving stakeholders, communities, and how to select your team.

Overview

When starting a mapping project, it is important to define the scope of the project and understand the
larger context in which the data is needed, this includes understanding how to work with local stakehold-
ers and how the data will impact them.

Deciding what to map

1. Purpose and audience: All data collected needs to fulfill a specific purpose with an intended
use case and/or audience. This not only defines the scope of the project and data collected but
helps ensure that the data collection process is ethical and limits the burden on individuals and
communities being surveyed, even if indirectly. A helpful way to think about this to ask, what
problem is this project seeking to address or what question(s), or SDG indicator(s), are we hoping
this data will answer once it has been collected?

2. Geographic extent: Does this mapping project involve gathering information about a city, a neigh-
borhood, a whole country? Do the questions that the project needs answering logically connect to
a particular administrative scale? Or another sort of boundary?

3. Features: What, within the geographic extent, needs to be mapped? Roads? Buildings? Par-
ticular kinds of buildings such as schools or health facilities? Is there other information such as
land-use or natural features like rivers and forests that will also require mapping?

4. Attributes: What information about each feature will the team collect? For example, is knowing
the width or surface of roads important to the questions the project seeks to answer? The number
of stories of each building? The number of beds in each hospital?

The answers to these questions will help determine if there are any existing datasets that could be used
and the amount of time and resources necessary to complete the project. In some cases, it can be
helpful to run a small pilot project in order to determine the best approach to data collection and develop
an estimate of the level of effort required.

To collect good data you need to employ a well-defined data model. A data model reflects the information
you want to capture. Example SDG data models for OpenStreetMap can be found in Part 4. After
establishing a solid data model, it is important to create logical Field Data Collection Forms that capture
the data you are looking for in the best way.

Planning and Preparation

Before laying the groundwork for a field mapping project, there are several factors that you and your team
should consider. Below are a selection of factors and questions that should be asked in preparation for
dealing with them.

Political Climate:

• Government support - If a non-governmental organization, does local, regional, and national gov-
ernment support humanitarian activities in the area? Governments may either support or oppose
humanitarian organizations within their country.
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• Hostile activity - Is the area experiencing violence or hostile events? Is this activity involve groups
similar to your own? Is this a secure environment to conduct your work? A hostile climate canmake
it extremely difficult to carry out operations.

Communication

• Infrastructure – Is there a foundation of technology that supports an organization? This can be
related to actual hardware, software, networks, data centers, or the presence of electricity.

• Imagery Available – Is there good quality, high-resolution imagery available, from satellites or
other sources? Using aerial imagery as a background layer is considered to be the easiest way to
map, particularly when many buildings need to be digitized.

• Internet Access – Is there an Internet connection? What is the amount of bandwidth or level
of connectivity? Many tools rely on Internet access. If you don’t have an Internet connection, a
POSM may be a potential solution.

• Smartphones – Does the community have smartphones? Though not essential by any means,
mobile data collection is a recommended method of field mapping and is done using smartphones.

Literacy

• Map Literacy – Are communities aware of the basic conventions of maps, can they read them,
and do they use them?

• General Literacy – Does the community have the ability to read and write? Higher educational
levels can assist the mapping process.

Accessibility

• Terrain Accessibility – Are areas you want to map physically accessible?
• Transportation – How will you reach the site? Is there public transportation or do you need to hire
vehicles?

Coordinate with the local administration of the area you will be mapping

In many cases, mapping teams will need to carry an authorization letter or another form of permission
from local officials to show credibility and to reduce potential conflict that could arise during the field
data collection. We recommend that organizations and communities should request this letter from the
appropriate authorities well ahead of planned mapping activities to reduce the risk of delay.

Identifying and contacting partner organisations working locally in the area that you are planning to map
is critical to ensuring local buy-in, project success, and sustainability. While contacting these can be done
via email or a letter detailing your intent, in-person meetings have more weight and provide opportunity
to develop a stronger relationship.

Building a Mapping Team

In most cases, non-governmental organizations and governmental agencies will draw mappers from
within their own teams. However, organizations should consider the benefits of bringing in mappers
from partner organizations and local communities. When working within refugee environments, it is es-
pecially important to consider incorporating refugees (and host community members) into the mapping
process. By incorporating local communities, beneficiaries, and partners in the mapping team, partici-
patory mapping activities:

• Increase local buy-in and representation
• Allow communities to directly represent their needs and values
• Incorporate local knowledge and perspectives that might not otherwise be accessed
• Empower local community members with skill development

When deciding what individuals to work with, the following factors should be considered:

1. Community – Active participation by the affected population is essential to providing assistance
that best meets their needs. The first criteria for participant selection is being from the local com-
munity. Non-governmental organizations should also consider integrating local and/or national
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government staff to increase buy-in and data use. Government organizations conducting mapping
and survey activities should consider incorporating staff typically outside of geospatial activities
as well as staff from non-governmental partner organizations. Regardless, participation from the
affected population should be of the highest priority.

2. Motivation – Participants should have strong reasons for working. Motivations vary, but one of the
strongest factors is being emotionally invested in a project. Feeling like you are making progress
in meaningful work is a powerful motivator.

3. Non-Discrimination – no one should be discriminated against on any grounds of status, including
age, gender, race, color, ethnicity, sexual orientation, language, religion, disability, health status,
political or other opinion, national or social origin. None of these should be criteria in determining
participants. Take into consideration pre-existing social, cultural and political dynamics or practices
that may marginalize or exploit certain groups

4. Payment – As a general rule it is good practice to cover costs of active participants. For example,
if volunteers join your team as field mappers they should be paid per diems to cover transportation
and food. Projects rely on the data these volunteers collect, so it is an integral part of the work and
should not be treated lightly. Of course unpaid volunteers can and should also be active partici-
pants, but organizations must judge when the line is crossed into work to avoid exploitation. Lastly,
be mindful that even seemingly small payments can affect power dynamics in refugee communities
and households.

5. Gender – Organizations should be sensitive to gender but avoid using it as criteria to determine
participants, aligned with the non-discrimination principle. Within families, paying one member but
not another can have unintended consequences - either positive or negative.

6. Training Your Team - Questions to consider when training your team:

• What is the technical literacy of team members? Certain groups will require longer lengths
of time to learn an application or tool than others.

• What tools will you be using? The tools you use will determine the length of time and
skill level demanded of your team. Additionally, the number of tools you plan to train team
members in impacts the length of training and time necessary to master a skill or tool.

• Will you be able to have hands-on and field training? Training teams in tools using hands-
on approaches, including conducting trial fieldwork greatly increases the success rate of mas-
tery and improves data quality. All trainings should incorporate a practical session if possible.

• Will you have consistent access to internet and electricity? Some tools require internet
and computer use for training.

Community Entry

Community entry is the process of initiating, nurturing and sustaining a relationship in order to secure
a community’s participation and interest in a program. Whether preparing to engage with refugee and
host communities in a settlement setting or local communities in a capital city, there are a few recom-
mendations and practical questions that can guide your team in mindfully establishing a relationship with
a given group and setting the stage for activity implementation in a community.

The most important thing to keep in mind is how individuals can be part of the work as members of
projects. They must be given ownership. Before starting a project, objectives and strategy should
be shared with community members. They should give feedback, and this should be incorporated. If
certain members of the community are not given roles in the project, both in terms of strategy and
implementation, you may face problems down the road.

In the context of working with refugees, for example, who are used to seeing new projects with skepticism,
it is especially important that your approach to engagewith and inform these groups of the upcomingwork
is prioritized over activity implementation and achieving results. Many organizations and individuals use
humanitarian crises as opportunities to exploit people – whether deliberately or through incompetence.
It is crucial to build trust and respect between the organization and community. Though protected
under international law, refugees in host countries are subject to municipal and national authorities. The
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presence of refugees can put pressure on host communities, which often fuels prejudice. Therefore, the
final aspect of successful community entry is taking into account the host community’s concerns.

A few practical questions can guide us in appropriately engaging with local communities for the first time:

• Who needs to be informed about your intent to enter a community?
• What documents do you need before entering a community? Permission may include permits
or a letter of permission from local authorities acknowledging your presence and activities in the
community.

• How can specific groups or individuals in the community be involved in the project?
• What is the most appropriate way of communicating about roles and responsibilities for a project
to these groups?

• Where can you seek information about the dynamics between groups in a given community? How
do you ensure you understand tensions or conflicts between groups you intend to work with?

• What measures are in place to mitigate or manage - if any - conflicts arise?
• Example: In the context of working with refugee and host communities, are you confident there
will not be any resentment between groups working on the same project?

Other practical recommendations to ease your organization’s entering into a new community:

• Set up consultation meetings with relevant leaders and community members to gather feedback
about proposed activities and timeline

• Articulate benefits of projects involvement to all who are involved
• Include a community member - who is familiar with local laws and customs - in your project team
• Establish relationships and work through partners already based in the community to ease activity
implementation and enable integration into existing initiatives

• Create a Whatsapp group to enable direct and more efficient communication
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1.2 Safety, Security, and Logistics

In this section, Project Managers will find questions and considerations on assessing needs for safety,
security, and logistics for field operations. ***

Overview

For projects requiring field work, you will need to take extra steps to ensure that logistics and security
are effectively handled. The following are topics that project managers should consider and have plans
for before entering the field. Work with donors, local partners, and stakeholders to fill information gaps
and meet these needs.

Logistics

There are many components to managing logistics for field operations. The topics listed below are just
a few components that we recommend all organizations and communities consider prior to starting field
mapping activities.

Workspace / Meeting space

• Do your operations require a workspace or meeting place?
• Does your operations require a central base with full-day access and wi-fi?

Equipment

Different scopes of work will require different types of equipment. For example, ODK and Kobo software
can run on most Android devices, but OMK software requires higher specifications.

• What type of mobile devices will you use to collect data? (Mobile phones, tablets, GPS devices,
etc.)

• Does everyone on the team have access to data collection devices? Will you need to procure
hardware?

• Does everyone on the team have access to computers/laptops? Or will the team plan to work in
shifts?

Refer to Section 1.3 Hardware for guidance on selecting mobile devices, laptops and other hardware
for your project.

Transportation

• How will mappers move around in the field?
• Is the scope of work/area of interest large enough that mappers will need transportation beyond
walking?

• What types of transportation are available?
• What types of transportation are safe for the context and circumstances?
• Will this type of transportation have associated costs? (i.e. driver fees, rental, fuel)

Safety & Security

Each context is so different that it is difficult to make specific recommendations for safety. Communi-
ties and organizations conducting mapping activities should establish contingency plans to address the
different types of security incidents that may occur. Team members should coordinate all responses to
such incidents so as to safeguard the rights and well-being of local community members, and ensure
that staff members and volunteers are not put at risk.

For operations, the key to effective safety and security management is the creation of a culture of security.
Each staff member and volunteer has a responsibility for their own safety and security, and that of other
team members.
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Please note: The below topics are suggestions for mapping teams to consider when building and dis-
cussing security plans for mapping activities, and is in no way comprehensive.

• Personal Security - What is the appropriate behavior, dress code, language, and forms of com-
munication when interacting with local communities and other stakeholders? Does everyone on
your team understand these factors?

• Legal requirements - Do you have a letter of permission to conduct field activities? Does your
team understand local laws and customs?

• Communications - Do you know which communication networks are best for your area of work?
Have you provided all team members with internal and external contact details? Have you devel-
oped and communicated contingency plans to your team? Does your team have a method for
reporting incidents and do team members know how to use it?

• Travel - What types of travel will be required for this work? What attire, visibility, documentation is
necessary for travel? What types of risks (i.e. crime, accidents) are teams exposed to?

• Common Crime - What types of crime are common in the area of work? What is the frequency
and occurrence of crime?

• Medical Emergencies - Are managers and supervisors aware of teammembers’ pre-existing med-
ical conditions? Does everyone on the team know or have access to information on the location
and contact information for local health facilities and emergency services? Do all teams have
access to a first aid kit? Is someone on each team trained in first aid?

For operations, the key to effective safety and security management is the creation of a culture of security.
Each staff member and volunteer has a responsibility for their own safety and security, and that of other
team members.

Tips:

• Know the emergency services numbers for the local area
• Always have access to a first aid kit
• Teams should have someone trained in first aid
• Let people decide where they work and feel most safe in
• Avoid performing field work alone
• Always obtain relevant permits, licenses, permissions, and visas for work
• Develop a country specific security plan
• Create a minor incident and suspicious activity report
• Establish a process for regular monitoring and review of hazards
• If operating outside of your home country, sign up for travel alerts from your embassy

Additional Resources

• HOT General Hazard Mitigation Advice
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1.3 Selecting Hardware

In this section, Project Managers will find information on selecting the appropriate hardware for conduct-
ing a mapping project including:

• Determining what hardware may or may not be needed.
• Specifications and recommended models for mobile devices, tablets, and computers based on
project needs.

• Guides on additional equipment that may be needed such as power banks and hard drives.

Overview

Hardware encompasses all physical assets related to technology, computers, and electronics needed
for a project. When designing a mapping project, managers will need to assess what hardware, and
specifications, are necessary to complete the work. While the anticipated project workflow influences
the selection of hardware, it is important to note that the availability of technology and resources for
procurement may place restrictions on hardware selection. In this way, hardware availability can also
influence the workflow, making hardware selection an important part of the planning process. Questions
to ask during hardware selection:

• Will mappers be collecting data in the field? If yes, see Mobile Data Collection: smartphones &
tablets to determine what devices are best for field data collection.

• Will mappers be collecting data for more than: 4 hours a day with OpenMapKit and/or naviga-
tion/tracking apps? 6 hours with OpenDataKit or KoboCollect? If yes, see Powerbanks and charg-
ing.

• Will data need to be stored or backed up physically? see Storage Devices: POSM & Hard Drives
• Will there be digitization and editing of data? Will maps and visualizations need to be made from
data? See Computers to understand what specifications are needed for different activities.

• Will there need to be drone imagery capture? see Drones and UAVs to understand what machines
are best suited depending on the need.

• Will there need to be street view imagery capture? see Street view imagery: phones, cameras,
and 360 devices.

Mobile data collection: smartphones & tablets

Smartphones versus tabletsWhen choosing a type of device for mobile data collection, it is important
to determine if a smartphone or tablet is more appropriate for mapping activities. Each device types
have pros and cons, so it’s important to understand what is best for a particular project, mapper, and
environment.

When planning to use OpenDataKit:

Most any Android smartphone or tablet will do, as long as it has a relatively modern Android version
(4.1+).

When planning to use OpenMapKit:

To enable OpenMapKit to run fluently and be able to handle larger background maps (in ‘mbtiles’ format)
and OSM data, please make sure that phones have:

• At least 1.5, but preferably 2 GB of RAM
• Preferably 16 GB of storage
• A modern Android version (6.0+)

Furthermore, the following are recommended:

• A 5” screen for usability
• A decently sized battery. For extended usage, it may be necessary to have battery packs
• Make sure to have enough charging options, such as car chargers and extension cords
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The following phones/models have been verified to work well on various projects:

Smartphones:

• Tecno Camon C9 (2 GB RAM)
• Tecno L9 (2 GB RAM, 16 GB storage)
• Huawei Y5 (2017) and Huawei Y6 Pro (2 GB RAM, 16 GB storage)
• Sony Experia L1 (2 GB RAM, 16 GB storage)
• Motorola Moto G5 (2 GB RAM, 16 GB storage)
• Infinix

Tablets:

• Samsung Tab A (SM-T285, 7”, 2016) (1.5 GB RAM, 8GB storage)
• Huawei Mediapad t3 10 AGS-W09

Protecting mobile devices HOT recommends that cases are procured for all mobile data collection
devices, regardless of type. This will help protect the devices from weather, dropping, sun exposure,
and other hazards. Ultimately, protecting devices not only reduces costs associated with device loss or
replacement, it also protects the loss of data stored in the devices.

Power banks and charging

When using mobile devices for data collection, ensuring that devices can remain charged throughout the
day and be recharged is critical. HOT recommends procuring power banks when possible to ensure that
devices are ready for mapping. Each project (and applications used) will have different drain on mobile
devices, in general, HOT has found that consistently collecting surveys with OpenMapKit and running a
GPS application in the background (i.e. OSMAnd, OSMTracker) will drain a typical device battery in 3-5
hours - requiring the need for power banks to work through the entire day. When selecting power banks,
it is recommended that they are tested for compatibility with the mobile device used.

In addition to keeping devices charged during the day, project managers need to consider how all devices
(including power banks) will be charged at the end of the work day. Will mappers have access to power
at night? Does your team have enough outlets or power strips to effectively charge all of your devices?
Will mappers need to find alternative options for charging devices?

Storage Devices: Hard Drives and computer back-ups

When collecting survey data in the field, accidents can happen including lost, damaged, or stolen mobile
data collection devices or laptops. For that reason, it is important to have a data storage strategy to
ensure back-ups exist. It is much easier to recollect one day’s worth of field data than to completely
redo all of the work. Multiple laptops with duplicate back-ups and hard-drives are effective ways of
keeping back ups, even if your team is using a cloud server. Storage devices should have at minimum
1 terabyte of storage.

Street view imagery: phones, cameras, and 360 devices

Mapillary provides an up-to-date list of recommended equipment for capturing street view imagery here.
In addition to recommended devices, this list provides additional equipment recommendations including
mounts, memory cards, charging, and cases. Additionally, HOT has used mobile devices provided in
the OpenMapKit list above for street view imagery capture.

Computers

Determining the specifications, quality, and type of computer depends on the needs of the project or ac-
tivity. At minimum, computers involved with mapping activities should have the following specifications:
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• 15” screen or larger
• Processor: Core i5, relatively new
• RAM: preferably at least 8gb
• 512 GB hard disk or larger
• Operating system: Windows or Linux preferred for most applications

The following computers have been verified to work well on various projects, categorized by typical use:

a) Training, data cleaning and basic GIS/data processing

• Lenovo Ideapad 320
• HP 250 G6
• Lenovo ThinkPad X234
• DELL Latitude E6430s
• HP Elitebook 840

b) Advanced GIS and drone imagery processing

• Acer Aspire e5-575
• Lenovo P50

Drones and UAVs

When quality imagery is not available or up-to-date imagery is necessary for a data collection process,
such as capturing the impact of a recent flood or to capture newly constructed buildings, using a drone
or unmanned aerial vehicles (UAVs) may fulfill imagery needs. Selecting a UAV/drone depends on the
need of the project and available resources. Drones/UAVs are generally classified into three types based
on mode of flight. See the table below for a comparison of the different types. Note: cost is based on
HOT experience and is not necessarily representative.

Type Flight time Max speed Payload Coverage Cost range

Multi-rotor UAV 25-45 minutes 45-60 mph 450g-5.5kg 2-7 km2 $3-65k
Fixed Wing UAV 45 minutes 40-110 mph 1-3 kg <12 km2 $25-120k
Hybrid UAV 60 minutes 70-120 mph 1-6 kg <13 km2 $30k+

In brief, multi-rotor UAVs are best suited for small-scale operations with smaller mapping areas and/or
quick response time for flight deployment (i.e. responding to natural disasters), whereas fixed wing UAVs
are better suited for aerial mapping of large areas.

For HOT projects, we have selected and used the following drones:

• Multi-rotor: DJI Phantom 4 Pro
• Fixed wing: senseFly eBee

Please note: anyone interested in drone flying should understand local drone/UAV laws and regulations,
as well as seek out proper training in piloting.

Hardware Management Considerations

• Create and have all mapping participants sign an agreement for the responsibility and liability of
devices

• Create an equipment sign out log
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1.4 Trainings and Workshops

In this section, Project Managers will find information on considerations and resources to use while
planning trainings and workshops for mapping and OSM, including:

• Guidance on training requirements
• Examples and resources for creating training agendas
• Considerations for presentations and other provided materials.

Overview

Most mapping projects will involve trainings or workshops of some kind, whether training field mappers
to use OpenDataKit, training local government stakeholders how to export and use OSM data, or training
students in QGIS for creatingmaps. During the planning stage, project managers and OSM communities
should anticipate what trainings are necessary and what resources will be required to run each training
or workshop.

Training Requirements

Attendee requirements
Requirements for attendees will vary depending on the scope of the trainings, the intended participants,
and the available resources. No matter the scope of the training, it is important to communicate these
requirements BEFORE the training so that participants can come prepared.

Some attendee requirements may include:

• Have a laptop and mouse.
• Be computer literate with basic computer skills.
• Have enthusiasm and willingness to collaborate with others.
• Attendee’s computers should have sufficient free disk space (approx 10GB) and attendees should
have administrator rights so that they can install software on their computers.

• Attendees should have a PDF document viewer installed on their computers.

Workshop venue requirements

• Wi-Fi Capability
– If the venue can provide Wi-Fi, confirm with the venue managers that the Wi-Fi has enough
capacity for the number of attendees expected to show. For example, if you expect 10-15
people to show up to your event, the Wi-Fi will need to be capable of hosting 15-20 internet
connections - remember, you will need to connect as well!

– If there are no venues with wi-fi capability, consider the option of using a Mi-fi device or other
Hotspot options

• Space, tables, and chairs to provide for your expected attendance.
• Enough power outlets for charging laptops and other devices.

– If this is limited, you’ll need to consider power strips and extension cables.
• Generator/electricity access for duration of workshop.

Creating an Agenda

Training Agenda Examples

• Three-day field mapping workshop
• Two-day GIS workshop

Training Agenda Template

• Template
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Presentations

After developing the agenda, you will need to determine what presentations are needed for each activity.
HOT Training Presentations provided in this Toolbox are available for teams and OSM Communities to
use with credit provided to HOT. Navigate through the Toolbox to appropriate sections for presentations
needed.

Tools, Software, and Materials to Provide

It is highly recommended that prior to the training/workshop, all necessary installation files are down-
loaded and loaded onto USB drives for offline installation. Sections throughout this Toolbox introducing
tools include links to the installation files you will need.

Additional Resources

• Beginning OpenStreetMap Trainer Toolkit
• Intermediate OpenStreetMap Trainer Toolkit
• Advanced OpenStreetMap Trainer Toolkit
• TeachOSM
• LearnOSM

– Mapping Party
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2.0 Introduction to Digitization and Editing in OSM

In this section, Project Managers will find tools and resources to lead and implement organized Open-
StreetMap editing activities including:

• Presentations and step-by-step guides for introducing teams to OpenStreetMap and editing tools
such as the HOT Tasking Manager.

• Resources for determining if your project needs to meet OSM Organized Editing Guidelines
• Detailed guides and training activities for digitization teams to use during validation and data upload

Digitization, or remote mapping, is the process of tracing features such as buildings and roads from
aerial or satellite imagery to create map data. OpenStreetMap relies heavily on users generating data
through digitization.

With OpenStreetmap at the core of our tools and workflows, mapping projects using HOT tools and
workflows will likely incorporate digitization or editing of OSM data during one, in not multiple phases in
the project timeline. While numerous resources exist to teach new users how to use OpenStreetMap for
the first time, this section is largely designed to guide project managers and community members through
the digitization process from the perspective of leading trainings and managing teams conducting OSM
editing. Users looking for guidance on individuals mapping in OSM should look to LearnOSM.org as a
resource.

• 2.1 Introduction to OSM contains a brief overview of OpenStreetMap with the purpose of being
distributed as supplemental training guides.

• 2.2 Organized Editing Guidelines covers considerations project managers and communities should
make when organizing focused digitization or editing campaigns.

• 2.3 Working with the HOT Tasking Manager provides an overview of HOT’s tool for crowdsourcing
OpenStreetMap edits, as well as a guide for setting up tasks in the Tasking Manager.

• 2.4 Editing with iD and JOSM Editor provides guidance on selecting the appropriate OSM editing
tool for your project or event, and training materials using both tools.

• 2.5 Validating with JOSM dives into the validation process step-by-step.
• 2.6 Resolving conflicts in JOSM provides additional assistance for teams conducting advanced
OSM editing.

The following presentation(s) can be used to lead a training or workshop:

• Introduction to OSM
• Introduction to HOT Tasking Manager
• Mapping with iD Editor
• Mapping with JOSM
• Validating with JOSM
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2.1 Introduction to OpenStreetMap

This section provides:

• An overview of OpenStreetMap, including presentation slides
• Step-by-step instructions for creating OpenStreetMap accounts
• Step-by-step instructions for using and navigating OSM
• Considerations for training large groups

The following materials are designed to assist project managers and others leading trainings and work-
shops. If you are an individual interested in learning how to map with OpenStreetMap, please visit
LearnOSM.org.

Overview

OpenStreetMap is a collaborative project to create a free editable world map and is at the core of HOT’s
mapping activities. You are free to use it for any purpose as long as you credit OSM and its contributors.

The power of OpenStreetMap is that it empowers anyone, anywhere in the world to add information to a
collective map and use the data for any purpose. You can think of OSM as the “Wikipedia of maps” – it is
an online database and global community of over 5million registered users. This community collaborates
to build a free and open map of the world to which anyone can contribute and which anyone can use in
their own context. All that is needed to contribute to OSM is an internet connection and email address.

OpenStreetMap can, and has, been used for a wide variety of purposes - from disaster response to
commercial use. The first organized use of OSM in disaster response was following the 2010 Haiti
Earthquake. As high-resolution imagery of the affected area was made available to the public, over 600
individuals from the global OSM community began digitizing the imagery and tracing roads and other
infrastructure. They made what quickly became the most detailed map of Port-au-Prince in existence,
which was then used by search and rescue teams to help route supplies around the devastated capital
and to coordinate many other aspects of the response and reconstruction effort.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Introduction to OSM

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

• Step-by-Step Instructions: Opening OSM Accounts
• Step-by-Step Instructions: Using OSM

Opening OSM Accounts

With OpenStreetMap (OSM) at the core of mapping activities, it is critical that all team members and
participants have activated OSM accounts. This will be necessary before using many mapping tools
such as HOT Tasking Manager, JOSM, and HOT Export Tool. This section covers how to:

• Create an OpenStreetMap Account

Skills and Technology Needed

• Computer
• Activated email account
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• Internet connection

Creating an OSM Account

To get started, you will need to create an account on www.openstreetmap.org. Please use the “Sign Up”
tab in the top right corner to begin.

Please fill in all the fields in the form. We recommend using an email you have easy access to e.g. your
work email, as you will receive a confirmation email to verify your account. You will not receive any
spam/marketing emails. Click the blue “Sign Up” button when finished.

Note : If a problem occurs, a problem message will appear. Make sure that the email you
entered is the same as in the first two boxes and your password. If the box for the user name
is red then someone else has already used the name and you have to look for another name.

Next, please read and accept the contributor terms and agreements by selecting where you are based
(France, Germany, or the Rest of the World), and clicking the blue “Agree” button on the bottom of your
screen.

To activate your account, please now check your email and click on the link provided.

On the OpenStreetMap page, click Log In in the upper right corner. Enter your OpenStreetMap user-
name and password then press Enter. You should now be logged in and you will see your username
on the top right of the OpenStreetMap site.

Considerations for signing up large numbers of individuals

• Prior to beginning the OSM registration process, all individuals signing up for OSM accounts will
need to have an existing and accessible email account. If registering a large group of individuals
at one time, we recommend asking the group if they have accessible email accounts. When plan-
ning mapathons and trainings in areas where regular email use may be low, we also recommend
planning for time in assisting individuals with setting up email accounts.

• Consider internet connectivity and capacity prior to registering large numbers of individuals for
OSM accounts. Having individuals taking turns to register or running registration simultaneous to
other activities can reduce the load on a slow internet connection.

• It is crucial that usernames and passwords are remembered by participants so that they can access
other tools that require OSM accounts to log-in. We recommend encouraging participants to find
a way of safely storing this information for future reference.

Using OpenStreetMap

After creating an OpenStreetMap account it is important to understand basic skills in navigating Open-
StreetMap. This section covers how to:

• Operate and navigate the OpenStreetMap website
• See object information in OpenStreetMap
• Create share link in OpenStreetMap
• Save images from OpenStreetMap
• Understand the basic concept of attributes in OpenStreetMap
• Understand history in OpenStreetMap

Navigate the map

In the main view of the OpenStreetMap website, you will see a large map in it. You must be able to
navigate the map so you can go to a location that you want. Here are the ways to navigate the map on
OpenStreetMap:

• Use the left mouse to drag the map view. Left-click on your mouse, then hold and drag the map to
the location that you want. If you don’t have a mouse, you can press and hold the right touchpad
and then move the cursor.

How to drag the map view

How to drag the map view
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• Use (+) and (-) button in the upper right corner of the map to zoom in and zoom out the map view.
You also can use your mouse scroll-wheel to zoom your map. Scroll your mouse up to zoom in,
while scroll down to zoom out.

How to zoom in and out the map view

How to zoom in and out the map view

• To search the location based on the name, type the location name on the Search box in the upper
left side on the screen. You can type it in the search column, then press Enter or click Go. After
that a Search Results box will appear below the search column, then you can choose and click
on the search. The map will automatically move to the location you chose.

Steps to find location using Search box

Steps to find location using Search box

• To display your current location, you can go to the map panel to the right of the map and click
Show My Location button. Then, the map will automatically display your current location point
(blue dot). Make sure to enable the GPS on your laptop or computer to allow OSM to get your
current location.

The display of Show My Location feature

The display of Show My Location feature

Change different style options for the map

OpenStreetMap contains geographic data from all over the world. Although stored in one database, the
data can be displayed in several styles. The steps to change style map in OSM are as follows:

• Click Layers button in the right panel on the map.

The Layers button to change background layer

The Layers button to change background layer

OSM has four types of layers with different functions, namely:

• Standard: This layer shows all the objects on the OSM map.

Standard Layer

Standard Layer

• Cycle Map : This layer emphasizes cycling routes and pedestrian roads.

Cycle Map layer

Cycle Map layer

• Transport Map: This layer emphasizes transportation routes on the map such as highways and
bus stop.

Transport Map Layer

Transport Map Layer

• Humanitarian: This layer emphasizes important objects or amenities on the map such as school,
hospital, etc.

Humanitarian Layer

Humanitarian Layer

View object information in OpenStreetMap

In the OpenStreetMap page, besides see the current location and navigate the map, you also can see
the feature information using Query Features. The steps to use Query Features are below:

• Click on Query Features button on the panel in the right. After you clicked it, you should see the
question mark on your cursor. This indicates that the query features function is activated.
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Query Features button

Query Features button

• Now you can choose an object or location that you want to identify. For this example, we click on
a governmental office building (Dinas Kesehatan) in Jakarta.

• You should see a box appears in left corner that displays Nearby Features and Enclosing Fea-
tures options. Nearby Features shows the description of any object that is closest to the location
of your chosen point, while Enclosing features shows all the object information that have a close
range location with your chosen point. Try to click one feature in the Nearby Features, click Gov-
ernmental office Dinas Kesehatan for this example.

Nearby features dan Enclosing features in Query Features

Nearby features dan Enclosing features in Query Features

• After you clicked it, the information detail about Dinas Kesehatan building will appear in the left
box. The information displayed is a tag or object attribute regarding general information objects
such as object names, addresses, building levels, and others.

Query Features result

Query Features result

Share map locations in OpenStreetMap

You can share links of your OpenStreetMap maps to others for various purposes, such as sharing the
location of your current position with your colleagues and so on. To be able to share OpenStreetMap
maps, the steps are as follows:

• Click the Share button on the right panel, then the Share column will appear.
• Check the Include marker to add the location marker point. You can move or drag the marker
point to the desired location. Just click and hold the location marker then you drag to the desired
location point. Another way is to shift the map so that the location marker is in the position you
want.

Add marker point

Add marker point

• Once the marker position has fixed, you can copy the link in the Link box and share the link
according to your needs. You can also copy a shorter version of the link in the Short Link box or
copy the HTML code in the HTML box.

Share the link of the map in OpenStreetMap

Share the link of the map in OpenStreetMap

Export map as an image

Besides changing the layer map, you also can export the map as an image and choose the various
format file such as .png, .jpg, .svg, and .pdf. The steps to export the map are as follows:

• Click on the Share icon in the right of your map. Then the Share column will appear on the right
side of your screen.

Share button to export the map

Share button to export the map

• After that, specify the area on the map that you want to export as an image. Give a check mark
on the Set custom dimensions box in the Image section, then adjust the size of the box or adjust
the scale in the Scale section.

Note : You can only export map as image if you set the Standard Layer view. If your map
does not use the Standard Layer, you need to change it first on the Layers menu.

• You can choose the format of the export image in the Format dropdown menu. After that, click
Download button to download the image and save the image to your folder location.
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Image section to export the map

Image section to export the map

View the editing history in OpenStreetMap

When you edit objects or make changes to OpenStreetMap, you can see the editing history of objects
in that area. The steps to see editing history are as follows:

• You can see the information by clicking on the History menu button on the top left of the map.
• After that, the Changesets column will appear at the bottom of the Search box and orange boxes
will appear on the map that indicates which areas have just been edited. Changeset is a version
of every change uploaded by OSM users. The information that we can see in the Changesets
column is as follows:

1. Changeset comment. It is recommended that you write the short comment when uploading
changes or changeset. Comments can contain information about any changes that you made or
specific hashtags.

2. Upload time information.
3. OSM username.
4. Changeset number. This number is a unique number as the changeset identity.

Changeset history in OpenStreetMap

Changeset history in OpenStreetMap

• You can click one of the changeset on the changeset list or you can immediately select the orange
box on the map. After you select one of the changeset, you will get details about the changeset.

The changeset details

The changeset details

Basic concept of OpenStreetMap attributes

1. The attribute concept on object

When you draw an object as a point, line, or polygon in OSM, you still need to add information
about the object such as object name, address, or other supporting information. This information
will help other users when using OSM data for various purposes. Information provided by users
on OSM objects is called an attribute or tag.

An attribute/tag is like a label that you can place on an object. For example, if you draw a square,
this is only a square without any object information. But you can add attributes to describe that
object, for example you draw a square that is is a building; the name of the building is “Tebet
Hospital”; 10 level building.

2. Components in OpenStreetMap attribute data

You can add as many attributes / tags as you want to an object. Attributes are stored as a pair
of text, named Key and Value. Key is general information that explains the function of an object.
In one key, it can consist of many values. For example schools, mosques, and hospitals have
key=amenities (important facilities). Although the three objects have different types of functions,
but all three objects have the same key. Whereas Value is information that more specifically ex-
plains the type of an object. Because this value describes specific information about an object,
so that one type of value can only describes the type of the object itself. Not the same as a key
that can explain general information about the object. In OpenStreetMap, an attribute is added by
formatting a key-value pair that represents physical features on the ground, for example:

The example of object attributes

The example of object attributes

In the example above, there are four kinds of key & value attributes, including object amenities for
hospital (amenity = hospital), building objects (building = yes), building level 10 (building:levels =
10) and object name Tebet Hospital’ (name = Tebet Hospital).
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Additional Resources

• LearnOSM - Introduction to OSM
• OSM Wiki - Abot OpenStreetMap

• Two Minute Tutorial - What is OpenStreetMap?
• Two Minute Tutorials - How to sign up for OpenStreetMap
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2.2 Organized OSM Editing

This section provides:

• Considerations for managing and sourcing mappers for an organized editing project
• Overview of the OSM Organized Editing Guidelines and compliance
• Step-by-step guide for complying with the OSM Organized Editing Guidelines

Overview

Before starting any mapping project, it is important to assess, and if necessary, update the Open-
StreetMap basemap through remote mapping. This remote mapping process helps ensure that the
buildings and roads used during a field mapping phase are up to date, improving the quality and effec-
tiveness of field mapping efforts. For example, using remote mapping, your team can identify buildings
or entire villages that might have been missed otherwise.

While the anticipated project workflow influences the area to be remotely mapped, it is important to note
that the budget and time available may place restrictions on what is feasible to be digitized. In this way,
remote mapping can also influence the workflow, making the remote mapping plan an important part of
the planning process.

No matter the scope of your project you will need to determine:

• Who will be digitizing for your project?
• How will you manage your organized OSM editing efforts?
• Do Organized Editing Guidelines requirements apply to you?

Sourcing your remote mappers

Remote mapping takes time and effort. This process can take several different forms ranging from being
quickly completed with a few volunteer mappers for a small area to an organized, paid team working
for several months to complete a region. The resources and time needed to map your area of interest
depends on:

• Size of your area of interest: Are you mapping one city or an entire district?
• Timeline: Does the area need to be mapped in a few weeks? Months?
• Resources needed: Does your project have budget to pay digitizers and validators?
• Quality: What are your resources for ensuring that the mapped data is high quality? Does the
data need to be immediately high quality, or is there room for new mappers to make mistakes?

• Features and attributes: Does your project require only buildings to be mapped? Roads? Will
any features (such as roof:material) be added by remote mappers?

Sourcing Options

The following a few recommendations on how to organize and source your mappers based on our best
experiences.

• Global HOT/OSM Community: The global community is a wonderful and FREE source of remote
mappers. As of September 2019, 180,000 volunteers from around the world have mapped over
2 million tasks on HOT’s Tasking Manager to support mapping efforts around the world. Here are
some considerations to make when utilizing the Global HOT/OSM Community for remote mapping
efforts:
– Size of AOI: With a large pool of individuals to choose from, the global community can cover
any size of digitization efforts, from a neighborhood to entire countries.
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– Timeline: While the global community is known for it’s rapid response in the wake of disasters
and immediate humanitarian needs, other types of projects should not rely on the community
to map areas within a controlled timeframe. Relying on the global community to map a district
in Liberia, could take a week or several months depending on interest in the project and other
urgent mapping needs.

– Quality: The disadvantage of using the global community for remote mapping efforts is that
it can be more difficult to control the quality of data being immediately mapped. While all
remote mapping should be validated, the wide range of skills and experience (as well as
understanding of the project needs) could mean that additional efforts will be required to
review and fix any mistakes made by remote mappers.

– Resources needed: As already stated, using the global community for mapping has the great
advantage of being completely free!

– Features and attributes: Tasks best suited for the larger community are those that are simplest.
Additional instructions beyond tracing buildings is feasible, but extra checks will be necessary
for coverage as some mappers may miss detailed instructions.

• Dedicated team of digitizers (5+ people): Some projects may find that the best way to meet
the needs of their project is to hire a small team of dedicated digitizers to systematically map an
area. Typically this dedicated team works together in-person, which allows for consistent training
and quality assurance. However, it is possible to use a paid team of mappers working remotely
if mappers are experienced and do not require extensive training. We do recommend that when
looking to hire a team of mappers that you reach out to the local OSM community with these
opportunities. Here are some considerations to make when utilizing a dedicated team of digitizers
for remote mapping efforts:
– Size of AOI: Like the global community, digitization teams can cover any amount of area with
enough time. As team members are dedicated to the mapping task, digitization teams can
handle larger areas over a shorter period than the global community.

– Timeline: For meeting tight deadlines, a dedicated team of digitizers can be the best option
as it ensures that the mapping task can be effectively planned and executed. Meeting that
timeline does depend on the number of digitizers hired and their experience. HOT has found
that newly trained teams of digitizers can map 500-1000 buildings a day depending on the
imagery quality and density of mapping.

– Quality: Having a dedicated and paid team means that it’s easier to train and manage the
data quality of the mapping efforts.

– Resources needed: Budget for paying digitizers is required. Also recommended is providing
a dedicated workspace and consistent internet connection, as well as laptops where needed
if working with mappers on location.

– Features and attributes: By working directly with individuals, you can ensure that all spe-
cial features and attributes your remote mapping campaign requires are consistently added.
Having local context (such as recognizing roof material) is also extremely helpful for adding
unique features and attributes.

• Mixed approach: paid digitizers and global community: When there are timelines in place but
the scope of the work is too large for your team, one option is to have a mix of paid digitizers and
the global community. Here are some considerations to make when taking a mixed approach for
sourcing remote mapping efforts:
– Size of AOI: If you have a small team, combining efforts with the global community can help
you achieve a much larger area.

– Timeline: By including some paid digitizers, this method can help keep the project in
development while relying on the global community.

– Quality: Additionally, by including paid digitizers, your team can choose to focus on validating
the efforts of the global community and increase the consistency of quality mapping edits.

– Resources needed: Smaller budget than a full team, but will still likely need to provide a
dedicated workspace and consistent internet connection.

– Features and attributes: If there are unique features and attributes that rely on local context,
you can rely on the global community to develop the basemap and then your paid team can
add those features later. Or, you can use your small team to validate the special features and
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attributes added by the global community.
• Hosting Mapathons: Another option that blends utilizing volunteers with some of the benefits
of a dedicated team is hosting a series of Mapathons. These mapathons typically bring together
groups of volunteers (ranging from university students to corporate volunteer events) to map a task
together in person. Here are some considerations to make when hosting mapathons for remote
mapping efforts:
– Size of AOI: The amount of area that can be covered depends on the number of people
attending the mapathons, the number of mapathons hosted, and the skill level of volunteers.
In general, this option is only recommended for smaller areas.

– Timeline: This option can be faster than relying solely on the global community, but slower
than having a dedicated team of volunteers. Again, the speed of mapping depends on the
skill level of the mappers, frequency and number of events, if the same mappers attend each
event, and how much training will be required.

– Quality: Since mapathons generally bring new or inexperienced mappers together, ma-
pathons have the possibility of requiring more effort on the validation side of mapping.
However, if the same attendees regularly participate, this data quality will increase.

– Resources needed: Smaller budget than a dedicated in-person team, but event space, inter-
net, and refreshments will need to be covered.

– Features and attributes: If your mapping project requires unique features and attributes, map-
athons allow for better training and management of volunteers adding that information. How-
ever, similar to data quality, this will still require a heavier lift in validation than using a dedi-
cated team.

Whenever possible, we recommend sourcing local mappers to be part of the digitization efforts. And
remember, it is critical that no matter what plan you choose, that it includes a validation and quality
control plan!

Managing your digitization efforts

Once you decide how you will source your team of mappers (paid or unpaid, local or remote), you will
need to set up a plan and gather resources. Here’s a checklist of some questions to consider:

• What will be your team structure? We recommend having one dedicated validator for every five
digitizers.

• Have you trained validators? Our training materials for validators are available here.
• How will you track the progress of your mapping? When setting up a large number of mapping
tasks, it helps to set up a tracker to monitor the progress of all tasks.

Organised Editing Compliance Procedures

The OSM Foundation has set up Organised Editing Guidelines for documenting organized editing efforts.
While it is not a requirement or policy, HOT highly encourages all groups to comply with these procedures
when applicable. For simplicity and ease of understanding these guidelines, HOT has developed the
following guide, however, HOT does not take responsibility for compliance.

The following is based on HOT’s suggested procedures for complying with the Organised Editing Guide-
lines (OEG) - as of June 2019

Purpose

What problem(s) does the OEG aim to address, and how can we best comply with, and address, these
concerns?
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• Transparency - the OEG attempts to make it easier for local mappers to know what organizations
are editing in their area.

• Communication - the OEG attempts to make it easier for local mappers to communicate with
organized editors and editing teams.

• Conflict Resolution - theOEGattempts to provide a basis for coordinating, as well as amechanism
for local communities to form a complaint against an organized editing activity.

Documentation

• The official OEG can be found here: https://osmfoundation.org/wiki/Organised_Editing_Guidelines
• The official OEG Activities page here: https://wiki.openstreetmap.org/wiki/Organised_Editing/
Activities

• The HOT OEG Activities page here: https://wiki.openstreetmap.org/wiki/Organised_Editing/
Activities/Humanitarian_OpenStreetMap_Team

Requirements

What exactly is required by the Organized Editing Guidelines (OEG)?

1. Project Documentation on the OSM Wiki:
• Organisation and contact info

– description and link to organization
– a way to contact the project manager or team

• Project details
– the goal and purpose of the activity
– the timeframe for the activity
– any non-standard tools and data sources used, and their usage conditions
– links where the community can access any non-standard tools or data sources

• Standard changeset comment
– specific hashtag for tracking
– link to related organized editing activity

• Team information
– the accounts of participating persons that wish to be identified, with any details they wish
to include

– if participants will receive training material or written instructions, a copy of, or link to,
these materials
1. links to organized editing organization(s) and activity(ies) on user profile
2. sufficient training for project (i.e. local tagging schemas, etc.)

– if the success or performance of participants will be measured in any way, a description
of the metrics used for this

2. Project Execution and Follow-up
• Communication with the local community

– 2 week notice for non-emergency projects, open forum/mailing list
– 2 working day response for community inquiries throughout project

• Plans for a “post-event clean up” to validate edits, especially if the activity introduces new
contributors to OpenStreetMap.

• After the activity has completed, or at least once a month for ongoing efforts, a description of
the results.

Does this apply to me?

Common Elements:

Common elements of projects can be jointly-documented among projects.

For HOT, most projects fall under OEG compliance, and will share the following:
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• The organization and contact information
• Instructions to a certain degree, i.e. basic mapping covered with LearnOSM materials
• A somewhat standard validation process; of course be explicit about any ground truthing
• Somewhat standardized tool set(s) (i.e. TM for Remote, ODK/OMK for ground)
• Reports/descriptions/news at a central location (i.e. HOT website)

Step-by-Step Process:

1. Project Pre-launch
• Have at least a skeleton wiki/web-page ready to share with local community

– How to edit the wiki: https://learnosm.org/en/intermediate/editing-the-wiki/
– See https://wiki.openstreetmap.org/wiki/Template:Activation for a template/example of
Activation wiki-pages

– How to create HOT Website projects
• Local contact made a minimum of 2 weeks prior of launch; through their open mailing-list, or
forum, most likely to contact the key leaders in the community
– Look here for mailing lists: https://lists.openstreetmap.org/listinfo
– Search wiki by country as they may have other communication channels listed there, and
sometimes individual points of contact

– And try https://github.com/osmlab/osm-community-index
– Only if you exhaust these options is it acceptable to assume no local community

• Set-up OSM User Profiles:
– Consider registering team on OSM with designated usernames

1. Can still be personalized, such as JaneDoe_Validator, JohnDoe_Mapper, etc.
– Consider also using organization email account(s)

2. Ideally, the Project Manager or Team Lead should get, or be able to access all mes-
saging. If a mapper leaves, but then gets messages from the community, you will
want to be able to reply

10. All profiles should at least have a link to the OEG project page, organizations website, or
(for HOT) preferably a link to the individual’s profile on the website

2. Project Launch
• Ensure the project has an entry in OEG activities page
• Have the required details of your plan in a wiki-page or (for HOT) a hotosm.org website project-
page

• Appoint one or two people that will handle rapid replying to all community traffic (2 business
day max)

• Periodic Reports are typically handled through blog (for HOT), but can also consider posting
results on wiki’s, etc.

3. Project Completion
• Make sure there is a plan to finish any remaining validation and that is communicated to the
local community.

• With constant communication with the local community throughout the project, it should be
fairly easy and straightforward to determine when the project will be done and the Community
is back on their own, with conduits to project org(s).

• Before closing your project out, make sure there is a final blog-post or report documenting
the closure.
– Doc/report does not need to be full report requested by a donor, as example, but generally
the results: successful or not, lessons learned

– Last, move your row in the OEG Activities table from Active to Previous

Additional Resources

• Campaign Management Guide
• HOT Organised Editing Compliance Procedures

27

https://learnosm.org/en/intermediate/editing-the-wiki/
https://wiki.openstreetmap.org/wiki/Template:Activation
https://lists.openstreetmap.org/listinfo
https://github.com/osmlab/osm-community-index
https://wiki.openstreetmap.org/wiki/Organised_Editing/Activities/Humanitarian_OpenStreetMap_Team
https://docs.google.com/document/d/1xsza0vqr_KKGFFuYW_kfRM5wNxvSh4EeEWZ7EA271Kk/edit#heading=h.tcis54iaj9t4
https://docs.google.com/document/d/1IIrR75Cmy92giXLa9hCVIur0wJ3HU4nTZoq6zQWyrEU/edit?usp=sharing


2.3 Working with the HOT Tasking Manager

This section provides:

• An overview of the HOT Tasking Manager, including presentation slides
• Step-by-step instructions for getting started with the HOT Tasking Manager

The following materials are designed to assist project managers and others leading trainings and work-
shops. If you are an individual interested in learning how to map with OpenStreetMap, please visit
LearnOSM.org.

Overview

The HOT Tasking Manager is a mapping tool designed and built for the Humanitarian OpenStreetMap
Team’s collaborative mapping process in OpenStreetMap. The purpose of the tool is to divide up a
mapping project into smaller tasks that can be completed rapidly with many people working on the same
overall area. It shows which areas need to be mapped and which areas need the mapping validated.

For information on Managing and Creating Projects on the HOT Tasking Manager, fill out a form here,
http://bit.ly/TaskManagers, to receive training and permissions to become a TM Project Manager.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Introduction to HOT Tasking Manager

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Getting Started with Tasking Manager

Skills and Technology Needed

• Computer
• Internet connection
• OSM account

Head to the HOT Tasking Manager website: https://tasks.hotosm.org/. To sign in, click on the ‘login’
button in the top right corner of the page. Once you click on the login button a new page will open on
the OpenStreetMap website with a login form. Please enter your OSM username and password.

If this is the first time you are logging into Tasking Manager with your OSM username and password
from the device you are using, an authorisation message will appear. Click ‘Grant Access’ so that your
OSM login details will sync to the Tasking Manager. Navigate back to the Tasking Manager page and
click on the ‘Start Mapping’ button. You will notice that your username now displays in the upper right
hand corner of the page.

Finding a Project

The ‘Start Mapping’ button on the landing page, or the ‘Contribe’ button at the top, will take you to the
Contribute page of the HOT Tasking Manager. This page will display a list of current mapping projects.
The Grid View will display tasks as shown below:

Each task listed will describe:
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1. The urgency of the task
2. The task number and project name - this will often include the location of the task, the type of

humanitarian response, and the focus feature being mapped
3. Any important information e.g. type of mapper needed / experience level
4. A description of the task
5. The organization requesting the task
6. The category of the task
7. The level of experience a mapper needs to contribute
8. The percentage of the task mapped so far
9. The percentage of the task validated so far
10. The current number of active users

If you have a specific task to contribute to, you can search for it in the sidebar to the left of your screen.
You can search by:

• Project name or number
• Level of mapping difficulty
• Organization
• Campaign
• Type of mapping (features being mapped)

You can also view the list of projects in Map view. You can switch between Grid view and Map view by
clicking on each option. The view you are currently in will display as underlined. If you select Map view,
the list of tasks will display on a map of the world. Projects are clustered together into circles which
display the number of projects in that particular area.

You can zoom into an area to view a smaller breakdown of projects in a particular region.

Selecting a Project

Once you have decided which task you want to map, you can click on the task to open the project page.
The task page will provide specific details on the task objective and requirements.

Underneath the project description you will find instructions for the task. The instructions explain which
entities to map (which features e.g. buildings, roads) and provides project specific guidelines (mapping
notes) to follow. The Project Specific Mapping Notes section gives detailed instructions on the imagery
to use, how to trace specific features, and how to tag features.

Mapping features which are the focus point of the task are explained in further detail underneath the
Project Specific Mapping Needs. For example, if the type of mapping of a project is buildings and roads,
the following instructions might appear:

These feature specifications will describe common tags used for each main feature and provide tips for
mapping that feature.

The map on the right-hand side of the task you have selected is split into squares which are colour coded
dependent on the completion of the mapping in that square. The colours represent the following:

• White: a tile is ‘Ready’ to be mapped and needs to be completed
• Yellow: a tile has been ‘Mapped’
• Grey: a tile has ‘Bad Imagery’
• Green: a tile has been ‘Validated’. This means that the mapping in this area has been quality
checked, edited if necessary, and approved. Validators will leave comments next to a tile to show
the changes they have made

• Red: a tile has been ‘Invalidated’. This could be because an area was not fully mapped or multiple
errors need to be corrected

• Blue: a tile is ‘Locked’ by another user
• Blue with dark blue outline - a tile is ‘Locked by You’. You are currently mapping this tile.

Click on a white tile to begin mapping an area that is in need of mapping. When you click on a white
tile the outline of the square will be highlighted in yellow and two options will appear ‘Start Mapping’ and
‘Select Another Task’.

If you click, ‘Select Another Task’, the map will zoom in to an alternative task which needs mapping. You
may notice that some tasks have comments next to them under the History section. The History section
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will display comments that have been left by other users e.g. if a task has been started but still needs
someone to complete. It will also show when the tile was last locked for mapping by another user.

When you have selected the tile that you want to map, click ‘Start Mapping’. You then need to select the
type of editor you will be using. Select ‘JOSM’ or ‘iD Editor’ from the dropdown list and then click ‘Start
Editor’.

Additional Resources

• OSM Tasking Manager Wiki
• Learn How to Use the Tasking Manager

• Two Minute Tutorials: How to use the OSM Tasking Manager
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2.4 Editing with iD and JOSM

This section provides:

• A comparison of OpenStreetMap editing tools, JOSM and iD Editor
• An overview of iD Editor, including presentation slides
• An overview of JOSM, including presentation slides

The following materials are designed to assist project managers and others leading trainings and work-
shops. If you are an individual interested in learning how to map with OpenStreetMap using iD Editor or
JOSM, please visit LearnOSM.org.

Overview

There are several ways to edit in OpenStreetMap. The twomost commonly used tools and best programs
for mapping projects are iD editor and JOSM. This section provides an overview of each tool as well as
presentations to be used in trainings. For self-paced materials and guides, visit LearnOSM.

The following section is designed to provide Project Managers and OSM Communities with guidance in
making management decisions.

Comparison of Tools

iD Editor The iD editor is a user-friendly tool that allows you to directly make changes in Open-
StreetMap.

iD Editor is best for:

• Simple edits
• Fast Internet access to load the imagery and save the edits.
• Following a consistent and simple tagging scheme.
• When you are restricted from installing a program on the computer you are using.

Skills and Technology Needed:

• Computer
• Mouse
• Strong Internet connection
• OSM account

JOSM JOSM (Java OpenStreetMap Editor) is an open source editor for OpenStreetMap data with
offline compatibility.

JOSM is best for:

• Adding many buildings (See buildings_tool plugin).
• Editing many polygons or lines that already exist.
• When you are on an unreliable Internet connection or offline.
• Using a specific tagging scheme (or custom presets).

Skills and Technology Needed:

• Computer
• Mouse
• Minimal/intermittent internet connection for data download & upload
• OSM account
• Installation files (Recommended: download installation files for offline sharing and installation)

– Java (Install this file before installing JOSM)
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– Java OpenStreetMap Editor Installer

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Introduction to iD Editor
• Introduction to JOSM

Additional Resources

• LearnOSM
• Awesome OSM: A Comprehensive Guide on Mapping Building Footprints
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2.5 Validating with JOSM

This section provides:

• An overview of Validation in JOSM, including presentation slides
• Step-by-step instructions for practicing validation in JOSM

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to validate OSM
data in JOSM.

Overview

Validation is a process of checking the data quality (in this case, map data quality) for accuracy, consis-
tency, completeness and anomaly. Validation is important to maintain the quality of OSM data. When
checking for accuracy, you need to make sure that the map data is aligned with the imagery and is cor-
rect in terms of geometry. For consistency, make sure that all mapped objects are consistent in shape.
For example, when you found a residential area, make sure all the buildings are consistently traced and
orthogonalized.

Example of data validation

For completeness, it depends on what information you want to collect when mapping and what map-
ping method is used. Information collected using remote mapping method would be different with the
information collected by conducting field survey. Information collected using remote mapping method
will be very limited since you only have satellite imagery and gpx tracks available as reference. For
anomaly, make sure there is no abnormal looking mapped objects. See the picture below, the mapped
buildings on the left tends to be smaller than the mapped buildings on the right. After carefully checking
the imagery, it turns out that the smaller buildings are actually tombs that are mapped as buildings.

Example of data completeness

While light validation can be completed using iD Editor, HOT recommends that detailed validation be
completed using JOSM.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Validation in JOSM

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Practice Validation

The following activity covers the process of validating bad OSM data in JOSM. This activity uses an
example file that can be downloaded here [2].

Skills and Technology Needed

• Computer
• Internet connection (for data download)
• OSM account
• JOSM
• Example .osm file
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Estimated time for completion: 1 hour

Objectives:

• To be able to understand validation process for OSM data
• To be able to perform validation using Validation Tools on JOSM
• To be able to fix commonly error, warning and mistake found during validation

1. Opening OSM Data

After successfully downloaded sample data, open file validation_sample.osm into your JOSM by fol-
lowing these steps:

• Click menu File  Open

JOSM Menu File

JOSM Menu File

• Go to your directory where you save validation_sample.osm. Select the file validation_sample.osm
and then click Open.

Opening an osm file on JOSM

Opening an osm file on JOSM

• After opening the exercise file, your JOSM will look like this:

Exercise file on JOSM

Exercise file on JOSM

2. Using JOSM Validation Tools

JOSM provides a built-in validator that checks and fixes invalid map data called Validation Tools. After
checking for accuracy, consistency, completeness and anomaly, run this validation tools so that the map
data is perfectly valid. To get started with the Validation tools, you need to activate the Validation Results
Windows by following these steps:

• Click menuWindows  Validation Results

Windows menu on JOSM

Windows menu on JOSM

• Validation results Windows will appear on the left side of your JOSM

Validation results Windows

Validation results Windows

After activating the Validation Results Windows, now you can start validation using JOSM Validation
Tools. Download OSM data first using either Slippy Map or Tasking Mananger, then you can click the
Validation button in the Validation Results Windows. Let’s use OSM data sample for exercise.

• To run validation on all the data in the current data layer, which is validation_sample.osm, make
sure that there is no data selected. Then, click Validation button in the Validation Results Windows.
Once the validation process is finished, Validation Results Windows will be filled with listed errors
and warnings. The amount of errors and warnings found depends on the quality of the data. For
example, on this OSM data sample, you will find one error and twenty one warnings.

Validation Results from OSM Data Sample

Validation Results from OSM Data Sample

• A new layer called Validation errors will also be added to the Layers Windows. This layer will
highlight the errors and warnings found - red highlight for errors and yellow highlight for warnings.

Highlighted errors and warnings

Highlighted errors and warnings

3. Fixing Errors and Warnings
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Errors are important to fix. Do not ignore errors. If you have errors on your OSM data, you won’t be able
to upload it into OSM Server until you fix the errors. Some errors can be fixed automatically using the
Fix button on Validation Results Windows. Warnings are problems that are important to fix, but in some
cases, such as “Unnamed Ways”, they are tolerable. Mostly, warning should be fixed manually. Now,
let’s try to fix errors and warnings found on validation_sample.osm. There are one error and twenty one
warnings found on validation_sample.osm. They are:

• Error: Duplicated ways (1)
• Warning: Building inside building (4)
• Warning: Crossing building/highway (1)
• Warning: Crossing buildings (1)
• Warning: Crossing highways (1)
• Warning: deprecated tagging - amenity=hotel is deprecated, use tourism=hotel instead (1)
• Warning: missing tag - incomplete object: only name (1)
• Warning: node connects highway and building (1)
• Warning: Overlapping highways (1)
• Warning: Unclosed way - building (1)
• Warning: Unnamed ways (6)
• Warning: Untagged ways (1)
• Warning: Way end node near other highway (2)

Now, let’s fix all the errors and warnings one by one.

3.1 Fixing Error: Duplicated ways

Duplicated ways error come up when there are ways that duplicate. This is usually caused by unstable
internet connection when uploading OSM data into OSM server. Initially, to fix errors or warning, you
should select the error or warning you want to fix. Go to the Duplicated ways error in the Validation
Result Windows, click the + icon so that it looks like the picture below.

Duplicated objects on Validation Results

Duplicated objects on Validation Results

Select the objects where it is duplicated and Right-click  Zoom to problem to zoom and see the
duplicated objects. Your map canvas will zoom in to the duplicated objects. Fortunately, duplicated
ways can be automatically fixed. After selecting the duplicated objects, click Fix. Voila, your error is
fixed!

Zooming to Error: Duplicated ways

Zooming to Error: Duplicated ways

3.2 Fixing Warning: Building inside building

Building inside building warning come up when there is a building object inside another building object.
To fix it, go to the building inside building warning in the Validation Results Windows, click the + icon so
that it looks like the picture below.

Building inside building on Validation Results

Building inside building on Validation Results

Select the objects listed under the warning Building inside building and Right-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Building inside building

Zooming to Warning: Building inside building

Most of warning should be fixed manually. To fix building inside building, simply delete one of the build-
ings. To decide which one to be deleted, please take a look at the imagery and carefully decide which
one to be deleted. Voila, you just fixed a building inside building.

Fixing a building inside building warning

Fixing a building inside building warning
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3.3 Fixing Warning: Crossing building/highway

Crossing building/highway come up when there is a building crossing with highway. To fix it, go to the
crossing building/highway warning in the Validation Results Windows, click the + icon so that it looks like
the picture below.

Crossing building/highway on Validation Results

Select the objects listed under the warning Crossing building/highway and Right-click  Zoom to prob-
lem to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Crossing building/highway

To fix crossing building/highway, simply move one of the crossed objects, either the building or the
segment/node of the highway. To decide which object that should be moved, please take a look at the
imagery.

Fixing a crossing building/highway warning

3.4 Fixing Warning: Crossing buildings

Crossing buildings warning come up when there are two or more buildings overlapped with each other.
To fix it, go to the crossing buildings warning in the Validation Results Windows, click the + icon so that
it looks like the picture below.

Crossing buildings on Validation Results

Crossing buildings on Validation Results

Select the objects listed under the warning Crossing buildings and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Crossing buildings

Zooming to Warning: Crossing buildings

To fix crossing buildings, simply move one of the overlapped buildings so that they wont be overlapping
anymore. To decide which buildings that should be moved, please take a look at the imagery.

Fixing a crossing buildings warning

Fixing a crossing buildings warning

3.5 Fixing Warning: Crossing highways

Crossing highways warning come up when there are highways that cross each other with no crossing
node. To fix it, go to the crossing highways warning in the Validation Results Windows, click the + icon
so that it looks like the picture below.

Crossing highways on Validation Results

Crossing highways on Validation Results

Select the objects listed under the warning Crossing highways and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Crossing highways

Zooming to Warning: Crossing highways

To fix crossing highways, simply add a crossing node in the highway intersection. To add node at inter-
section, you can use JOSM additional tools, but first you have to activate plugin utilsplugins2. You can
go to menu Preferences  Plugins, search for utilsplugins2 and give a check for utilsplugin2.

Activating plugin utilsplugins2

Activating plugin utilsplugins2

To add node at intersection, select the two crossing highways, and go to menuMore tools  Add nodes
at intersections. And voila, your crossing highways now have a crossing node.

Adding node at intersection
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Adding node at intersection

3.6 Fixing Warning: deprecated tagging

Deprecated tagging warning come up when there is an object or more in your OSM data that used
deprecated tagging. To fix it, go to the deprecated tagging warning in the Validation Results Windows,
click the + icon so that it looks like the picture below.

Deprecated tagging on Validation Results

Deprecated tagging on Validation Results

Select the objects listed under the warning deprecated tagging and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: deprecated tagging

Zooming to Warning: deprecated tagging

Fortunately, deprecated tagging can be fixed automatically using Fix button. After selecting the object
that has deprecated tagging, press the Fix button. JOSM will automatically change the deprecated tag
into the new one.

Fixing deprecated tagging

Fixing deprecated tagging

3.7 Fixing Warning: missing tag

Missing tag warning come up when there is one or more objects that have no tag or the tag is incomplete.
To fix it, go to the missing tag warning in the Validation Results Windows, click the + icon so that it looks
like the picture below.

Missing tag on Validation Results

Missing tag on Validation Results

Select the objects listed under the warning missing tag and Right-click  Zoom to problem to zoom and
see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: missing tag

Zooming to Warning: missing tag

In this case, the object “Monrovia Park” only has tag name. It does not have the tag that identify it as
park. What you have to do is simply add a tag to define that it is a park, named Monrovia Park. To add
tag, click menu Presets  Search preset… and search for Park. Select one that suits the kind of park
you map, in this case you can select Geography/Landuse/Park, then click Select. Leave the name as
is, then click Apply Preset.

Adding tag

Adding tag

Fixing missing tag warning

Fixing missing tag warning

3.8 Fixing Warning: node connects highway and building

Node connects highway and building warning come up when there is a building node connects with
highway. To fix it, go to the node connects highway and building warning in the Validation Results
Windows, click the + icon so that it looks like the picture below.

Node connects highway and building on Validation Results

Node connects highway and building on Validation Results

Select the objects listed under the warning node connects highway and building and Right-click  Zoom
to problem to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Node connects highway and building
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Zooming to Warning: Node connects highway and building

To fix this, simply separate the connected nodes by selecting the connected nodes first then click menu
Tools  Unglue Ways or press G on keyboard for shortcut. After separating the connected nodes, keep
in mind to move either the whole building or the highway’s node since both nodes are still overlapping.

Zooming to Warning: Node connects highway and building

Zooming to Warning: Node connects highway and building

Fixing node connects highway and building warning

Fixing node connects highway and building warning

3.9 Fixing Warning: Overlapping highways

Overlapping highways come up when there are highways overlapping each other. To fix it, go to the
overlapping highways warning in the Validation Results Windows, click the + icon so that it looks like the
picture below.

Overlapping highways on Validation Results

Overlapping highways on Validation Results

Select the objects listed under the warning overlapping highways and Right-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Overlapping highways

Zooming to Warning: Overlapping highways

To fix this warning, firstly you should split the overlapped segment of the highway. Select one end node
where the highways are overlapped, then click menu Tools  Split way or press P on keyboard for
shortcut. Selet the other end node where the highways are overlapped, and then menu Tools  Split
way or press P on keyboard again. Now the overlapped segment have splitted. All you have to do now
is to delete the overlapped segment by selecting the segment and then press delete on your keyboard.

Fixing overlapping highways warning

Fixing overlapping highways warning

3.10 Fixing Warning: Unclosed way - building

Unclosed way - building warning come up when there is one or more buildings drawn as unclosed
polygon. This happens when you draw building manually using node tools without building tools and the
first node and the last node are not merged. To fix it, go to the unclosed way - building warning in the
Validation Results Windows, click the + icon so that it looks like the picture below.

Unclosed way - building on Validation Results

Unclosed way - building on Validation Results

Select the objects listed under the warning unclosed way - building and Right-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Unclosed way - building

Zooming to Warning: Unclosed way - building

To fix this, select the first node and the last node of the building and merge it by clicking menu Tools 
Merge Nodes or pressing M on keyboard. And voila, now your building is a closed polygon.

Fixing unclosed way - building warning

Fixing unclosed way - building warning

3.11 Fixing Warning: Unnamed ways

Unnamed ways warning come up when there is one or more highways (main road) that do not have
names. This warning is one of the tolerable warning, so you can just ignore this. If you know the name
of the road, you can add the road’s name by adding tag name to the road. However, if you do not
know the name, please just leave it as is rather than giving a random name that could be misleading. To
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ignore this warning, you can just leave it as is or you can also put it on your Ignore list so that this warning
does not come up when you perform validation in the future. Click the “Unnamed Ways” warning in the
warning list, then click Ignore and clickWhole Group.

Putting a warning into Ignore List

Putting a warning into Ignore List

You can always put it back to your warning list if you change your mind, so that this warning will come
up again when you perform validation by clicking Manage Ignore, then right-click on the warning you
want to put back and choose Don’t Ignore.

Managing Ignore List

Managing Ignore List

3.12 Fixing Warning: Untagged ways

Untagged ways warning come up when there is untagged object. To fix it, go to the untagged ways
warning in the Validation Results Windows, click the + icon so that it looks like the picture below.

Untagged ways on Validation Results

Untagged ways on Validation Results

Select the objects listed under the warning untagged ways and Right-click  Zoom to problem to zoom
and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning: Untagged ways

Zooming to Warning: Untagged ways

To fix it, just simply add tag/preset to the object. Please take a look at the imagery to decide what tag to
add to the object. Select the object and then go to menu Preset and select the tag that suits the object.
For example, if this object turns out to be hospital, add tag/preset hospital.

Fixing untagged ways warning

Fixing untagged ways warning

3.13 Fixing Warning: Way end node near other highway

To fix way end node near other highway, go to the way end node near other highway in the Validation
Results Windows, click the + icon so that it looks like the picture below.

Way end node near other highway on Validation Results

Way end node near other highway on Validation Results

Select the objects listed under the warning untagged ways and Right-click  Zoom to problem to zoom
and see the objects. Your map canvas will zoom in to the objects.

Zooming to Warning

Zooming to Warning

To fix it, select the end node and then activate Draw mode by pressing A on keyboard. Then, draw the
road so that it is connected to the road nearby.

Fixing Warning

Fixing Warning

Congratulations! Now you have finished fixing errors and warnings in the validation_sample.osm. Hope-
fully after completing this exercise, you can perform validation for OSMdata. More validator means better
OSM data quality.
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2.6 Resolving conflicts in JOSM

This section provides:

• An overview of data conflict in OpenStreetMap
• Step-by-step instructions for resolving data conflict in JOSM
• Guidance on preventing and managing data conflict

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to validate OSM
data in JOSM.

Overview

When you are uploading your changes in JOSM, some contributors might also do editing in your area.
In other situations, different data may have been collected in the field for the same features. may have
This might occur data conflict in your uploading process. Therefore, it is critical for digitizers to learn
about data conflict in OpenStreetMap, types of conflict, and how to fix it using JOSM.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Resolving Data Conflict in JOSM

Objectives:

• Participants can explain what is data conflict on OpenStreetMap
• Participants knowing about types of conflict in JOSM
• Participants can fix data conflicts using JOSM
• Participants know to avoid data conflict in JOSM

1. Data Conflict in OpenStreetMap

When you have edited your changes and were uploading them in JOSM (learn more about this in Using
JOSM module), maybe you ever received a message like this:

Example of Conflict Detection Window in JOSM

Example of Conflict Detection Window in JOSM

The picture above shows data conflict in OSM. Why that could possibly happen? This conflict happens
because when you edit your data in JOSM, you edit the same data/object(s) with the other contributor in
the same time. Thus, the other contributor have uploaded the changes first and have received by OSM
server. After that, you also want to upload the same data/object(s) with your own changes. Therefore,
your changes will automatically rejected by the server because it causes confusion.

You will face with data conflict when you do changes in JOSM such as editing, adding, or delet some
objects in OpenStreetMap, while the other contributor also do the same thing on the objects. The other
contributor has uploaded their changes slightly before you. Therefore, when you try to upload your
changes, it causes confusion for the OSM Server because it does not know which changes is correct
and can be saved. If this happens, then the data conflict need to be fixed before you can continue to
upload your changes into OSM server.
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Example why conflict happens in JOSMExample why conflict happens in JOSM

Example why conflict happens in JOSM

The picture above is example of conflict that could happen because of different position with the object
between your version (my version) and version of the other contributor / have received by server (their
version). To resolve this conflict, you have to choose one version between them (see section 3. Fixing
Data Conflict in JOSM).

2. Types of Data Conflict in JOSM

2.1 Conflict of Properties

Conflict of properties happens when an object(s) has been moved or deleted so one or more of its node
has different location/position than the other version.

Conflict Property Window

Conflict Property Window

The picture above is an example of conflict of properties in JOSM. As can be seen in the picture, in My
Version the object has square shape and in the other version (their version) one of the node is deleted
then change its shape become triangle. To fixed this, you need to choose which version that correct
based on the location of the different nodes in both version.

2.2 Conflict of Tag

Conflict of tag happens because there are different information (tag) on on the object that has been
edited by two or more contributors. The information could be deleted or changed on the other version.

Conflict of Tag in JOSM

Conflict of Tag in JOSM

The picture above shows differences between two versions on the same object in JOSM. My version
has Rumah Sakit tag (amenity = hospital) with its name value is Rumah Sakit Tebet Raya while the other
version (Their version) has tag klinik (amenity = clinic) with name RS Tebet Timur. You have to choose
one of them that you think has correct information to fix it before upload it to the server.

2.3 Conflict of Node

This conflict happens when there are differences order of the nodes in a way or closedway object(s)
which have been removed or moved on one of the versions and has been uploaded to the OSM server.

Conflict of Nodes in JOSM

Conflict of Nodes in JOSM

3. Fix Conflict Data in JOSM

Fixing conflict data in JOSM is quite simple, even though most OSM contributors would have some
confusion to do it. Generally, every data conflict fixing in JOSM asks you to choose the correct changes
between your version and the other version that have uploaded to the server (their version). You have to
choose whether to keep your version or delete you version and use their version. Steps to fix conflict
data in JOSM as follows:

• When the conflict window appears, you might be only want to select the Synchronize node
5,960,126 only option. However, this option will only fix conflict in one certain nodes. Instead,
you should choose Synchronize entire dataset option so you can resolve all conflict nodes in one
time.

Conflict Detection Window in JOSM

Conflict Detection Window in JOSM

• After that, JOSM will show how many conflicts that has been detected, Click OK.

Number of detected conflict

Number of detected conflict
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• There is a list of conflicts in Conflict panel at bottom right corner in your JOSM. You can choose
which conflict you want to fix and click Resolve.

Conflict panel to fix detected conflict

Conflict panel to fix detected conflict

• When you have click the Resolve button, the window will appears and shows detail about detected
conflict. The message about conflict might be looks complicated but it actually has simple instruc-
tion. You will know about what type of conflict do you have by looking at symbol. Therefore, the
conflict in this example was caused by different coordinate location and position of object. You
can look at a list of changed or moved coordinate as shown in picture below. Thus, conflict in this
example was caused by one changed node.

A Window to Resolve Conflict

A Window to Resolve Conflict

• You only can resolve one conflicts at one time. You can choose which correct version between
your version or their version in the server. If you sure that your version is the correct one (you edit
/ add the object based on your field survey mapping or you already know the object personally),
then choose My Version (local dataset). However, if you are not sure about your version and
think that the other version more convincing then you can choose Their version (server dataset).
Click blue arrow blue arrow symbol in the version that you choose. If the conflict has been fixed
then the symbol will be going turn to green check mark green check

Choose one of the versions to resolve data conflict

Choose one of the versions to resolve data conflict

• After you have select the right version, you have to make sure the color of conflict box has been
changed from pink to green. This means you have successfully fixed the conflict.

Difference color between original conflict and resolved conflict

Difference color between original conflict and resolved conflict

• Then click Apply Resolution as shown in the picture above. After you have finished all of your
conflict, you can start to upload your OSM changes.

Resolved conflict window

Resolved conflict window

• In window menu, you can activate Conflicts window. This window shows total number of conflict
on all of your data when you click the Resolve button. You also can use another way by right click
on one of the conflict and choose Resolve to my versions or Resolve to their versions. To find
the object you can right click and click Zoom to Conflict. This will be very useful if you have many
conflicts and need to check and fix them one by one.

Window of list conflict on JOSM_

Window of list conflict on JOSM_

Note : You can not upload your changes until you have resolved all of your conflict and list
of conflict in the conflict window has empty. Keep in mind, you need to be careful when
resolving the conflict and need to check it one by one to make sure everything is correct as
it should.

4. Avoiding Data Conflict in JOSM

You can do some things to avoid conflict when uploading your data into OSM server, as follows:

• Upload your changes continuously

To minimize conflict, you can upload your changes continuously. For instance, if you mapped 100
buildings but does not have a good internet connection, you should upload your changes for every
20 buildings or every 15 minutes. The reason for this is because the conflict would have bigger
possibility to occur if you upload when it is finished. The longer you waiting to upload the more
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possibility the data could possibly have edited and uploaded to the server by other contributors.
Therefore, the probability of conflict for your edit will increase.

If you want to save your OSM data and upload it later, you can update your OSM data first before
you upload it. This should be done so you can get the latest OSM data from the server before you
upload it. You can do that by click File → Update data or Update Modified then waiting until the
updating process is finished. After that, you can upload your changes with Upload data options
File menu or just click icon on menu bar.

Update data options in file menu

Update data options in file menu

• Edit Only in Downloaded Area

You can do mapping in specific area to minimize risk of conflict with avoid editing objects outside
your downloaded area in JOSM. This can prevent two or more users editing in same area. Notice
that diagonal lines around your downloaded area is an area you need to avoid to edit in JOSM.

Downloaded Area

Downloaded Area (black) dan Outside Downloaded Area (diagonal lines)

After you download the data, your editing area is only area inside which does not have diagonal
lines. The area outside you editing area most likely currently editing or have been edited by other
contributors. Avoid edit in the area will reduce the risk of getting conflict in your data.

• Using Tasking Manager

If you want to do collaborative mapping, you can use Tasking Manager. It will help you to divide
your mapping area into task grids. Thus, you can choose your mapping area grid easily without
worry getting same area with other OSM contributors because once you select certain grid, it will
be locked and cannot choose by other contributors.

Any mapping volunteer in the area can choose one grid that they want and after finish they can
mark the grid as completed mapped. This will allow a lot of people to map certain area in same
time without getting worried to get conflict.

Tasking Manager Interface

Tasking Manager Interface (tasks.openstreetmap.id)

Summary

If you have followed and finished to practice all the steps in this chapter, You have successfully under-
stand about data conflict in JOSM and how to fix it. Moreover, you also have learned about types of
conflict and how to avoid them in JOSM. Congratulations!
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3.0 Introduction to Technical Set-up for Field Mapping

In this section, Project Managers will find tools and resources to determine which data collection tools
are appropriate and how to navigate the technical steps needed to prepare for a field mapping project
including:

• Presentations and step-by-step guides for developing a data model suitable for uploading to
OpenStreetMap

• Resources for determining the correct mobile data collection, navigation applications, and server
options for your project

• Detailed guides and resources for setting up applications such as OpenMapKit

Any field project will require some degree of Field Mapping Technical Set-Up regardless of the complex-
ity of the data collection workflow. This section is designed to guide project managers and community
members through the decision making process to determine what tools and steps are necessary for their
specific project. Many technical guides exist on setting up and using specific tools such as OpenDataKit
and POSM. To support project managers effectively, step-by-step guides are provided for some tools
and processes where external documentation is lacking or HOT has previously created tailored materi-
als. For tools and processes with quality guides and materials outside of HOT resources, external links
have been provided.

• 3.1 Designing the Data Model covers the workflow and tools needed to develop a data model for
OSM data collection.

• 3.2 Data Collection Applications provides guidance on selecting the appropriate data collection
application for your project. Sub-pages also provide detailed instructions and resources on setting
up specific tools such as ODK and OMK.

• 3.3 Navigation Applications provides an overview of navigation applications and how they can be
used by project managers for their project.

• 3.4 Data Collection Servers provides guidance on determining if a server is necessary for your
project and selecting the appropriate server for based on data and resource needs.

The following presentation(s) can be used to lead a training or workshop:

• Data Models and Tagging
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3.1 Designing The Data Model

This section provides:

• An overview of data models and OpenStreetMap tagging, including presentation slides
• Step-by-step instructions for tools to help build your data model
• Step-by-step instructions for creating your data model

Overview

When beginning a mapping project, a data model will need to be created in order to determine what
features are mapped and the details collected for each of those features. A data model defines what
features are surveyed or mapped and what attributes are collected for each feature. If a project will
upload data to OpenStreetMap, the data model should be designed to match OSM tagging.

Example data models:

• Uganda Refugee Crisis
• Ramani Huria

OSM doesn’t work with layers or attribute tables, but tags. Tags are used in OSM to categorize features,
and to add information that is useful for understanding of the map, planning, routing, and querying. Each
tag consists of a key, and a value. Each map feature should have one or more tags such as:

• building=residential
• highway=primary
• amenity=school

In addition, each of these features can have an unlimited number of related attributes added into OSM
as tags. For example, a building might have the following tags:

• building=commercial
• building:material=brick
• roof:material=metal
• shop=tailor

Creating a data model should be done in collaboration with all stakeholders in order to ensure that all
necessary information is collected - it is a lot more difficult to revisit a location for mapping to collect
additional information. At the same time, when designing a data model you should consider how much
time it will take for a surveyor to complete data collection - every feature type, attribute, or question will
add additional time needed.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Data models and tagging

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

• Tools for creating your data model
• Creating your data model
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Tools for creating your data model

HOT recommends using TagInfo and the OSMWiki to search for existing OSM features when developing
your data model. The following steps will provide an introduction to how to use these tools.

Skills and Technology Needed

• Computer with
• Internet connection
• OpenStreetMap Account
• Recommended: computer mouse

How to Use the OSM Wiki

osm_wiki_map_features

1. Navigate to https://wiki.openstreetmap.org/wiki/Map_Features in a Google Chrome or Mozilla Fire-
fox internet browser.

2. This page provides documentation on common, existing OSM features categorized by type. These
tables contain keys and values, along with comments and sometimes pictures to help define the
tag. Scroll through the tables to explore the tags described.

3. Search for a particular tag by using ‘Ctrl+F’ on your keyboard. As an example, search for the tag
that should be used for hospitals. To do so, hit ‘Ctrl+F’ on you keyboard, type ‘hospital’ in the
search bar, and hit enter. This will bring you to the appropriate tag for hospitals. Note: there might
be more than one appropriate tag for a search item. Scroll through the results until you find the
appropriate tag.

4. Keys and values within the tables will also link out to individual wiki pages for those fea-
tures. For example, by clicking on “hospital” under amenities, you will be redirected to
https://wiki.openstreetmap.org/wiki/Tag:amenity%3Dhospital. This page provides in-depth detail
about the tag as well as related tags and tips on how to map a particular feature.

5. To practice, search for other key words relating to features you would want to map to discover keys
and values related to that feature.

How to use TagInfo

taginfo

1. Navigate to https://taginfo.openstreetmap.org in a Google Chrome or Mozilla Firefox internet
browser.

2. In the upper left corner, use the search bar to find a tag. For this activity, search for “roof”.
3. The next window will allow you to select from existing keys, values, and relations that contain
“roof”.

4. Selecting one of these options will bring you to an information page about that key, value, or relation.
For this activity, find and click on “roof:material”.

5. You will now see an information page about the tag “roof:material” including values that have been
used with the key “roof:material”, combinations of other tags that have been used with the key, a
map of the key’s global use distrubtion if there are enough use cases, and links to any existing
related OSM Wiki pages.

6. To practice, search for other key words relating to features you would want to map to discover keys
and values related to that feature.

Creating your data model

The following activity will guide you through the process of creating a data model. While this process
could be done by hand or in document software (such as Google Docs or Microsoft Word), spreadsheet
software is the recommended method of documenting your data model.

Skills and Technology Needed

• Computer with
• Internet connection (recommended for accessing TagInfo and OSM Wiki)
• OpenStreetMap Account
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• Recommended: computer mouse
• Spreadsheet software, such as LibreCalc, Google Sheets, or Excel (recommended for structuring
your data model)

Data model workflow

Designing a data model based on OSM tagging is typically defined by the following questions and
workflow:

1. What is the focus of the data collection? Consider how the data will be used.
2. What features do you want to collect? Identify the focus of the data collection.
3. Where are you collecting data? Data models can differ based on their location.
4. What has been done before? Draft data model by leveraging similar models.
5. What tags exist for features?

1. Verify tag status through OSM Wiki
2. Verify tag usage through TagInfo

6. Use approved tags where possible in data model
7. Do all stakeholders agree on the data model? Review data model and incorporate feedback from

project partners (adding, removing, or changing data model features can delay field data collection
and decrease data quality!)

Create a list of all of the features that you want to collect. For example: buildings, water points, roads.

Feature

Buildings
Water Points
Roads

Go to OpenStreetMap wiki to search for the appropriate key for each feature, and value if there is only
one value option.

Feature Key Value

Buildings building
Water Points amenity water_point
Roads highway

For features withmultiple values, such as buildings, use theOSMWiki page for that key as well as TagInfo
to find appropriate values. These values should only be what is reasonable for your data collection.
While it would be ideal to collect every building type in a city, your project might only be able to collect
all school and hospital buildings. Note: values in your data model should make sense for the context
of your geography. For example: hut is an appropriate value for buildings in Liberia, but not likely in
Germany. Additionally, you may need to interpret an existing value type to best match the appropriate
value for your region.

Feature Key Value

Buildings building residential, school, civic
Water Points amenity water_point
Roads highway primary, secondary, residential

Once you have the base tags for your features, you can decide on what attributes you want or can collect
for each feature.

Feature Key Value

Buildings building residential, school, civic
building:material
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Feature Key Value

building:levels
roof:material

Water Points amenity water_point
status

Roads highway primary, secondary, residential
name
condition
surface
width

Next, values can also be determined for each attribute key. These options can be determined using the
OSM Wiki and TagInfo, or in some cases can be defined by the mapper - such as for numeric answers
or names.

Feature Key Value

Buildings building residential, school, civic
building:material cement_block, brick, wood, mud
building:levels numeric
roof:material thatch, metal, concrete, plastic, tile

Water Points amenity water_point
drinking_water yes, no

Roads highway primary, secondary, residential
name user defined
condition excellent, good, poor
surface gravel, paved, dirt
width numeric

Once completed with your data model, this data model should be checked by your stakeholders for any
gaps. Additionally, your project plan should allow flexibility so that this data model can be adjusted with
field testing and consulting your mappers.

Collecting private data Private data should never be uploaded to OSM. However, some projects do
require personal information to be collected. When this is the case, the data model can include unique
non-OSM tags for private data that needs to be collected. When cleaning data following data collection,
this private data can be kept in a full dataset before being removed. Once private data is removed, the
dataset can be uploaded to OSM.
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3.2 Data collection applications

This section provides:

• An overview of data collection application options
• Guidance on selecting a data collection application for your project needs
• Brief overviews of OpenDataKit, OpenMapKit, KoboCollect, and OSMTracker

Overview

Several mobile applications exist to assist with field data collection. Choosing an application to use
depends on mobile device capability, varying set-up requirements, and survey needs. Options include
OpenDataKit, OpenMapKit, KoboCollect, OSMTracker, and Maps.me

## Choosing a Data Collection Application

Which data collection application should I use? Use the following table to decide which application
is best for your project and resource restrictions. These are not the only options available, but instead,
applications that HOT has used and tested in the field for mapping projects.

I want to collect… ODK Kobo OMK Maps.me OSM Tracker Mapillary

Qualitative survey data    × × ×
Quantitative survey data    × × ×
GPS Points      ×
Photos attached to GPS Points   × ×  ×
GPX Tracks × × × ×  
Streetview imagery × × × × × 
Data attached to OSM points of interest × ×   × ×
Data attached to OSM polygons (i.e. buildings) × ×   × ×

Open Data Kit (ODK)

ODK is a free an open-source set of tools which help organizations author, field, and manage mobile
data collection solutions. ODK Collect is part of ODK and is an Android app that replaces paper forms
used in survey-based data gathering. It supports a wide range of question and answer types, and is
designed to work well without network connectivity.

Skills and Technology Needed

• Computer
• Internet Connection
• Mobile devices (see 1.3 Hardware for specifications.)
• ODK forms
• Spreadsheet software (such as Excel or LibreCalc)

Use OpenDataKit (ODK) if:

• You have access to mobile devices but they have limited RAM & storage
• You do not need to collect data for buildings in OSM OR you are able to manually transfer data
collected as points to OSM polygons after data collection.

• You want or need to have an easy set-up option for data collection.

Resources

• OpenDataKit: https://opendatakit.org
• ODK Guide: https://docs.opendatakit.org/collect-intro
• ODK Build: https://build.opendatakit.org
• Building ODK Forms: http://xlsform.org/en
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Download

• Directly download via Google Play
• Download APK to share and install offline

Set-up and use

• For set-up, see Section 3.2.1 Setting up OpenDataKit.
• For use, see Section 4.1 Using OpenDataKit.

OpenMapKit (OMK)

OMK is an extension that launches directly from within ODK Collect when the OSM question type is
enabled in a standard survey. It is what allows you to browse OSM features, and to create and edit
OSM tags.

Skills and Technology Needed

• Computer
• Internet Connection
• Mobile devices (see Hardware for specifications.)
• OMK forms
• Spreadsheet software (such as Excel or LibreCalc)
• Additional files

– .mbtiles
– OSM layer
– Constraint file

• Recommended: OMK Server

Use OpenMapKit (OMK) if:

• You have access to mobile devices with sufficient RAM & storage (see 1.3 Hardware for specifica-
tions.)

• You need to collect data for buildings in OSM
• You have the capacity for more intensive set-up prior to data collection

Download

• Directly download via Google Play
• Download APK to share and install offline

Set-up and Use

• For set-up, see Section 3.2.2 Setting up OpenMapKit.
• For use, see Section 4.2 Using OpenMapKit.

KoBoCollect

Kobo is in almost all ways similar to ODK Collect, and is built on top of the ODK platform. Kobo also has
prebuilt analysis tools and is another popular option.

Skills and Technology Needed:

• Computer
• Internet Connection
• Kobo Account
• Mobile devices (see 1.3 Hardware

Download

• Directly download viaGoogle Play: https://play.google.com/store/apps/details?id=org.koboc.collect.android&hl=en_US

Set-up and Use

Visit the KoBo Collect website: https://www.kobotoolbox.org
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Maps.Me

Maps.me is a navigation application that uses OpenStreetMap data, and can be used offline. It is suitable
for collection Point of Interest (POI) information, as far as these fit within the types of data that Maps.me
shows you on the map.

Skills and Technology Needed

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android or iOS device

Download

• Directly download via Google Play
• Download APK to share and install offline

Additional Resources

• OSM Wiki: https://wiki.openstreetmap.org/wiki/MAPS.ME

OSMTracker

OSM Tracker is “an offline GPS tracker designed for collecting points of interest (POI) to be added to
the map and for recording GPX tracks.” OSM Tracker is free and open-source.

Skills and Technology Needed

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)

Download

• Directly download via Google Play

Set-up and Use See section 4.3 Using OSM Tracker

Additional Resources

• OSMWiki: https://wiki.openstreetmap.org/wiki/OSMTracker_(Android)
• LearnOSM: https://learnosm.org/en/mobile-mapping/osmtracker/

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

• HOT Community Webinar: Mobile Data Collection Best Practices and Tools
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3.2.1 Setting up OpenDataKit

This section provides:

• An overview of steps needed to set-up ODK
• A step-by-step guide for creating ODK survey forms, including example files
• A step-by-step guide for setting up ODK on devices

Overview

OpenDataKit (ODK) is a free an open-source set of tools which help organizations author, field, and
managemobile data collection solutions. ODK Collect is part of ODK and is an Android app that replaces
paper forms used in survey-based data gathering. It supports a wide range of question and answer types,
and is designed to work well without network connectivity.

Not sure if OpenDataKit is right for your project? Review Data Collection Applications.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Set-up Process To set-up OpenDataKit for devices, you will need to follow the following steps:

1. Create ODK forms
2. Download and set up the ODK application

Creating ODK Forms

When using ODK and OMK survey applications, you will need to create the files that will serve as the
survey forms.

Forms can be created using spreadsheet software (such as Excel or LibreCalc) or using the ODK Form
Builder. Documentation on how to design a form can be found here.

• Example ODK form
• Blank ODK form

Form conversion After forms are developed, they need to be converted from .xlsx/.xls to .xml to be
used by the ODK application. This can be done by using XLSform online or offline. If using OpenMapKit
Server or KoboToolBox server, you will not need to complete form conversion. The server will complete
this process for you.

Download and set up the ODK application

Download application

The ODK application can be found on Google Play here.

If installing on multiple devices with low internet resources, it is recommended to download and share
the apk offline. The APK file for OpenMapKit can be downloaded here.

Setting up application on devices

1. Find the ODK Collect app icon on your mobile device and tap to open the app.
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2. After downloading the ODK app, an odk folder will be automatically created in on the internal
memory of the device. Connect your device to a laptop to confirm that this folder is created. If you
don’t see this folder on your device’s internal storage, Restart the device.

3. Once the device has been restarted, connect it to your laptop, and navigate to internal storage ->
odk folder. You will find for sub-folders inside the openmapkit folder. I.e ‘forms’, ‘instances’, ‘layers’
and ‘metadata’ folders.

4. Add your xml forms to the forms folder.
5. In the ODK Collect Main Menu window, select Fill Blank Form. This will display all forms down-

loaded from the server, which you will be using to field data collection testing.
6. Once you confirm that you have all forms on your device, click on the device back button to exit

the ODK Collect App.
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3.2.2 Setting up OpenMapKit

This section provides:

• An overview of steps needed to set-up OMK
• A step-by-step guide for creating OMK survey forms, including example files
• Guidance on selecting an MBTile creation method and step-by-step guide on creating MBTiles.
• A step-by-step guide for creating additional files necessary for running OMK.
• A step-by-step guide for setting up OMK on devices.

Overview

OpenMapKit (OMK) is an extension that launches directly from within OpenDataKit (ODK) Collect when
the OpenStreetMap question type is enabled in a standard survey. It is what allows you to browse OSM
features, and to create and edit OSM tags.

Not sure if OpenMapKit is right for your project? Review Data Collection Applications.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Set-up Process To set-up OpenMapKit for devices, you will need to follow the following steps:

1. Create OMK forms
2. Create .mbtiles
3. Create .osm layer
4. Optional: Set-up constraint file
5. Download and set up ODK and OMK applications

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Creating OMK Forms

When using OMK survey applications, you will need to create the files that will serve as the survey forms.

Forms for OMK are slightly altered from ODK forms to incorporate the OSM tagging scheme and need to
be built using spreadsheet software (such as Excel or LibreCalc). In addition to the structure of an ODK
form, OMK forms require an additional ‘osm’ tab that alters the form structure for OMK. Documentation
on how to design a form can be found here.

• Example OMK form
• Blank OMK form

Form conversion After forms are developed, they need to be converted from .xlsx/.xls to .xml to be
used by the ODK application. This can be done by using XLSform online or offline. If using OpenMapKit
server, you will not need to complete form conversion. The server will complete this process for you.

Create .mbtiles

MBTiles (.mbtiles) is the file format used for storing map tiles as a single file - the most common use
case as baselayers for mobile mapping applications. There are multiple tools to create mbtiles, with
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selection based on baselayer type (aerial imagery), addition of vector layers, file size, zoom, etc. Many
factors can influence the type of basemap that you need for your field data collection.

• If you are mapping buildings in areas that are rural and/or there are few landmarks in OSM, use
an aerial imagery basemap mbtile.

• If you are working with mappers or surveyors with low map literacy, aerial imagery basemap
mbtiles could reduce issues.

• If you are mapping points (such as POI) and/or working in well-mapped areas, simply using OSM
basemap mbtiles would be feasible.

• If your mapping area is being divided into assignment areas or enumeration areas to divide among
surveyors, consider adding vector layers to your mbtile for mappers work from.

I need .mbtiles with… HOT Export Tool QGIS Tile Huria

Aerial Imagery Basemap X  
OSM Basemap   
Vector Layers (i.e. enumeration areas) X  X

Resources

• OSM Wiki: https://wiki.openstreetmap.org/wiki/MBTiles
• Mapbox: https://docs.mapbox.com/help/glossary/mbtiles/

a) Create an MBTile with HOT Export Tool HOT Export Tool allows users to download OSM data by
specifying tags, area of interest, and file type. Learning resources and walkthroughs can be found at
the HOT Export Tool Learn page.

Skill level: Easy

Tools and Technology Needed:

• Computer
• Internet Connection
• OSM Account

To get started, open an internet browser and go to: https://export.hotosm.org/ To use the HOT Export
Tool, you will need to log in using your OSM username and password, by clicking the red “Log In” button
in the top right-hand corner.

Select ‘Create’ in the top menu.

Select an AOI on the map by searching a place, uploading a .geojson, or drawing an area in the map
to the right. To draw an area of interest, zoom in and find a location of your choice (i.e. Zwedru, Accra).
Once you have zoomed in to your area of interest, select the box tool from the Tools Menu on the right.
Click one corner to start drawing a box, then select the opposite corner to complete the box. This is your
AREA OF INTEREST that will be downloaded.

On the left hand side of the window, fill out the “1 Describe” options:

• Name: “[YOUR OSM USERNAME] Test Export”
– For example, “jessbeutler Test Export”

• Description (optional)
• Project (optional)

– For example, “Government Inclusion Project”

Select preferred file type in the ‘Formats’ tab. Select .mbtiles.

In the ‘Data’ tab, select the ‘OpenStreetMap’ as the source. Then select the zoom range. The higher the
zoom range, the more you will be able to zoom in on the basemap. Note, higher zoom ranges increase
the size of files.

In the ‘Summary’ tab, select ‘Create Export’. While processing, a “Running” status will show. Processing
time depends on export size. Once completed, the file will be available for download & sent to your email.
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This process will take several minutes to process.

When the export process is completed, the ‘Status’ bar will be updated to ‘COMPLETED’. Download the
file by clicking on the file link, as highlighted below.

b) Create an MBTile in QGIS Skills and technology needed

• Computer
• Internet access (for web service basemaps only)
• QGIS (and Basic skills in QGIS)
• Optional:

– Vector layers
– QuickMapServices plug-in

Recommendation: When running this process for the first time, we recommend creating an MBTile for
a small area (<1 sq km) to test processing times.

To create an MBTile in QGIS using this process, you will need to have version 3.8 or higher installed.
The following instructions were developed using QGIS version 3.10.

Open a QGIS project. Add (and style) all layers required for your MBTile basemap. These layers can
include:

• Vector layers for enumeration areas, or other guidance.
• Raster layers, such as aerial imagery or an OSM basemap. Web service basemaps can be ac-
cessed via the QuickMapServices plugin.

Once all layers are selected and styled, navigate to the ‘Processes’ menu and open ‘Toolbox’.

In the ‘Toolbox’ panel on the right-hand side, open the ‘Raster Tools’ sub-menu. Select ‘Generate XYZ
tiles (MBTiles)’.

In this pop-up window, you will need to set the specifications for your MBTile. Click on the ‘…’ button
under ‘Extent’ to select the extent of the MBTile. You can either select the extent of the map canvas or
draw a bounding box.

Next, you will need to select the minimum and maximum zoom. This selection will depend on the needs
of your MBTile and may require trial and error to assess the best combination. For use with OpenMapKit,
we recommend a minimum zoom of 18. Note: the larger the range and the higher the zoom levels, the
longer it will take for the MBTile to process (and will create a larger file.)

The remaining specifications can be adjusted as needed. Hover over each of these options to see
default, minimum, and maximum options.

Once all settings are selected, click ‘Run’ to process the MBTile.

Note: this process may take several minutes depending on the zoom range and size of the MBTile as
well as the processing power of your computer.

c) Create an MBTile in Tile Huria Tile Huria is a simple tool for creating mbtiles based on an area
provided via Geojson format with aerial imagery.

Skill level: Easy

Tools and Technology Needed:

• Computer
• Internet Connection
• .geojson file for area of interest
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Create an .osm layer

To conduct data collection using OpenMapKit (OMK), you will need to create an .osm layer. This .osm
layer provides the buildings for selection in the OMK application.

Skills and Technology Needed

• Computer
• Internet Connection
• JOSM Installed
• Basic JOSM skills

In JOSM, click the top-menu File > New Layer to start. Then click the top-menu File > Download Data.

In the ‘Download’ window, click the tab ‘Download from Overpass API’. This will allow you to download
data with specific key=value tags in an area of interest. The top of this tab provides space for a query
to be entered. Click ‘Query Wizard.’

For an OMK .osm layer, we want a layer with only building polygons. In the search bar, type ”building=*”.
This will return an OSM feature with a building tag. Click ‘Build query’.

In the slippy map below the Overpass query, navigate to your area of interest in OSM. Drag the map
by holding down the right-click button and dragging your mouse. To zoom, use the ‘+’/‘-’ keys on your
keyboard. Once navigated to your AOI, hold down the left-button of your mouse or navigation pad and
drag your mouse to create a pink box. This pink box is your bounding box, all buildings within this area
will be downloaded. When complete, click ‘Download’.

Right click on the layer file in the ‘Layers’ window. Click ‘Save as’. The default file type is OSM Server
Files (*.osm), this is the correct file type.

Once saved, this file can be uploaded to devices for data collection with OMK.

Optional: Set-up a constraint file

Constraint files manage the logic of a form - when to skip questions, etc. OpenMapKit comes with a
pre-built constrain file. For information on how to modify a constraint file, see

Download and set up the OMK application

Note: You will need ODK to run OMK. We advise installing ODK first to allow for proper set-up and
testing.

Download application

TheOMKapplication can be found onGoogle Play: https://play.google.com/store/apps/details?id=org.redcross.openmapkit&hl=en_US

If installing on multiple devices with low internet resources, it is recommended to download and share
the apk offline. The APK file for OpenMapKit can be downloaded here.

Setting up application on devices

1. After downloading the OMK app, a openmapkit folder will be automatically created in on the internal
memory of the device. Connect your device to a laptop to confirm that this folder is created. If you
don’t see this folder on your device’s internal storage, Restart the device.

2. Once the device has been restarted, connect it to your laptop, and navigate to internal storage
-> openmapkit folder. You will find for sub-folders inside the openmapkit folder. I.e ‘constraints’,
‘deployments’, ‘mbtiles’ and ‘osm’ folders.

3. If you have a customized constraints file, in the constraints folder, delete the Buildings.json and
default.json files. Add your custom the default.json file to the constraints folder.

4. Add your .mbtiles file to the mbtiles folder.
5. Add your .osm file to the osm folder.
6. Now you are set to start working with OMK. Exit the file manager window.
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3.3 Navigation Applications

This section provides:

• An overview of Navigation Applications, including presentation slides
• Guidance on what applications to choose
• Brief overviews of Maps.me and OSMAnd

Overview

Several mobile applications exist to assist with field navigation using OpenStreetMap as a baselayer
and functioning offline for low-connection environments. Options include OSMAnd and Maps.me.

While navigation tools are not required for data collection, they can be extremely useful for data collection
teams in navigating to field locations, as well as for supervisors and project managers to understand
where their teams have been.

Additional benefits of navigation applications include:

• Collecting GPX tracks: GPX tracks can be used to record field movement as well as recording
highway and road routes for later digitization and upload to OSM.

• Adding KML files: Adding point layers to a navigation map can help field mappers navigate to
specific locations or survey blocks that are not in OSM.

## Choosing a Navigation Application

Which navigation application should I use?

I want to… Maps.me OSMAnd

Use OSM data to find my location  
Find my location offline  
Add kml files for navigation guidance  
Record GPX tracks* × 
Add data to OSM within app  ×

OSMAnd

OSMAnd is a global mobile map viewing and navigation app for online and offline OSM Maps. It is used
for recording tracks as well as mapping features. It provides easy way to record and submit information
in the field.

Skills and Technology Needed

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android

Resources

• LearnOSM: https://learnosm.org/en/mobile-mapping/osmand/
• OSM Wiki: https://wiki.openstreetmap.org/wiki/OsmAnd

Download

• Google Play: https://play.google.com/store/apps/details?id=net.osmand&hl=en_US
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Maps.Me

Maps.me is a navigation application that uses OpenStreetMap data, and can be used offline. It is suitable
for collection Point of Interest (POI) information, as far as these fit within the types of data that Maps.me
shows you on the map.

Skills and Technology Needed

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android or iOS device

Resources

• Maps.me: https://maps.me
• OSM Wiki: https://wiki.openstreetmap.org/wiki/MAPS.ME

Download

• Google Play: https://play.google.com/store/apps/details?id=com.mapswithme.maps.pro&hl=en_US

Additional Considerations

When downloading applications to be used by large numbers of individuals, managers should consider:

• Downloading the apk files prior to installation. These are offline files that can be shared between
users and allow for offline installation.

• For Maps.Me, share basemaps with an offline file rather than requiring each user to download an
entire basemap (i.e. Liberia, northern Botswana) on data or wifi. To get an offline map file, you
will need to download the map to one device. Plug the device into a computer and navigate to the
file folder. The basemap file in this folder can be copied and pasted to the appropriate file in other
devices.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Introduction to Navigation Applications
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3.4 Data Collection Servers

This section provides:

• An overview of server storage options
• Guidance on selecting a server for your project needs
• Brief overviews of server options

The following section provides an overview and guide to deciding if a server is necessary for your project
and options to choose from. For in-depth information on setting up and managing servers, please use
the documentation linked for each server option.

Overview

When beginning amapping project, many organizations ask if they need to have a server. After collecting
data, you’ll need to get the data from the devices. Sometimes, it works to simply collect and process
data directly from the data collection devices. However, this does not scale well when you get more
people collecting data, and also means your data is not backed up - if you lose the device, you can lose
the data. Prior to data collection, it is important to have a data management strategy that is suited for
your operations.

## Choosing a Storage Option

Cloud Server vs. Physical storage Using a data collection server allows for much better management
of forms and deployments, collection and aggregation of responses, and can offer additional features for
viewing, analysing and exporting data. Use of a server may be restricted by available resources (cost of
a server) and/or internet connection (access to cloud server). Servers used in HOT workflows include:

• POSM
• OpenMapKit Server
• Kobo Toolbox

If the use of a server is not available to you, it is still possible and crucial to store backups of data. In
this case, data will need to be downloaded or otherwise shared with a central location, such as a laptop
computer, and cloned to a secondary location such as a hard-drive or second computer.

Which server should I use?

If you do decide to use a server, use the following table to decide which table is best for your project and
resource restrictions. These are not the only options available, but instead, servers that HOT has used
and tested in the field for mapping projects.

I want to use a server that… Kobo Toolbox OpenMapKit Server POSM

Is physical or does not require internet connection for upload   
Is cloud-based (data upload via internet)   
Accepts ODK data   
Accepts KOBO Collect data   ×
Accepts OMK data × × ×
Can provide data visualizations × × ×
Provides a map visualization of GPS data collected × × 

Kobo Toolbox

Kobo Toolbox is an online application that allows users to build Kobo/ODK surveys as well as store,
aggregate, and perform analysis of Kobo/ODK data.

Kobo Dashboard showing data collected in Uganda

Skill level to implement and manage
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Beginner

Use Kobo Toolbox Server if:

• OpenMapKit is NOT being used.
• Data is collected in .xml format, such as with ODK or Kobo Collect
• Geospatial data collection does not include polygons - GPS points are accepted

Set-up and Data Management Visit kobo.humanitarianresponse.info

OpenMapKit Server

OpenMapKit Server is a cloud based storage system for specially designed to store and compile Open-
MapKit data. Data collected through OpenDataKit can also be uploaded to an OpenMapKit Server.

Skill level to implement and manage Moderate

Use OpenMapKit Server if:

• Collecting .osm data using OpenMapKit.
• Collecting .xml data using ODK and Kobo applications.
• Project Manager need to monitor data as it is collected and uploaded from the field.

Set-up Set up and hosting is provided by HOT for local OSM communities and projects that HOT has
an active agreement with.

Data Management

1. OpenMapKit Server allows for ODK and OMK forms in .xlsx format to be uploaded and converted
to .xml forms. In other words, OpenMapKit Server can convert forms from Excel format to the
digital format readable by ODK, Kobo, and OMK applications.

2. OpenMapKit Server also allows for Deployments (containing .mbtiles and .osm building layers) to
be uploaded.

3. Both forms and deployments can be downloaded directly to mobile phones and tablets via internet
connection - allowing for remote set-up of devices for data collection.

4. Completed forms and data can then be uploaded directly from the field when an internet connection
is available.

5. OpenMapKit Server managers can view the the incoming data and download in a variety of formats.

POSM

Portable OpenStreetMap, or POSM, is a physical server that contains a set of OpenStreetMap tools,
including OpenMapKit server. POSMs allow multiple users to connect and upload data from data collec-
tion devices to a central location without the need for internet access. This data can then be aggregated
using the OMK Server and synced with OSM directly or downloaded for analysis and processing.

Skill level to implement and manage Expert

Use POSM if:

• Project Managers will need to procure hardware for assembling a POSM, or parts for self-assembly.
Additionally, teams will need to have skills for setting up a server on the device. Due to these
requirements, POSM is only recommended for teams that have technical support available.

• Surveyors will not have access to internet for data upload
• Surveyors will be able to convene for upload to POSM (i.e. able to gather to return to a location
where the POSM is kept)

• Project managers are able to procure and purchase a POSM device

Set-up and Data Management Visit the POSM.io website.
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4.0 Introduction to Field Mapping Management

In this section, Project Managers will find tools and resources to lead andmanage field mapping activities
as well as resources designed for their team including:

• Step-by-step guides for surveyors, mappers and field supervisors to manage and use data collec-
tion tools in the field

• Resources and step-by-step guides for managers on how to organize and monitor teams in the
field

Effective Field Mapping Management - knowing when, where, and what data is collected by each team
member - is critical to ensuring that mapping efforts are done in a timely and safe manner with high
quality and completeness. Additionally, field supervisors and team members will need the skills to set-
up and manage field data collection tools. This section provides guides for setting up and using three
tools: OpenDataKit, OpenMapKit, and OSMTracker.

• 4.1 Managing teams in the field provides project managers and supervisors with tools and re-
sources to assign and coordinate mapping assignment areas (or enumeration areas) to team
members and mappers.

• 4.2 Using ODK Collect serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use ODK Collect.

• 4.3 Using OpenMapKit serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use OpenMapKit.

• 4.4 Using OSM Tracker serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use OSM Tracker.
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4.1 Managing Teams in the Field

This section provides:

• An overview of tools and methods for managing teams in the field.
• Step-by-step guides for using OSMAnd and QGIS to manage team movement and completion of
assignment areas.

Overview

Central to effective and successful field data collection is a well thought out field data collection plan.
This will ensure that field teams face the least number of challenges while out in the field, thus reducing
the number of calls for field support coming to the supervisor.

When planning to deploy a team, it is important for the Supervisor to have a good picture of how many
work days they have versus the man power available to do the work. Once this is done, they will then
go ahead and create small sections of the mapping area, that can be covered in a day by a team of two
mappers or a single mapper depending on the team arrangement.

Similar to the grid in Tasking Manager, creating sections for mapping allows supervisors to divide tasks,
monitor progress, and be able to assess gaps or quality issues.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in creating and implementing assignment areas for field maping.

Skills and Technology Needed

• Computer
• QGIS Installed
• Basic QGIS skills
• QuickMapServices

Creating Mapping Sections in QGIS for Printed Maps

The following activity covers the process of generating mapping sections in QGIS for printing. This
activity uses the example of leading a team of 8 mapping volunteers to map Grootfontein Town, in
Northern Namibia, during a Malaria Elimination Project. Example files are provided for this activity but
can be followed with files provided by the user.

To begin, open QGIS on your computer and start a new project. Using QuickMapServices as a basemap,
navigate to Grootfontein Town, Northern Namibia.

Create an empty shapefile by selecting ‘Layer’ > ‘Create Layer’ > ‘New Shapefile Layer’. After selecting
the location and name of the file, make sure to assign the file as ‘Polygon’.

Enable editing, select the ‘New feature’ too. Create sections of the town, giving them numbers. These
sections should follow natural features or prominent landmarks such as swamps or roads. This is to
ensure that ease of location of these sections by mappers.

Once all sections are created, style for visibility.

Make maps showing these sections. These maps can be printed out for sharing with the mapping
volunteers. Teams can now head to their allocated sections to conduct field mapping.
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Creating and Importing Mapping Sections into OSMAnd

The following activity covers the process of importing files into OSMAnd based on the previous activity
(generating mapping sections in QGIS). This activity uses the example of leading a team of 8 mapping
volunteers to map Grootfontein Town, in Northern Namibia, during a Malaria Elimination Project.

OSMAnd provides a great alternative to printing out these sections maps. With OSMAnd, the Supervisor
can instead use the following steps to give sections to team members for use in the field directly on their
mobile devices.

1. Create section centroids from the grootfontein_sections.shp giving you grootfontein_sections_centroids.shp.
Create centroids by selecting the ‘Vector’ menu > ‘Geometry Tools’ > ‘Centroids’. In the sub-menu,
select the grootfontein_sections.shp file as the Input layer, click ‘Run.’

2. Export the sections shapefiles (grootfontein_sections.shp) and the centroids shapefile (groot-
fontein_sections_centroids.shp) as a .gpx giving you a grootfontein_sections.gpx and groot-
fontein_sections_centroids.gpx.

3. Transfer these two .gpx files from you computer to the _/Phone/Android/data/net.osmand/files/tracks
_folder

4. Open OSMAnd application and load these two files via Menu button -> My Places -> Tracks ->
Browse to where the files are located

The sections gpx file will show you boundaries of the sections and the centroids gpx file will show you
section numbers once a centroid point is selected. With these two, volunteers can move in the field using
the OSMAnd app, locating their positions each time as well as the sections in which they are standing.
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4.2 Using ODK Collect

This guide provides surveyors, mappers and field supervisors with the skills to:

• Complete the initial setup for ODK Collect
• Use ODK Collect for data collection surveys

Overview

Open Data Kit Collect (ODK Collect) is a data collection application on Android. ODK Collect can
replace form survey from paper to digital. Therefore, this application will help the mapping and data
collection activities in the field which also allow to save the location and photo information at once.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Initial Setup for ODK Collect

1. Set the URL Server If you are not using a server, skip to step 2. Set the Image Size

To take the form survey from the server for the first time, the user needs to set the URL server. There
are the steps:

• Open ODK Collect and press the three point button in the upper right corner, select General Set-
tings → Server

Option to fill the URL address menu in ODK Collect

Option to fill the URL address menu in ODK Collect

• Type the URL address server in URL → OK

Step to fill the URL address in ODK Collect

Step to fill the URL address in ODK Collect

2. Set the Image Size

In addition to the location point, you can also take a picture as additional information. If you will be
collecting images as part of your data collection surveys, you can set the picture resolution as desired.
But, the picture resolution will also affect the amount of your phone memory or file which will be uploaded
to the server later. It is recommended that you choose the smallest resolution of the image during initial
setup. You can follow this step:

• Open ODK Collect and press the three point button in the upper right corner, select General Set-
tings → Form Management.

Option menu to set image resolution

Option menu to set image resolution

• Select Image Size then select the Very Small (640px) option.

Image Size menu to set the image resolution

Image Size menu to set the image resolution
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ODK Collect basic operations

1. How To Get a Blank Form Survey From Server If you are not using a server and surveys were
manually uploaded to the device, skip to step 2. Fill the Survey Form

Before you fill-out the form survey that you made before, you need to download the blank survey form
from specified server. You can follow this step to take a blank survey from the server:

• Press Get Blank Form and wait for the form to download from the server and make sure your
internet is active.

Get blank form options to take form on a server

Get blank form options to take form on a server

• Select the available form, tick the check box or if you want to select all the form, you can Select
All. If your form does not appear, can press Refresh to reload the page.

Page display on Get Blank Form menu

Page display on Get Blank Form menu

• After select the form, you can press Get Selected to download the selected form.

Page display on the Get Blank Form to get the survey form

Page display on the Get Blank Form to get the survey form

2. Fill the Survey Form * To fill the form, back to the start page and select Fill Blank Form menu. And
then select one form blank that you want to fill in the survey form list.

Fill Blank Form options for filling out the survey form and blank survey form list

Fill Blank Form options for filling out the survey form and blank survey form list

• Swipe to right or left on the screen to move the next/previous page. Questions that have a red star
in the top left are required and you can not go to next question if the answer is empty.

Examples of mandatory question (red star)

Examples of mandatory question (red star)

• You can take photos directly by choose Take Picture option or select a photo from your photo
gallery by select Choose Image.

Take photo display in ODK Form

Take photo display in ODK Form

• To add object location points include OSM object tag, you can use additional application, that is
OpenMapKit (OMK). You can immediately switch to OMK application by press Launch OpenMap-
Kit on the form. You can learn about using OMK application in section 4.3 Using the OpenMapKit.

Launch OpenMapKit button on the survey form

Launch OpenMapKit button on the survey form

• At the end, you can name the form, tick checkMark form as finalized and at the end choose Save
Form and Exit to finalize the final form survey.

Finalization of page views on the survey form

Finalization of page views on the survey form

3. Edit the Completed Survey Form The saved form automatically save in ODK Collect. (Note: we do
not recommend editing forms collected via OpenMapKit due to potential data error.) If you want to edit
the completed form, you can follow this step:

• You can back to start page and choose Edit Saved Form.
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Edit Saved Form for edit the saved form

Edit Saved Form for edit the saved form

• Select the form that you want to edit by press the form and you can edit the form.

Edit save form page to select the form that you want to edit

Edit save form page to select the form that you want to edit

• Then, press floppy disk icon

Edit save form page to select the form that you want to edit

Edit save form page to select the form that you want to edit

Transferring Completed Forms

After completing data collection, all forms will need to be transferred from the data collection device to
a central storage location for data cleaning and processing.

1. Manual Download

If you do not have access to a server, forms can be manually downloaded from devices. To do so, plug
the device into a computer.

• Go File Manager or File Explorer on your smartphone and open your internal storage. Then open
ODK folder. This folder contains all the survey result file which stored on ODK Collect application.
Then select the ‘instances’ folder which contains the files from the survey results.

Instances folder in ODK folder and the survey result in instances folder

Instances folder in ODK folder and the survey result in instances folder

• Copy the ‘instances’ folder to your computer. Rename the folder by date and surveyor.

2. Upload Survey Forms to Server

After you fill and save the form, the next step is upload form survey to server. You can follow this step
to upload form to server:

• To upload the form return to the server, you can choose Send Finalized Form.

Send Finalized Form to upload a survey form to the server

Send Finalized Form to upload a survey form to the server

• Form survey is saved on that page and ready to send. You can choose Select All to select all
forms first.

• Make sure you are connected on the internet. Then press Send Selected and wait until the pro-
cess_ upload_ the form is complete.

Survey forms that are ready to send in the Send Finalized Form

Survey forms that are ready to send in the Send Finalized Form

• All forms that have been successfully uploaded will be stored in View Sent Form menu and the
icon turn into green.

View Sent Form and survey form that have been successfully uploaded to the server

View Sent Form and survey form that have been successfully uploaded to the server

• After upload the form, you can delete the form in Delete Saved Form menu.

Delete Saved Form menu for delete the form

Delete Saved Form menu for delete the form

• You can delete the the filled form in Saved Forms option and delete the blank form in Blank Forms
option. You should choose the form that you want to delete or Select All for delete all form.

67



Delete Saved Form option

Delete Saved Form option

• You need to confirm to delete the survey form by choose Delete Forms

Delete confirmation dialog box

Delete confirmation dialog box

3. Upload Survey Form to Google Drive

After you upload all the survey form to server, you may want to save and upload the survey result file in
.zip format in Google Drive folder that was created by your mapping supervisor. This is the step:

• Go File Manager or File Explorer on your smartphone and open your internal storage. Then open
ODK folder. This folder contains all the survey result file which stored on ODK Collect application.
Then select the ‘instances’ folder which contains the files from the survey results.

Instances folder in ODK folder and the survey result in instances folder

Instances folder in ODK folder and the survey result in instances folder

• Before you move instances folder to your computer, you need to convert the folder to .zip format
by pressing the instances folder and select Compress. You can change the .zip file name.

The step for convert to .zip format

The step for convert to .zip format

• After you move .zip file to your computer, you can upload the file to Google Drive that already set
by your mapping supervisor.

The .zip file that ready to move to computer

The .zip file that ready to move to computer

• You can upload the file to Survey Result folder (or another name that your mapping supervisor
made) by click right on your mouse then choose Upload Files and choose the file that you want
to upload.

The folder on Google Drive for upload .zip file

The folder on Google Drive for upload .zip file
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4.3 Using OpenMapKit

This guide provides surveyors, mappers and field supervisors with the skills to:

• Configure OpenMapKit on devices for individual use and data collection
• Operate OpenMapKit for field data collection

Overview

OpenMapKit (OMK) is an additional application that is used to support ODK Collect in determining the
position of objects found during precise and precise field surveys. OpenMapKit can be run through ODK
Collect, after you open and select one of the available forms. In determining the location of an object,
OpenMapKit requires a map background in the form of a satellite imagery or OSM map. If you use the
OSM as the map background, the thing to note is that the data must be available on the OSM server.

Prior to learning how to use OpenMapKit, users should know how to use ODK (OpenDataKit) Collect,
an android-based application to replace paper form for surveys as OpenMapKit is an extension of ODK
Collect. This extension is used to add information on the position or location of the object surveyed.

*If you have not yet completed the initial set-up OpenMapKit, see 3.2.2 Setting up OpenMapKit before
proceeding.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Configuring OpenMapKit

Before you use OpenMapKit, you must first make sure each device is confirgured. The following are
step by step instructions of the initial OpenMapKit Configuration:

• On the home page of OpenMapKit, press the settings button located in the upper right corner.
This will allow you to download deployments (if applicable), select a basemap, and select the
OSM buildings layer.

1. Deployments If using OpenMapKit Server and deployments, follow these steps to download files
needed for field mapping. If not using deployments, skip to 2. Basemap.

• Open the OpenMapKit app, tap on the Settings button in the top right corner, and select Deploy-
ments [1].

• Select the appropriate deployment (i.e. census-versalles). Select the black download button in the
lower right corner.

2. Basemaps By default, OpenMapKit will display the Online Humanitarian OpenStreetMap that can
be accessed using an internet connection. However, if manually added to the device or downloaded
through a deployment, an offline basemap can be opened without an internet connection.

Select and change the OpenMapKit basemap by pressing the settings button located in the top right
corner and pressing Basemap then select the .mbtiles. Then press OK.

Display basemap settings in OpenMapKit

Display basemap settings in OpenMapKit
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3. OSM Buildings Layer Selecting an installed OSM File Open the OpenMapKit app, tap on the
Settings button in the top right corner, and select OSM XML Layer [3]. Select the correct .osm layer for
the locality that is being worked in.

Downloading OSM file If your device does not have an OSM buildings layer (.osm file) pre-loaded or
a file was not downloaded with a deployment, users can still download an OSM buildings layer with an
internet connection. Users will need to complete the following steps:

• Navigate the map to your current location (for example, you are already on the survey location) by
pressing the round button in the lower right corner of the screen until the round button is colored
blue. A black dot will appear at your current location.

Navigate to the current location in OpenMapKit

Navigate to the current location in OpenMapKit

• Press the settings button in the top right corner

• Select OSM XML Downloader to start download OSM data according to the view on the screen of
your smartphone (the duration depends on the size of the area). Make sure you are connected to
an internet connection when downloading OSM data. Note the color of the building, the building on
the OSM _basemap _have brown color and the building from OSM XML Downloader is purple.

Building colors

Building color on the OSM basemap (left) and downloaded building color (right)

• Your new downloaded OSM data will be saved in the format .osm which can be activated or deac-
tivated via the settings button → OSM XML Layer.

OSM XML Downloader menu and OSM XML Layers menu

OSM XML Downloader menu and OSM XML Layers menu

4. Enter OSM Username Select OSM User name OSM and enter your User Name

Display settings menu OpenMapKit

Display settings menu OpenMapKit

Using OpenMapKit

Once you have configured your basemap and OSM layer, you can add the building information by:

• Select the building to which the information will be added. Make sure the building is purple which
indicates that the building has been downloaded from OSM. If the building is selected, the color
will change to orange.

• You can fill the building information in accordance with the form you have chosen before in the
ODK Collect application, with press the information tag in the first row located below.

Fill out building information using a form from ODK Collect

Fill out building information using a form from ODK Collect.

• When done, at the end of the page select Save to save the form to ODK Collect. If you have
completed filling in the form, the building that you fill in the information will look like this:

The building that has been filled in the information

Building that has been filled in the information

If the building data for location of your survey is not yet available in the OSM, you can map the building
before conducting the survey. If you don’t have time to do the mapping, you can use points to mark the
object in the OpenMapKit by:
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• Press the plus (+) icon in the lower right corner of your screen until it turns green. It will appear
green marker with the words Add Node on it. Slide the map until the location of the marker is
accurate with the object in the field.

Add marker using plus icon

Add markers using the plus (+) icon

• Press Add Node if the point is accurate

Add node button when adding a point

Add note button when add point

• If the point you add turns out to be in a position that is not in represent with the object in the field,
you can move the point that has been added by clicking on the point to move then press the two
arrow icon in the top right corner. The color of the point will turn orange and above it will be appear
Place Node.

Swipe points that have been added

Swipe points that have been added

• Slide the map to the accurate point position, then press Place Node.

Place node button when shifting a point

Place node button when shifting a point

• After the position is accurate as the object in the field, you can fill out the form the same as the
previous step.

• Enter information that matches the conditions in the field. Swipe the screen right or left to change
thepage questionon the form.

• At the end of the page, select Save to save the form to ODK Collect. If you finished to fill in forms,
the marker that you fill in the information will look like this:

the point of objects already loaded with informations

Point of objects already loaded with informations

• Now you can see the form has been successfully saved on the ODK Collect.

Note: all OpenMapKit surveys will be launched from the ODK application.
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4.4 Using OSMTracker

This section provides surveyors, mappers and field supervisors with the skills to:

• Complete the initial setup for OSM Tracker
• Use OSM Tracker for recording tracks, images, and notes

Overview

OSMTracker is an android application that allows us to record our survey data. Similar to GPS, OSM-
Tracker is able to record waypoint and also track. What makes OSMTracker different with common GPS
device is its capability to take pictures when you collect the survey data. With these images taken, it will
make your mapping more easier because you can track back what object you have been taken and take
a look into your pictures for more detail. Waypoint and track that you have collected can be converted
into .gpx file so you can open your survey data using JOSM or you can directly upload your data into
OpenStreetMap.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Downloading and installing

If you want to use OSMTracker you can download the application on your smartphone. Open your
Google Playstore and search OSMTracker in search box.

You can download OSMTracker on Google Playstore

You can download OSMTracker on Google Playstore

After the installation finished, open your OSMTracker application on your smartphone.

OSMTracker page display

OSMTracker page display

Initial Setup for OSMTracker

Before you can use the OSMTracker, there are few setting you have to do. Go to

Setting button on the top right corner and then select Settings.

Select Settings menu on OSMTracker

Select Settings menu on OSMTracker

On the settings page there are several things you have to look:

Several configurations on Settings menu

Several configurations on Settings menu

1. GPS logging interval

This section will set how often your OSMTracker record the track. If you set the number smaller,
OSMTracker will record the track more often. The default value for this setting is 0, which means
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that OSMTracker will always record your track. This will affect your battery life. You can change
the number according to your need, for example 2 second.

2. External storage (SD) directory

This section determine where you want to save all your survey data on your smartphone. By
default, OSMTracker will create a new folder called “osmtracker” on your smartphone’s internal
storage. If you don’t want to change this setting, you can ignore this section.

3. One directory per track

If you activate this feature, each track you save will create a new folder in your internal storage.

4. Filename for named track

This section will set the labelling of you survey data. By default, the labelling consists of track
name, survey date, and survey time. You can ignore this setting if you don’t want to change it.

5. Screen always on

If you activate this feature, you will let your smartphone always turn on when you use OSMTracker.
When you using this setting, it will drain your smartphone’s battery fast. You can change it as you
needed.

6. Background map

Use this setting to show the background map on your track. Activate this setting so you can see
your survey track with map as it’s background.

7. Map tile provider

You can change your background map using this feature.

After all the setting is done, then you are ready to use your OSMTracker. Always remember to activate
your GPS setting on your smartphone, then you can open your OSMTracker. If you are using OSM-
Tracker for the first time, your home page will be empty. Later, all your survey data will show up on your
home page.

OSMTracker Basic Operations

1. Recording Survey Track

If you want to start your track recording, you can select the button + on your top right of your screen.
You will see the Track Logger page.

Use button to start recording

Use + button to start recording your track

Remember to always check your GPS accuracy. All feature on OSMTracker will not available if you
are not receiving a good GPS signal. Try to get GPS accuracy as best as you can (below 10 meter)
to prevent a mistake when recording your current position. You can see your GPS signal indicator on
your top right corner of your screen (look at the picture). The signal bar color will change to green and
become full when you receive a good signal. Make sure you are in a good position to receive signal.
Locate yourself on the open field and make sure you are not under the roof or tree.

Track logger feature

Unable to activate track logger function because the GPS signal is not good enough (left); Track logger
is activated if GPS signal is good enough (right)

When the GPS accuracy is good enough, then you can start to record your track. When you press the
+ button and the GPS accuracy is good enough, OSMTracker will automatically record your track.

2. Recording Object using Waypoints and Picture

When you open your Track Logger page, there are many buttons to access, but if you want to record
waypoints and also picture, you only have to use this 2 button:
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Track logger page on OSMTracker

Track logger page on OSMTracker

1. Text Note

Use Text note to mark your current position as a waypoint. Just press this button and then fill the
information. For example, you can label your waypoint with number and then the name of your object.

Text note function to record waypoint on your survey

Text note function to record waypoint on your survey

2. Take Photo

Use Take Photo to take your object photos. You can straight use your smartphone camera or you can
select the photo from your gallery.

You can choose to take the photos straight from your camera or select from your smartphone’s gallery

You can choose to take the photos straight from your camera or select from your smartphone’s gallery

3. Stop and Continue Track Recording

If you want to stop your recording, you can follow these steps:

1. On the Track Logger page, please go back to your home page, then find one file track you have
collected before. Press on that file for a while until additional menu is shows up.

Option to set stop tracking

Option to set stop tracking

2. Choose Stop tracking.

3. You can also press Save button on the top corner on your Track Logger page to stop the recording
and save your record.

If you want to continue your track record on your previous file, then you have to :

1. Press on your previous file until additional menu is shows up. Resume tracking
Select to resume tracking

2. Then choose Resume Tracking

Note :

Ikon

If your file has an orange color clock icon, it means that your file still on track recording mode.
This icon will disappear after you stop and save your file.

4. Showing List of Objects Collected

You can see list of objects you have collected. On Track Logger page, press the Setting button on the
top right corner of your screen, then selectWaypoints.

Button to show list of waypoints

Button to show list of waypoints

You will see the list of objects and the photos you have collected on the Waypoint list.

Waypoint list to see list of objects you have collected

Waypoint list to see list of objects you have collected

5. Showing Tracks and Waypoints Collected

You can also see your track and waypoints you have collected. On your Track Logger page, choose
menu Setting on the top right corner of your screen, then choose Display Track.

Display track button to see your track and objects you have collected

Display track button to see your track and objects you have collected
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When you choose to display your track, OSMTracker will ask your permission to show the background
map. Choose Display Background Map.

Option to display your background map

Option to display your background map

You will see the map with line, star, and people icon on the top of the map. The star icon represent the
waypoints, the line represents the track you have collected, and the people icon shows where is your
current position on the map.

Track and object’s collected on field survey

Track and object’s collected on field survey

6. Saving the OSMTracker Data

After you collecting the data, you can save your data and use it for your mapping guide. In order to
do that, you need to save your survey data as a .gpx data format. After that, you can upload it to
OpenStreetMap server or you can move the data to your laptop.

7. Saving Track and Waypoints as .gpx Data

You can save your track and waypoint into .gpx data. You can open .gpx data with mapping software
like QGIS and JOSM. On your survey file, select and press the file for a while, then select Export as
GPX. If the process is successful, you can see the green dot on the right side of the file name.

Menu to save your survey data into GPX

Menu to save your survey data into GPX

8. Uploading Track to OpenStreetMap Server

You can upload your survey data to OpenStreetMap server. On your survey file, press and hold it for a
while, then select Upload to OpenStreetMap.

Menu to upload your survey data into OpenStreetMap

Menu to upload your survey data into OpenStreetMap

On OpenStreetMap Upload page, you need to fill the form like name and file description. You can ignore
on Tags section. On the bottom section, you can set the track for :

1. Private

Track will not shown up to the public. Trackpoints can be accessed on the time sequence using GPS
API without time stamp.

2. Public

Track will be shown to the public and available for download to the other user.

3. Trackable

Track will be shown to the public, but trackpoints still can be accessed by public GPS API. Other user
can download your data but it will not connected with you.

4. Identifiable

Track will be shown to the public. Other user can download your data and can refer your OSM username.

For this option, you can choose Trackable or Public so another user can download your data.

Survey data is ready to upload into OpenStreetMap server

Survey data is ready to upload into OpenStreetMap server

9. Copying Track and Waypoint to Laptop/Computer

All the .gpx data stored in your internal storage of your smartphone. You can search the file using your
file manager. To copy the data, you can follow the instruction:
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1. Connect your smartphone to your laptop using your smartphone cable and then find folder called
“osmtracker” in your smartphone.

OSMTracker folder on your smartphone’s storage

OSMTracker folder on your smartphone’s storage

2. Inside of your OSMTracker folder, you can find a folder containing a .gpx data and photos. Copy
the entire folder into your laptop.

Example of OSMTracker data consist of .gpx file data and survey photos

Example of OSMTracker data consist of .gpx file data and survey photos

3. Open your JOSM, and then open your gpx data. Select menu File → Open and then open the
.gpx data format.

Open your file with .GPX format data on JOSM

Open your file with .GPX format data on JOSM

4. When you open your .gpx file, JOSM will automatically shows track and waypoint along with the
photo as well.

Field survey data when you open it on JOSM

Field survey data when you open it on JOSM

You can use your survey result as a guidance for your mapping using JOSM. The photos taken will help
you identify what object you should create in JOSM.
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5.0 Introduction to Data Cleaning, Upload, and Quality Assurance

In this section, Project Managers will find tools and resources to clean and upload field collected data to
OpenStreetMap and manage data quality including:

• Step-by-step guides cleaning data in JOSM for upload to OpenStreetMap.

• Resources for data quality tools to use following upload to OpenStreetMap, including presenta-
tions.

Data Cleaning, Upload, and Quality Assurance is a critical step in any mapping workflow. This process
covers cleaning raw field data for errors and mistakes, uploading clean data to OpenStreetMap, and
using various quality control tools to monitor data that has been uploaded. Regardless of how (and
if) you are collecting field data, any project that results edits in OpenStreetMap should have a quality
assurance and control plan.

• 5.1 Data Cleaning in JOSM covers the process and steps required to clean field data and the
uploading process using JOSM.

• 5.2 Quality Assurance Tools provides a guide to tools HOT uses for monitoring and checking data
quality of data uploaded to OpenStreetMap.

The following presentation(s) can be used to lead a training or workshop:

• Quality Assurance Tools

77

https://hotosm.github.io/toolbox/pages/data-cleaning-upload-and-quality-assurance/5.1-data-cleaning-with-josm/
https://hotosm.github.io/toolbox/pages/data-cleaning-upload-and-quality-assurance/5.2-quality-assurance-tools/
https://docs.google.com/presentation/d/1mn0ahFOCiz9DhrWmYFt1nrC25c7WQjODvXG6pTRJ-Jo/edit?usp=sharing


5.1 Data Cleaning with JOSM

This section provides:

• An overview data cleaning tools in JOSM
• Step-by-step instructions for importing field data into JOSM
• Step-by-step instructions for cleaning data into JOSM

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to clean and
upload field data in JOSM.

Overview

Data collected in the field should always be cleaned for errors and rectified with existing OSM data
before upload. There are a lot of OSM data editors available, but in this module the OSM data editor
used is JOSM. JOSM has a lot of useful tools and plugins, making OSM mapping a lot easier but most
importantly, it is the easiest tool and best tool for maintaining quality OSM data while importing batches
of field data into OSM.

to-do list in JOSM

JOSM Data Cleaning Tools

There are tools built into JOSM, as well as additional plugins that can assist with data quality control
during the upload process.

• Filters is a built-in tool that allows you to disable, hide, select, and highlight specific groups of
objects based on flexible custom parameters. This tool will help you to spot and avoid common
mistakes, and review data.

• The Validation Tool is another built-in tool that will review and search for common errors as well
as provide warnings about potentially problematic data.

• The Todo List plug-in allows users to systematically review data that is to be uploaded, andmonitor
progress of data cleaning work. The “ToDo List” plug-in, needs to be downloaded before it can
be used. Visit this page to learn how to install plug-ins in JOSM, then download the “ToDo List”
plug-in.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Adding Survey Data into JOSM

Following a field data collection activity using JOSM, use the following step-by-step guide to clean and
upload data to OSM. By following these steps, you will be able to:

• Install plugin Utilsplugin2
• Merge all survey data
• Save .osm file using JOSM
• Download OSM data
• Add satellite imagery layer on JOSM
• Add and edit OSM data using JOSM
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• Upload changes into OSM

• View changes of OSM data in OSM website

Skills and Technology Needed

• Computer
• Internet Connection
• JOSM Installed
• Basic JOSM skills
• Survey data

1. Installing plugin Utilsplugin2

Before adding or editing OSM data using JOSM, install plugin you’ll be using first. JOSM has a plugin
called utilsplugin2 whose one of the functions is makes copying preset/tag easier. To use this plugin,
you have to install the plugin first since it is not installed by default. These are the steps to install plugin
utilsplugin2:

• Open JOSM
• Click menu Edit → Preferences
• Select menu Plugins to install new plugin. If you haven’t downloaded available plugins, click
Download List first to download it. Make sure that you are connected to the internet.

• After downloading plugins, search the utlisplugin2 by typing it in the search box. After you found
it, give a check on the checkbox next to utilsplugin2.

Installing plugin utilsplugin2

Installing plugin utilsplugin2

• Click OK and wait until the installation process is finished. If the plugin has successfully installed,
there will be More tools menu on your JOSM.

More tools menu on JOSM

More tools menu on JOSM

Note: Sometimes JOSM ask you to Restart JOSM after installing new plugin to apply newly
installed plugins. However, not all newly installed plugin needs JOSM restarting to be used
after installation process finished.

2. Importing Field Data

2.1 Merging OMK Survey Data *Note: if your data is in a different format, skip to b. Importing Survey
Data (non-OMK).

If you have finished conducting survey using field data collection toolkit such as ODK Collect and Open-
MapKit, you can use the survey data as the reference to add object’s information when mapping it in
OSM. Survey data file format from OpenMapKit is .osm. The number of .osm files from OpenMapKit will
be the same amount as the surveyed objects since information of one object will be saved in one .osm
file. Merge all .osm file to make it easier to use the survey data as mapping reference by following these
steps:

• Go to File Explorer to where you save .osm file from ODK Collect and OMK.

File directory for .osm file from ODK Collect

File directory for .osm file from ODK Collect

• Search all .osm file by typing “osm” in the Search box. Select all .osm file from the search results.

Search results for keyword “osm”

Search results for keyword “osm”

• Drag all selected .osm file to JOSM.

Layers Windows after .osm file from ODK and OMK dragged into JOSM

Layers Windows after .osm file from ODK and OMK dragged into JOSM
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• Select all those .osm layer by selecting the uppermost .osm layer, then pressing Shift and then
selecting the lowermost .osm layer

• Right click on one of the .osm layer, then click Merge. Select target layer Windows will appear,
you do not have to change the target layer, click Merge.

Merging all survey data layer

Merging all survey data layer

• Save the merged layer and change the name by right-clicking on the merged layer, select Save
As, change the layer name and then click Save.

Saving the merged survey data layer

Saving the merged survey data layer

• JOSM provides a plugin named to-do to help you mark the mapped or unmapped object from
the merged survey data layer. You can refer to Using to-do list on JOSM module to learn how
to install and how to use to-do plugin in details. If you have already installed to-do plugin and
activated Todo list Windows, select all objects nodes in the merged layer using Select object icon,
then click Add on the Todo list Windows.

Adding objects into Todo list

Adding objects into Todo list

2.2 Importing Survey Data (non-OSM)

You will need to convert your data into a .geojson, .shapefile, or .osm file before beginning data cleaning.
We recommend merging and converting files in .QGIS, then open the merged file in JOSM.

3. Downloading OSM Data

After successfully merging all survey data, you need to download existing OSM data. Downloading OSM
data aims to discover which objects already mapped and which objects have not already mapped on
OSM. These are the steps to download OSM data using JOSM:

• Click menu File → Download Data
• Download Windows will appear. It will show you tab Slippy Map by default.

Download Windows on JOSM

Download Windows on JOSM

• If the map is not displaying your mapping area, slide the map by right clicking and hold your
mouse and then drag the map to your mapping area. Draw a box at your mapping area by left
clicking and hold your mouse and thenmove your mouse until a pink box cover the entire mapping
area. Then click Download.

• If it is quite hard to find your mapping area by sliding the map, you can click tab Areas around
places and type the name of your mapping area in the Enter a place name to search for box then
click Search. The search result will show you names of your mapping area. Click on one of the
names then go back to tab Slippy Map. The map on the tab Slippy Map will be directed to your
mapping area. Draw a box covering your entire area of mapping, then click Download.

Note: Do mind the amount of existing OSM data in your mapping area. If there is already
a lot of existing data, you should download it part by part since JOSM can not download an
enormous amount of data at once.

Tab “Areas around places” at Download Windows

Tab “Areas around places” at Download Windows

• After finished downloading OSM data in your mapping area, there will be a new layer in the Layer
Windows that will also be your editing layer to add or edit OSM data. Make sure that you only add
or edit data in the clear area, not in the shaded area. The shaded area is not your downloaded
area. And make sure your entire survey area is already downloaded. After downloading OSM
data, your JOSM will look like this:
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Downloading OSM data on JOSM

Tab “Downloading OSM data on JOSM” at Download Windows

• If you already downloaded OSM data in all your area, merge your downloaded OSM data layer
with your survey data layer. Select those two layers then right click, select Merge. Save on your
survey data layer. Then click Merge.

Merging downloaded OSM data with survey data layer

Merging downloaded OSM data with survey data layer

4. Adding Satellite Imagery

• Add satellite imagery as another reference for mapping by clicking menu Imagery → choose
one of the available imagery you want to use, such as DigitalGlobe Premium Imagery. After
successfully adding satellite imagery, it is time to add OSM data. Your JOSM will look like this:

Adding satellite imagery on JOSM

Adding satellite imagery on JOSM

• You can adjust the display of the satellite imagery. Select the satellite imagery layer, then click icon
Change visibility of selected layer and adjust its display by sliding the blue button left or right.

Changing the display of satellite imagery

Changing the display of satellite imagery

• If you use DigitalGlobe Premium Imagery as your reference, sometimes it has two versions of
display when you zoom it in or zoom it out. Usually there is only one version of display aligned with
the existing OSM data. Inactivate Auto Zoom feature so that the satellite imagery display won’t
change when you zoom it in or zoom it out. To inactivate Auto Zoom feature, right click on the
Satellite Imagery display → click Auto zoom so that the checkmark next to Auto zoom disappear.

Inactivating Auto zoom for satellite imagery

Inactivating Auto zoom for satellite imagery

5. Editing OSM Data Using JOSM

Now you are ready to add or to edit OSM data using JOSM. You can draw new objects or you can edit
the existing objects using the tools mentioned in Using JOSM module. Here are the steps on how to
add or edit OSM data using survey data, downloaded OSM data and satellite imagery that you already
added before on JOSM:

• After successfully following the stepsmentioned in the previous sections, there will be two layers on
your JOSM: satellite imagery layer (in the picture below, the layer meant is DigitalGlobe Premium
Imagery layer) and merged survey data with downloaded OSM data layer (in the picture below,
the layer meant is hasil_survey_jakut.osm layer). It will look like this:

Satellite imagery layer and merged survey data with downloaded data layer

Satellite imagery layer and merged survey data with downloaded data layer

• You can use Filter feature on JOSM so that you don’t accidentally make changes on other objects
such as administrative boundaries. Administrative boundaries in OSM is a delicate objects, so if
there are already administrative boundaries mapped on your mapping area then it is better to utilize
the Filter feature. To use this Filter feature, activate the Filter Windows by clicking menuWindows
→ Filter. There will be Filter Windows in the right panel. Click Add in the Filter Windows, type
boundary=administrative in the Filter string box and click Submit Filter. New filter will appear for
the administrative boundaries. To turn off the filter, simply uncheck the checkmark on the left of the
filter. You can find out more about Filter feature on JOSM in the Using Filter on JOSM module.

Filter Windows on JOSM

Filter Windows on JOSM

Adding filter string in the Filter Windows
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Adding filter string in the Filter Windows

Newly added filter in the Filter Windows

Newly added filter in the Filter Windows

• Start mapping by zooming in to an object, select one object in the Todo list Windows and then click
Zoom. After selecting and zooming in one object, you can copy the tag from the selected object
to the downloaded OSM objects. Select the downloaded OSM object that aligns with the selected
survey object, then click menu More tools → Copy tags from previous selection or press Shift
+ R on your keyboard. Make sure you selected the aligned survey object right before copying its
tags to downloaded OSM object. Also make sure that the copied tags are consistent with OSM
mapping guidelines and suitable for the object type. For example, in the picture below, a clinic
located in a shophouse complex, mapped as a point and only have tags suitable for point object.
While the building related tags added to the shophouse building where the clinic is located. When
you finish copying tags for one object, click Mark to identify that it is just already mapped on OSM.
Repeat until all of the objects mapped on OSM.

Using Zoom dan Mark feature on the Todo list Windows

Using Zoom dan Mark feature on the Todo list Windows

Tags suitable for point object

Tags suitable for point object

Copying building related tags using Shift + R

Copying building related tags using Shift + R

• Example given above is for point object. When you find an object that is supposed to map as a
polygon, such as school complex which has more than one building inside, how to map it on OSM?
Select the school object in the Todo list Windows and then click Zoom. Select the point object on
the map. Copy the tag to the building polygon aligned with the point object by selecting the building
polygon and then clicking menu More tools → Copy tags from previous selection or pressing
Shift + R on keyboard. After copying the tags, delete tags that are not related to building and left
only building related tags. Draw a polygon covering all school area using Draw nodes, then copy
tags that are suitable for school area (tags that you deleted before in the building polygon) like
amenity, name and addr:full. After that, delete the school point from the survey data since it has
just been mapped as a school area polygon.

School point from survey data

School point from survey data

Tags suitable for school building

Tags suitable for school building

Tags suitable for school area

Tags suitable for school area

6. Saving Changes

• If you have already done mapping using JOSM, save changes to OSM server because the newly
added objects are saved only in your computer. To save the changes you’ve made, click menu
File → Upload Data.

• If you encounter warning/error after clicking Upload Data, it is better to fix warning/error first. You
can find out more about fixing warning/error and common warning/errors found in Survey Data Val-
idation Using JOSMmodule. However, if you don’t have the time to learn how to fix warning/error,
you can just go ahead and click Continue Upload. Upload Windows will appear.

• If there is no warning/error, Upload Windows will appear. On the Upload Windows, type a brief
comment for the changes you’ve done in the comment box and specify the source(s) in the source
box. Type the name of the satellite imagery and survey in the source box. If you want other
contributors to review your edits, give a checkmark next to I would like someone to review my
edits. Then click Upload Changes.
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Upload Windows on JOSM

Upload Windows on JOSM

Note: You need to periodically upload your edits when mapping so that there won’t be a
hefty amount of edits to upload. The more edits you want to upload, the more time it takes
to upload. If you already mapped a lot of edits and haven’t done any upload, you can upload
it by chunk. You can do it by clicking tab Advanced and select Upload data in chunks of
objects in the Upload Windows. Type the Chunk size with how many changes you want to
upload per chunk, such as 500. This can be done to avoid incomplete upload, especially
when your internet connection is unstable that resulted in object duplication.

7. Saving .osm File

• You can also save your editing layer by right clicking on your editing layer and click Save. Save
OSM fileWIndows shown below will appear. Type the name of your file, then click Save. Your file
will be saved in .osm format.

Save OSM File Windows on JOSM

Save OSM File Windows on JOSM

Note: If you haven’t finished mapping your area and you want to continue mapping it later,
you can save your work as .osm file then you can continue mapping it later. You can open
your saved .osm file by clicking menu File → Open, choose the file you want to open and
click Open. After opening it, update the OSM data first by clicking menu File → Update Data
and you can go ahead to continue mapping.

8. Viewing Changes in the Map

• You can view your changes by checking it on OSM website and directing it to your mapping area.
Keep in mind, new changes can be viewed a while after uploading it to OSM server.

OSM map before and after mapping process

OSM map before and after mapping process

SUMMARY

If you can apply and follow through to all of the steps mentioned in this module, then you are able to go
through OSM mapping process using JOSM successfully. You are able to do OSM mapping process,
such as downloading OSM data, adding satellite image, editing OSM data, uploading changes, saving
OSM data as .osm file and viewing changes. You can upload your changes periodically, such as by
region or by village. If you already have finished conducting survey in one region or in one village, you
can upload it directly to OSM. This shall be done so that your survey data is not piled up and others can
perform data validation for your edits.
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5.2 Quality Assurance and Quality Control Tools

This section provides:

• An overview of Quality Assurance tools, including presentation slides
• Guidance on when, why, and how to use each tool
• Brief overviews and step-by-step guides on using each tool

Overview

Quality Assurance and Quality Control is the process by which mappers, and OpenStreetMap con-
tributors in general, check data to ensure that all information uploaded to OSM meets high standards
for usage and to prevent vandalism. As OpenStreetMap is a free and open platform that anyone can
use and edit, it is critical to the sustainability of open data and OSM that everyone participates in the
quality assurance and quality control process – from field data collection to data cleaning to long-term
maintenance of existing OSM data.

While Quality Assurance and Quality Control should be performed at all stages of a mapping project, the
following tools will help ensure that data uploaded to OpenStreetMap meets high quality standards.

## Choosing a Quality Assurance Tool

Which quality assurance tool should I use?

The following are Quality Assurance tools commonly used in the HOT workflow. A detailed overview of
these and other QA tools can be found at the Quality Assurance Tools Wiki. Different tools check for
different errors and issues. Use the following table to decide when and why each tool should be used.

I want to check for… MapCampaigner OSMCha Osmose JOSM Validator

Attribute completeness  × × ×
Potential vandalism ×  × ×
Contributions and upload issues by indivdual user ×  × ×
Tagging issues × ×  
Geometry issues × ×  

MapCampaigner

MapCampaigner is a tool developed by HOT to monitor attribute completeness for predefined areas
of interest (AOI). Based on your data model, the tool checks and highlights any map features that are
missing pre-defined tags within your AOI, and allows team validators to download and fix those features.

Skills and Technology Needed

• Computer with
• Internet connection
• Recommended: computer mouse

How to use MapCampaigner To navigate an existing campaign:

1. Navigate to https://campaigns.hotosm.org in the Google Chrome or Mozilla Firefox internet
browser.

2. Select one of the Projects in the landing page or use the search bar to look for a particular project.
Note: You may need to change the status menu from “Active” to “All” projects if you are not finding
a project.

3. Once a project is selected, scroll down to the feature details. Change the feature type by selecting
a feature from the drop-down menu on the left.
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4. For each feature type, the percent of features with 100% completeness will be shown on the left
panel.

5. On the map, features are colored by the percent of attributes completed. Select each feature to
view the existing tags and missing attributes. mc_monrovia

To create a new campaign: Follow the instructions under the resources tab found here: https://campaigns.hotosm.org/resources

OSMCha

OSMCha, or the OpenStreetMap Changeset Analyzer, is a tool designed to review uploads and changes
to OSM data, largely to prevent vandalism and bad edits made to map data. This tool allows users to filter
by username, location, dates of upload, and other metadata features. OSMCha is useful for monitoring
the progress of data cleaning and upload teams.

Skills and Technology Needed

• Computer with
• Internet connection
• OpenStreetMap Account
• Recommended: computer mouse

How to use OSMCha

1. Navigate to https://osmcha.mapbox.com in the Google Chrome or Mozilla Firefox internet browser.

2. To use OSMCha, you will need to sign in with your OpenStreetMap account and grant permission.
osmcha_signin

3. Once logged in, a left-hand panel will appear with changesets. Each changeset shows:

• OSM username
• Time of upload
• Changeset comment
• Changeset ID
• Flags (if any) - such as “Possible Import”
• Number of ways added (highlighted in green), ways modified (highighted in yellow), and ways
deleted (highlighted in red) osmcha_viewingchangesets

4. With OSMCha, you can create highly focused filters to monitor you and your team’s contribution
to OSM. Clicking on ‘Filters’ on the left-hand panel will open the Filters menu.

5. In this menu, unique filters can be applied such as OSM username, date range, locations. osm-
cha_filters

Practice creating a filter

1. Click ‘Filters’ on the left-hand panel.
2. Set filters for:

• Start Date: 01/01/19
• Your username
• A location
• One additional filter

3. Click apply.
4. Click on any of the changesets that appear on the left-hand panel. Do any changesets have flags

or warnings?
5. Click on ‘Filters’ again to modify and/or add more filters.
6. To Save a Filter for later use, click on ‘Filters’ on the left-hand panel. In the upper-right, click ‘Save’

to choose a name for this Filter.
7. The exact filter can now be accessed using the URL or in the ‘My Saved Filters’ option after clicking

on your username.
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Osmose

Osmose is a tool that monitors multiple quality control issues in OSM. These include issues with fea-
ture geometry (such as overlapping buildings/nodes, incomplete features, and duplications), and also
common tagging issues (such as missing, unsuitable or poorly formatted tags). More information about
Osmose can be found at the Osmose OSM Wiki Page.

Note: to properly use this tool and view errors, you will need to use the Google Chrome internet browser.
Firefox, Opera, Safari, and other browsers may not display the information correctly.

How to use Osmose

1. Navigate to http://osmose.openstreetmap.fr in the Google Chrome internet browser.
2. Use the zoom, pan, and search features on the map to navigate to your area of interest.
3. Use the left panel to toggle common issues on and off.
4. Identified issues will appear in the map as pins matching the icons from the issues panel. Click on

each pin to learn more about the object and associated issue(s).

osmose_monrovia

To fix issues identified in Osmose

1. Open JOSM on your computer.
2. In Osmose, locate the ‘Export’ button at the top of the page. Click ‘Export’, then ‘JOSM’.
3. Fix the issues identified then re-upload to OSM.

JOSM Validation Tool

JOSM ‘s built-in validation tool that checks for common errors and inconsistencies in OSM data relating
to both geometry and tagging.

How to use the JOSM Validation Tool

1. In JOSM, download data for your AOI.
2. Open the Validation Results tool. If the Validation Results tool is not activated, select ‘Windows’

from the top menu and select ‘Validation Results’.
3. In the Validation Results tool, click ‘Validation’.
4. Go through each warning/error produced. Note: some warnings can be disregarded, some can

be automatically fixed by clicking the ‘Fix’ button, and others will have to be manually fixed. For
more information on specific warnings and errors, read the Validator wiki.

5. Re-run the validation tool to confirm warnings/errors have been fixed.
6. Once all warnings/errors have been fixed, re-upload to OSM.

JOSMValidation

For further details on using the JOSM Validation Tool, review Section 3.5 Validation with JOSM

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Quality Assurance Tools
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6.0 Introduction to Data Export Tools

In this section, Project Managers will find resources on how to export OpenStreetMap data, including:

• An overview of data export tools, including presentation slides

• Step-by-step guides for exporting data with the HOT Export Tool and HDX

Data Export Tools allow users to download OSM data for use and analysis programs such as QGIS.
The following are Data Export Tools commonly used in the HOT workflow. For more information on how
to use these tools, follow the step-by-step guides in each of the following sections.

• 6.1 HOT Export Tool covers the HOT Export Tool which allows users to download OSM data by
specifying tags, area of interest, and file type.

• 6.2 Humanitarian Data Exchange (HDX) covers the Humanitarian Data Exchange (HDX) data
platform for storing and sharing humanitarian data managed by OCHA’s Centre for Humanitarian
Data.

• Information on QuickOSM, a QGIS Plug-in that allows users to directly download OSM data for
specific tags into QGIS, can be found in section 7.1 Introduction to QGIS.

The following presentation(s) can be used to lead a training or workshop:

• Data Export Tools
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6.1 HOT Export Tool

This section provides:

• An overview of the HOT Export Tool
• Step-by-step instructions on downloading data (such as shapefiles) from OpenStreetMap using
Export Tool

Overview

HOT Export Tool allows users to download OSM data by specifying tags, area of interest, and file type.
Learning resources and walkthroughs can be found at the HOT Export Tool Learn page.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Data Export Tools

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Using the HOT Export Tool

Tools and Technology Needed:

• Computer
• Internet Connection
• OSM Account

To get started, open an internet browser and go to: https://export.hotosm.org/ To use the HOT Export
Tool, you will need to log in using your OSM username and password, by clicking the red “Log In” button
in the top right-hand corner.

Select ‘Create’ in the top menu.

Select an AOI on the map by searching a place, uploading a .geojson, or drawing an area in the map
to the right. To draw an area of interest, zoom in and find a location of your choice (i.e. Zwedru, Accra).
Once you have zoomed in to your area of interest, select the box tool from the Tools Menu on the right.
Click one corner to start drawing a box, then select the opposite corner to complete the box. This is your
AREA OF INTEREST that will be downloaded.

On the left hand side of the window, fill out the “1 Describe” options:

• Name: “[YOUR OSM USERNAME] Test Export”
– For example, “jessbeutler Test Export”

• Description (optional)
• Project (optional)

– For example, “Government Inclusion Project”

Select preferred file type in the ‘Formats’ tab. If downloading data to use in a GIS program, try down-
loading a .shp file.

In the ‘Data’ tab, select the types of OSM data to export. Recommend types to try: ‘Education’, ‘Gov-
ernment’, ‘Healthcare’.

In the ‘Summary’ tab, select ‘Create Export’. While processing, a “Running” status will show. Processing
time depends on export size. Once completed, the file will be available for download & sent to your email.
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This process will take several minutes to process.

When the export process is completed, the ‘Status’ bar will be updated to ‘COMPLETED’. Download the
file by clicking on the file link, as highlighted below. For shapefiles, open the downloaded .zip folder and
save it to a folder of your choice on your computer. You can now use the shapefile in a GIS software
such as QGIS.
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6.2 Humanitarian Data Exchange

This section provides:

• An overview of the Humanitarian Data Exchange (HDX)
• Step-by-step instructions on downloading data (such as shapefiles) from OpenStreetMap using
HDX

Overview

Humanitarian Data Exchange (HDX) is a data platform for storing and sharing humanitarian data. The
platform is managed by OCHA’s Centre for Humanitarian Data. Types of data available on HDX include:
Data includes:

• Geospatial datasets
• CSVs & spreadsheets
• text & image files

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Data Export Tools

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Working with HDX

In this activity, you will practice using Humanitarian Data Exchange (HDX) for downloading OSM data
for use in QGIS. HDX is an online-based tool, so you will need to be patient with internet connectivity.

Tools and Technology Needed:

• Computer
• Internet Connection

Downloading data

Visit data.humdata.org. In the Find Data search bar, type your area of interest (i.e. Liberia, Tanzania),
and click search.

Browse list of available datasets. Select a dataset of interest and download the data file.

Adding data

Visit data.humdata.org. In the Add Data window, select ‘Upload File’. You will need to sign in or register
as an organization.

You will need to make sure data file meets HDX standards before uploading data file.
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7.0 Data Use and Analysis

In this section, Project Managers will find tools and resources on how to use OSM data to create map
products for decision-making including:

• A step-by-step guide for getting started with QGIS, including presentation slides
• A step-by-step guide for creating maps and atlases in QGIS
• Detailed guides and resources for using data in web and interactive maps

There are a handful of free Data Use and Analysis tools available to use your field generated data,
extract and utilize OSM data, or combine datasets to create maps, atlases, and other visuals for decision
making.

• 7.1 Introduction to QGIS provides an introduction to the open source geographic information sys-
tem (GIS) software that allows you to analyze and edit spatial information, as well as compose
and export geographic maps. Additionally, the section includes a step-by-step guide that project
managers can use in trainings for installing QGIS and learning basic skills.

• 7.2 Creating Maps and Atlases in QGIS covers more advance skills in QGIS, providing managers
with training materials to create maps and atlases in QGIS.

• 7.3 Web & Interactive Maps provides a basic guide to two interactive mapping tools, uMap and
Overpass Turbo Query.

The following presentation(s) can be used to lead a training or workshop:

• Introduction to QGIS
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7.1 Introduction to QGIS

This section covers the basic skills necessary to using QGIS. This includes step-by-step guides on:

• Installing QGIS
• Navigating QGIS
• Adding data
• Styling layers
• Installing Plugins, including QuickOSM and QuickMapServices

Overview

QGIS (or Quantum GIS) is a free and open source geographic information system (GIS) program. GIS
programs allow users to display, manage, and analyze geospatial information on the computer, and
create map products. Geospatial data that can be used in GIS includes aerial imagery, GPS data, and
spatial datasets. Following completion of this section, a new user should be prepared to navigate and
work with data in QGIS.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following presentation(s) can be used to lead a training or workshop.

• Introduction to QGIS

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

The following guide provides instructions and screenshots from QGIS 3.4. Versions before or after may
have different icons and steps.

Installing QGIS

QGIS is available for download for the following operating systems:

• Windows
• Mac OS
• Linux

Skills and Technology Needed

• Computer with
– Windows, Mac, or Linux operating system
– Sufficient free disk space (approx 10GB) and administrator rights to install software

• Recommended: computer mouse

For Windows Prior to installation, you need to determine whether or not your computer runs on a 32-bit
or 64-bit system.

1. Open the Start Menu, right-click on “Computer”, and select “Properties”.
2. Under “System”, the correct system type will be listed.

Installing from Shared File If you are offline, you will need to install QGIS from a shared file. The QGIS
Installer can be downloaded and shared via USB. This file can be shared with colleagues and others
who wish to install the program. To install from a shared file:

1. Go to folder shared to you and downloaded to your computer.
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2. Select the appropriate installer folder based on your operating system (Windows 32-bit; Windows
64-bit; or Mac).

3. Open the installer to begin the installation process.

Installing from QGIS Website If you have an internet connection, you can download directly from the
QGIS website. Additionally, it is highly recommended to download software directly from the QGIS
website whenever possible. This ensures that you have the most up-to-date version of the program.
The QGIS file is larger than 300MB and may take a long time to download, depending on your internet
connection.

To install:

1. Visit: http://www.qgis.org/en/site/forusers/download.html
2. Select your appropriate operating system (i.e. Windows, Mac, Linux).
3. For Windows - select your approprite system (32-bit or 64-bit).
4. Click on the QGIS Standalone Installer to begin the download process.
5. Once installed, open the installer to begin the installation process.

Considerations when installing QGIS for large numbers of individuals

• Consider internet connectivity and capacity prior to installing QGIS for large numbers of individuals
via internet. It is highly recommended that prior to the training/workshop, installation files are
downloaded and loaded onto USB drives for offline installation.

• When downloading offline installers for a large group, make sure to download an installer for all
operating systems. Note: it will be important to download the Windows installer for BOTH 32-bit
and 64-bit.

• The downlaod and installation process often takes longer than anticipated, especially when factor-
ing in technical skills and hardware compatibility. Therefore, it is recommended to begin download
and installation process early in the training or during breaks to ensure a smooth process and
adherance to agenda.

• Prior to the training/workshop, request attendees to make sure that they have enough space on
their computers (10GB+) for installation of QGIS.

Navigating QGIS

To open QGIS, open the QGIS folder on your desktop. In this folder, find QGIS Desktop. Double-click
to open this program

Taking a long time? Don’t panic! QGIS can take a few minutes to load.

Familiarize yourself with the various parts of the QGIS browser, hover your mouse over icons to view
names of various tools. Note: Your browser may have different tools than the image below.

1. Layers panel - This is where layers (i.e. imagery, building layers) will be listed. The order of layers
in the panel impacts the order of layers in the map - in other words, the layer at the top of the list
will appear as the top layer in the map.

2. Toolbars - Most of the tools you will regularly use in QGIS will appear as icons in the toolbars at
the top, such as save, zoom, pan. The number of toolbars depends on various features you have
activated or installed.

3. Map Canvas - When layers are added to the Layers Panel, they will appear in the map canvas.
4. Status Bar - Coordinates, scale, and projection will appear in the Status Bar.

Adding Data

Hover your mouse over the tools until you find the “Add Vector Layer” tool. Click on this icon to open
the Add Vector Data dialog.

Click the ‘…’ button under Source and navigate to the location on your computer where you have a
saved vector layer (i.e. .shp, .geojson) Select the file and ‘open’.

For more information on exporting data from OSM, see instructions on QuickOSM and Export Tools.
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Styling Layers

Data layers can be styled in three ways: opening the properties tab, copying from other layers in the
project, and importing a .qml style.

To manually select a style:

Right-click on the point layer and select ‘Properties’. (Alternate: Double-click on a layer in the Layers
Panel.)

Select ‘Style’ from the left-hand menu. There are many changes and styles that can be made in this
window. To complete a basic style change, select ‘Simple Fill’ near the top of the window. Now you can
change the Fill Color, Fill Style, Stroke (outline) Color, Stroke (outline) Width, Stroke (outline) Style and
more to your own choice.

Select ‘Ok’ to see your changes in the project.

You can also select from various preset styles in the main style window.

To copy styles from another data layer:

Right-click on any of the other layers. Select ‘Style’, then ‘Copy Style’, and ‘All Style Categories’.

Next, right-click on the layer you want to apply the style to. Select ‘Style’, then ‘Paste Style’, and ‘All
Style Categories’. Styles from point layer styles can only be copied and pasted to other point layers,
polygon layers styles can only be copied and pasted to other polygon layers, etc.

Styling a layer from an imported .qml file

A .qml file contains style information, including labels, exported from a layer. This file can be saved and
shared to ensure consistent use of particular styles, for example, if an organization uses a particular
color scheme and font for all maps.

Prior to importing a .qml file into QGIS, you will need to receive or download a .qml file. Practice .qml
files and .shp files can be found here.

1. Double-click on a layer in the Layers Panel or right-click on the point layer and select ‘Properties’.

2. Select ‘Style’ from the left-hand menu.

3. In the lower left hand corner of the Style window, select the ‘Style’ button. Click ‘load’ style.

4. Navigate to and select the .qml saved on your computer.

5. Click ‘Ok’. Your layer will assume all style choices saved to the .qml file.

Installing Plug-ins

Tools and skills required

• Internet connection
• Installed QGIS
• Navigating QGIS
• For QuickOSM: OSM Tagging and Data Models

Estimated time: <5 minutes, depending on internet connection

Plugins allow you to extend the functionality of QGIS. These plugins can range from allowing data to be
directly downloaded from OSM to QGIS to tools that assist with analysis.

In this exercise we shall install and use two plugins: QuickMapServices & QuickOSM

Note: Managing and installing plugins requires an internet connection. If the Plugin Manager is not
working, check your internet connection.

Considerations for working with large groups and/or in low-internet settings Plug-in Manager re-
quires a consistent internet connection to download plugins. It is highly recommended for training and
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workshop facilitators to pre-download offline versions for sharing. For instructions on how to download
an offline version of a plug-in for sharing, see section 1.8.1 Software and Tools to Share.

To install plugins, click on the menu item Plugins  Manage and Install Plugins.

QuickMapServices

QuickMapServices allows you to add free, online basemaps to your QGIS maps, including OSM
basemaps.

Note: asQuickMapServices provides online basemaps, use of these layers requires a consistent internet
connection.

In the Plugin Manager dialog box that opens, find the QuickMapServices plugin. To do so, click on the
search bar and type ‘QuickMapServices’, the plugin will appear in the list. Then click the Install Plugin
button.

Once installed, QuickMapServices can be accessed in the top menu Web  QuickMapServices

In the QuickMapServices sub-menu, several types of basemaps can be accessed including OSM.

For aerial imagery, in the QuickMapServices sub-menu, open ‘Settings’. Click the ‘More Services’ tab.
Select ‘Get Contributed Pack’.

Return to the QuickMapServices sub-menu. There will now be a long list of options for basemaps,
including Bing.

QuickOSM

QuickOSM allows you to select and download OpenStreetMap data for use in QGIS. QuickOSM works
by extracting specific data based on OSM based on tags (key=value pairs) and an area of interest.

Once installed, QuickOSM can be accessed in the top menu Vector  QuickOSM > QuickOSM

Note: When downloading data through QuickOSM, it is best to have a basemap layer focused on your
area of interest (seeQuickMapServices) and/or at least one shapefile/geojson layer in the area of interest.
This guides QuickOSM in downloading data for the correct area of interest.

To download data in QuickOSM in QGIS, you will need to build queries to download the exact data that
you need. QuickOSM makes building queries easier, but you will still need to know the tags (i.e. keys
and values) to generate data. It will become easier to remember these tags as you gain experience
working with OSM - in JOSM, QGIS, and other programs.

Below are some examples of common tags used in OSM queries.

Key Value

amenity school
place_of_worship
bar
bank

highway primary
residential
path

office government
ngo

shop clothes
tailor

In the pop-up QuickOSM window, at a minimum, you will need to fill in: key, value, and select the extent.
This

Tips:

• Key: For resources, on keys and values to use, see OSM Tagging and Data Models.

• Value: Multiple values can be strung together by separating with a comma (for example:
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amenity=school,hospital). To download all possible values of a key (i.e. amenity=*), leave the
value field blank.

• Extent: Selecting the extent chooses the area QuickOSM will search for and download data from.
There are multiple options you can select from when choosing the extent:

– In:
– Around:
– Canvas Extent:
– Layer Extent:
– Not Spatial:

Extent of the map canvas is best suited when you do not have a shapefile/geojson that covers your area
of interest (i.e. administrative boundaries) and/or a small area of interest. To base your extent on a layer,
use the drop down menu on the right to select the appropriate layer.

Once providing your key and value, and selecting your extent, click ‘Run Query’.

If your query is not working:

• Did you use capital letters in your keys and values? Make sure keys and values are in lowercase.
For example: key=amenity value=school NOT key=Amenity and value=SCHOOL

• Did you use the correct spelling in your keys and values? Make sure keys and values are spelled
EXACTLY as they are in OSM guides. Otherwise QuickOSM will be looking for the wrong tag. For
example: key=amenity NOT key=amenities

Note: To large of an area, or too much data to download, can overload the API or will be too much for a
slow internet connection. If you are having difficulty downloading data, try reducing the area or limit the
data download by changing your tags. For example, downloading all buildings in Africa, even some cities,
is too large for QuickOSM. Instead try downloading a smaller area or restricting to all building=school.

Additional Resources

• QGIS Training Manual: https://docs.qgis.org/2.18/en/docs/training_manual/
• QGIS Tutorials: https://www.qgistutorials.com/en/docs/learning_resources.html
• Further QGIS Install instructions: https://docs.qgis.org/testing/en/docs/user_manual/introduction/getting_started.html#installing-
qgis
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7.2 Creating Maps and Atlases in QGIS

This section covers the skills necessary to create maps and atlases in QGIS:

• Preparing map data
• Creating a Map Layout
• Atlas navigation and creation
• Creating map and atlas templates

Overview

Creating an atlas in QGIS allows users to create a series of maps for geographic regions with a set
template. This atlas template allows for a large number of maps to be generated for areas of interest,
such as districts, wards, and other administrative areas, with the same style and layout.

HOT Project Examples:

• Open Cities in Monrovia, Liberia
• LEGIT in Liberia
• Ramani Huria in Dar es Salaam, Tanzania (Dar es Salaam, Tanzania)

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

The following guide provides instructions and screenshots from QGIS 3.4. Versions before or after may
have different icons and steps.

Skills and technology needed:

• Installation of QGIS
• Navigating QGIS and adding data
• GIS data files (i.e. shapefiles, geojson)

– Example shapefiles zip

This activity covers the process of generating and configuring a map and atlas in print layout. Example
shapefiles are provided for this activity but can be followed with shapefiles provided by the user.

1. Preparing map data

Before creating an atlas, you will need to add and style layers. While styling layers, you will need to
consider how the layers will look in print composer. As maps in the atlas may be at varying scales, it
may be necessary to return to styling after generating the atlas to make adjustments.

To follow along with the practice steps, add the following vector data to your map: * Dar_sub-
wards_EPSG_4326 * Dar_wards_EPSG_4326

Change the background color of the project. Open the ‘Project’ menu from the top toolbar, select ‘Prop-
erties’. Under general settings, change the background color to blue.

Style the ward layer (Dar_wards_EPSG_4326) by right-clicking on the name in the Layers Panel and
selecting ‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described below:
* Select ‘Simple Fill’ from the upper left window. * Change ‘Symbol layer type’ to ‘Outline: Simple Line’
* Change the color to purple. * Change the ‘Pen style’ to ‘Dash Dot Line’ * Select ‘Apply’ and then ‘OK’.
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Duplicate the ward layer (Dar_wards_EPSG_4326) by right-clicking on the name in the Layers Panel
and selecting ‘Duplicate’. Right-click on the copy layer and select rename. Rename this layer as
‘Ward_grey_background’.

Style the ‘Ward_grey_background’ layer by right-clicking on the name in the Layers Panel and selecting
‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described below:

• Select ‘Simple Fill’ from the upper left window.
• Change ‘Symbol layer type’ to ‘Simple fill’
• Change the color to the html code #edeae2 (or select a light grey color).
• Change the ‘Outline style’ to ‘No pen’.
• Select ‘Apply’ and then ‘OK’.

Style the sub-ward layer (Dar_sub-wards_EPSG_4326) by right-clicking on the name in the Layers Panel
and selecting ‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described
below:

• Select ‘Simple Fill’ from the upper left window.
• Change ‘Symbol layer type’ to ‘Outline: Simple Line’
• Change the color to yellow.
• Change the ‘Pen style’ to ‘Dot’.
• Select ‘Apply’ and then ‘OK’.

After styling the sub-ward layer (Dar_sub-wards_EPSG_4326), select ‘Labels’ from the side menu in
‘Properties’.

• In the top drop down menu, change the option from ‘No Labels’ to ‘Show labels for this layers’.
• For ‘Label with’, select the option ‘Ward_Name’ from the drop-down menu.
• Change your ‘Text’ options such as font, font size, font color, etc.
• Select ‘Apply’ and then ‘OK’.

After styling all layers, ensure that your layers are in the following order in your layers panel. (To adjust
layer ordering, left-click and hold on a layer and then drag up or down in the list.)

• Dar_wards_EPSG_4326
• Dar_sub-wards_EPSG_4326
• Ward_grey_background

2. Creating a Map Layout in Print Layout

Open the ‘Project’ menu from the main toolbar, and select ‘New Print Layout’. In the pop-up window,
create a title for your map. This can be a unique name to describe your map’s purpose such as “Dar
Sub-Wards”. A new window will be created with a blank page. This shows how your map will look printed
out.

At minimum, you will need to add the following common elements of a map to the map canvas:

• Map
• Title
• Legend
• Scale Bar
• North arrow

Each of these elements can be added by opening the ‘Add Item’ menu on the top toolbar or by using
the quick access buttons on the left-hand toolbar.

Add your map by selecting ‘Add Map’ from the ‘Add Item’ menu (alt: use the Add Map tool from the
left-hand toolbar). You will need to draw the box by clicking and dragging the corners.

Add a title to your map by selecting ‘Add Label’ from the ‘Add Item’ menu (alt: use the Add Label tool
from the left-hand toolbar). Like the map, you will need to draw the box by clicking and dragging the
corners. The default text is ‘Lorem ipsum’. This can be changed in the ‘Item Properties’ panel. Change
the font and size of your title.
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Add a legend to your map by selecting ‘Add Legend’ from the ‘Add Item’ menu. The size of the Legend
will be generated based on its contents. You can change the size as well as add or remove legend items
in the ‘Item Properties’ panel.

Add a scale bar to your map by selecting ‘Add Scalebar’ from the ‘Add Item’ menu. Like the map, you
will need to draw the box by clicking and dragging the corners.

North arrow can be added by selecting ‘Add Image’. Like the map, you will need to draw the box by
clicking and dragging the corners. In the ‘Item Properties’ panel, open the ‘Search Directories’ option to
select from a choice of symbols.

Move these items around your Map Canvas until you are pleased with the layout of your map. Think of
your audience: will they understand the information you want to convey?

3. Saving Maps

At this stage, you can decide if you want to save the map as a single map or move on to generate an
atlas. If you would like to save the current map as a stand-alone map, open the ‘Layout’ Menu and select
one of the ‘Export as…’ options depending on your file preference.

4. Atlas Generation

After completing the layout for your map, you are ready to generate the atlas. Select the map box and
in the ‘Item Properties’ panel, check the box for ‘Controlled by Atlas’.

In the right-hand panel, select the tab for ‘Atlas generation’, near the ‘Composition’ and ‘Item properties’
tabs. If this tab is not appearing, select the ‘Atlas’ menu from the top toolbar, then select ‘Atlas Settings’.

In the ‘Atlas’ panel, check the box next to ‘Generate an atlas’ to begin configuring your atlas.

5. Configuration

The configuration options in the atlas generation panel controls how the atlas is generated.

1. The ‘Coverage layer’ is the layer that contains the geographic areas of interest for your atlas. For
example, for an atlas showing maps of each district you will need to select your district layer.

2. ‘Page name’ allows you to name pages by either selecting an attribute from the coverage layer or
building an expression from attribute table values.

3. If you do not want to show all areas included in your coverage layer, ‘Filter with’ allows you to filter
out geographic areas that you do or do not want to include in your atlas. This option requires an
expression to be built.

4. ‘Sort by’ allows you to order your atlas by an attribute of your coverage layer.

Practice

• Select ‘Dar_sub-wards_EPSG_4326’ as the coverage layer.
• For page name, select ‘Vil_Mtaa_N’. (This field is the sub-ward name.)
• Check the box for ‘Sort by’ and select ‘Vil_Mtaa_N’. (This field is the sub-ward name.)

6. Atlas Toolbar and Navigation

Once the atlas is generated, you will be able to preview and navigate through the atlas with the atlas
toolbar. To navigate, first select the ‘Preview atlas’ button. Changes can be made to the atlas layout
while in preview mode.
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7. Building expressions for data-driven text

Expressions allow for text such as labels and titles to be data-driven, or generated from attributes. When
working with an atlas, expressions take attributes from the coverage layer.

1. Text that is not data driven should be written within single quote marks. Example: ‘Map’
2. Spaces between words should be indicated with a space within single quote marks. Example:
‘Map of’

3. Selected values and plain text need to be separated by the operator ‘||’. This operator can be typed
or selected from the ‘Operators’ list. Example: ‘Map of’ ||

4. Data-driven text, or text that is generated from attributes, can be selected from the ‘Fields and
Values’ list. Example: ‘Map of’ || “Ward_Name”

5. An ‘Output preview’ will generate at the bottom of the expression builder window.

Practice

• Select or create your title box and select “Insert expression” in the ‘Item Properties’ panel.

• Use the ‘Fields and Values’ list to generate the following expression:

“Vil_Mtaa_N” || ‘,’ || “Ward_Name”

• Check the output preview to make sure the expression was typed correctly.

7. Inverse polygon layer

Adding an inverse polygon layer can focus the map by shading out or completely covering features
outside your area of interest.

1. Return to the main QGIS window.
2. Select the layer used as the coverage layer in the Print Composer. Right-click and select ‘Duplicate’
3. Right-click on the layer copy and select rename. Rename the layer.
4. Right-click on the layer and open properties. Select ‘Style’ from the side menu.
5. In the top drop-down menu, select ‘Inverted polygons’.
6. Under ‘Sub renderer:’, select ‘Rule-based’ from the drop down menu.
7. In the rules list window, double click on ‘(no filter)’ to open the ‘Edit rule’ window.
8. In the ‘Edit rule’ window, select the ‘…’ button to create a filter. An expression builder will open. In

the expression window, type or build from the Variable list: $id=@atlas_featureid
9. In the ‘Edit rule’ window, make sure that the symbol type is Simple Fill.
10. Change the transparency to 50%.
11. Change the color to dark grey.
12. Click ‘Ok’ to exit all option windows.

Practice:

• Complete all steps above.
• For step 2, this will be the “Dar_sub-wards_EPSG_4326” layer.
• For step 3, rename the file “inverse_sub-wards”.

8. Adding overview maps

Overview maps allow the audience to understand the map’s focal location within the context of a larger
area. For example, an overview map may show a ward’s location within the city. In QGIS, an overview
map can be created that will automatically show the map location for each atlas page.

1. In the main QGIS window, select the layers you would like to have in the overview map. These
should typically be layers that can be viewed easily on a small scale (i.e. boundaries, highways,
waterways). Multiple layers can be selected at a time by holding Ctrl on your keyboard while
selecting.

2. Right-click on these layers and select ‘Duplicate’.
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3. Select all of the copied layers. Right-click and select ‘Group Selected’. This allows for better data
management and makes it easier to turn groups of layers on and off depending on the map needs.

4. Right-click on this group and rename it ‘Overview Map’
5. Turn on all grouped layers and turn off all others by clicking the check boxes next to the layer

names.
6. Return to your Print Composer.
7. Open the ‘Layout’ menu from the top toolbar and select ‘Add map’. Draw a small box for your

overview map.
8. Go to the ‘Item Properties’ panel for the second map and open the ‘Overviews’ options.
9. Click the green ‘+’ button to add an overview.
10. For ‘Map frame’, select ‘Map 0’ from the drop down menu.
11. ‘Frame style’ will allow you to change the color, outline, and transparency of the map frame.
12. In the ‘Items Properties’ panel, open the ‘Layers’ option and select ‘Lock layers’. This will keep the

limited layers while allowing for the main map to show all layers.
13. Return to the Main QGIS window. Turn off all grouped overview layers and turn on the other layers.

Practice

• Follow all steps above.
• For Step 1, select the layers ‘Dar_wards_EPSG_4326 copy’, ‘Dar_sub-wards_EPSG_ 4326 copy’,
and ‘Ward_grey_background copy’.’

9. Atlas Review

After completing the layout and atlas generation, it is important to check each page of the atlas for correct
expression generation (i.e. all pages are correctly titled) and that the appearance of layers and labels in
each map appear correctly. If there is a large difference between map scales for different pages, styles,
labels, grids, and other factors may need to be adjusted to best suit all map scales.

Practice:

• Use the ‘Atlas toolbar’ to navigate through your atlas pages.
• For each page, check:

– Map layer visibility
– Label visibility
– Expression-driven text (i.e. title, additional text boxes)
– Scalebar size and placement

10. Output filename expression

Prior to exporting the atlas, an output filename expression needs to be built. This expression will deter-
mine the name for each page of the exported atlas files. See ‘Building expressions’ for instructions on
building expressions.

The default expression is ‘output_’||@atlas_featurenumber which will produce a filename such as “Out-
put 3”. This can be changed to create a more accurate filename for your maps.

Practice:

• Select the expression builder button
• Build the expression: “District_N” || ‘’ || “Ward_Name” || ’’ || “Vil_Mtaa_N”
• Check the output preview at the bottom of the expression builder to make sure that the expression
has been built correctly.

11. Exporting Atlas

To export the atlas, select the ‘Export Atlas’ button in the Atlas tool bar. Select the appropriate file
type (Export as Images, Export as SVG, or Export as PDF) and select the folder where the files will be
exported to.
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12. Atlas Templates

Atlas templates can be saved and added to other QGIS projects. To save a template, open the ‘Project’
menu from the top toolbar and select ‘Save as Template’. This will save as a Composer Template (.qpt
.QPT) file.

To add the template to another project, open a new print composer. Open the ‘Project’ menu from the
top toolbar and select ‘Add items from Template’. Note: items will be sized to the original document
page size. Item sizes may need to be adjusted if the new project is using a different page size.
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7.3 Web & Interactive Maps

This section provides:

• An overview of online interactive map tools for visualizing data
• Step-by-step instructions for creating interactive maps with two tools: uMap and Overpass Turbo

Overview

Interactive maps are viewed as the modern equivalent of visual communication with maps. This in-
volves the creation and study of the visual representation of data (maps). To communicate information
clearly and efficiently, data visualization uses statistical graphics, plots, information graphics and other
tools. The use of interactive maps gives users an opportunity to change the display of the map to one’s
preferences freely.

Resources and Training Materials

This section features a selection of resources targeted at project managers, trainers, or even self-
learners on the topic(s) outlined above.

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

This section covers two tools for creating interactive maps using OSM data: uMap andOverpass Turbo.
uMap lets you create maps with OSM layers quickly. The platform features sample maps to inspire your
use of layers, points of interest, design and licensing. Overpass Turbo Query is a web-based data
filtering tool for OSM. You can run queries and analyse the resulting OSM data interactively on a map.
There is an integrated Wizard that makes creating queries easy.

Overpass Turbo

Overpass Turbo Query is a web-based data mining tool for OpenStreetMap. It runs any kind of Overpass
API query and shows the results on an interactive map.

Skills and Technology Needed

• Computer with
• Internet connection
• Recommended: computer mouse

Skill level required Beginner/Intermediate

How to use Overpass Turbo

1. In your web browser enter https://overpass-turbo.eu/ to load Overpass Turbo
2. Click Wizard on the Top Bar to create a data query

3. Create a query. For example, type highway=* (This query searches for all highways in the area of
interest) in the search box and click ‘Build Query’.

4. In the search box on your right (Map Canvas) type the area of interest (such as Kampala, Uganda)
after which, zoom in to the area.

5. On the top bar, click Run to get the data. (After data points load on the map canvas)

6. Click on Export in the top bar. Under the Map section download as an interactive map and share.
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uMap

uMap lets you create amapwith OpenStreetMap layers and embed it in your site. All within a fewminutes.
You can create custom maps (see the examples below). It is powered by open-source, WTFPL-licensed
software.

Skills and Technology Needed

• Computer with
• Internet connection
• Recommended: computer mouse

Skill level required Beginner/Intermediate

How to use uMap

1. In your web browser enter http://umap.openstreetmap.fr/en/
2. On your top bar click login/signup and choose the third party (OpenStreetMap - Icon) application

to use.
3. Using OpenStreetMap account grant access to Umap and you will be redirected back to the uMap

interface.
4. On your top right corner, click create map tab

5. On the top bar, Click Editing, Untitled Map to provide title map, map description and configure
interactive and symbology settings of the map.

6. Click SAVE after every action to prevent losing changes made.
7. Click Import Data Icon on the editing tools (right bar) to add data to the map. Navigate to where

your data is stored and import it.

8. Click Manage Data Icon on the editing tools (right bar), then click the edit (pencil) button to edit the
visual properties of the data such as color and icon style.

9. Click Save on the top bar to have changes made saved.
10. Refresh the page and on the left panel, click the sharing icon to copy the link that can be shared

for the interactive map generated or embed the map in a custom website.

Linking uMap and Overpass Turbo

Linking uMap and Overpass Turbo makes your interactive uMap update as OpenStreetMap data is being
updated.

Skills and Technology Needed

• Computer with
• Internet connection
• Recommended: computer mouse

How to link uMap and Overpass Turbo

1. After creating a query in overpass-turbo.eu, click Export, Query, and then compact.

2. Copy the query link as text and paste into a text editor (e.g. notepad). If you use the “copy link”
feature of your browser you may first have to decode the URL by pasting in here and clicking
Decode before copying to output to a text editor.

3. Next, we need to take this text and generalise it to work on any map area:
4. Add http://overpass-api.de/api/interpreter?data= before the copied text.
5. Replace the hard-coded latitude and longitude coordinates with ({south},{west},{north},{east}).
This will need to be done three times; after node[x], way[x], and relation[x].

6. The final result should look like: http://overpass-api.de/api/interpreter?data=[out:json][timeout:25];(node[“source”=”HOT-UG”]({south},{west},{north},{east});way[“source”=”HOT-UG”]({south},{west},{north},{east});relation[“source”=”HOT-UG”]({south},{west},{north},{east}););out
body;>;out skel qt;

7. Now navigate to umap.openstreetmap.fr.
8. Click Create a map and pan/zoom in to the area of interest.
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9. Click the layers button and then click Edit (the pencil symbol).
10. In the right-hand pane click Remote data and paste the URL we constructed in step 6 into the Url

box.

11. Select “osm” from the drop-down Format list.
12. Tick the dynamic checkbox.
13. Optional: If you have a lot of data you may want to limit the display to certain zoom levels (so as

to not put too much strain on the Overpass servers). You can do this by entering a min zoom level
in the From Zoom box. Here I have entered 13 as my minimal zoom level.

14. Customise using the options on the right. Here I’ve changed the map background to OSM
monochrome and changed the colour of the overlay data.

15. Click More on the left-hand side, followed by Embed and share this map.
16. Copy and paste the embeddable iframe (You may need to click Current view instead of default

map view in the iframe options box.
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8.0 Introduction to Mapping Workflows

In this section, Project Managers will find example workflows from HOT projects on how the processes,
tools, and workflows contained in previous sections of this Toolbox have been applied to real field
projects. Project Managers can use these example workflows to identify a project similar in scope or
goal to their own and identify which tools and processes may be needed for their own project. Each
workflow example contains:

• An overview of the project

• A step-by-step guide of phases, steps, and tools used
• Links to various parts of the Toolbox to learn how the step was completed

There are many ways to complete a mapping project. HOT has provided overviews of how we’ve com-
pleted projects with the following workflows:

• 8.1 Buildings and POI with OMK showcases the tools and processes used in a long-term field
mapping project to map buildings and points of interest using OpenMapKit with government and
local partners.

• 8.2 POI with ODK + KoboToolbox Server showcases the tools and processes used in a simple
field mapping project used by a local NGO to integrate into existing programs using OpenDataKit
and KoboToolBox Server.
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8.1 Mapping Buildings and POI with OMK

The following workflow showcases the tools and processes used in a long-term field mapping project to
map buildings and points of interest using OpenMapKit with government and local partners.

Project Overview

Open Cities Africa - Accra

The Open Cities Africa Accra project sought to make Alogboshie and its environs resilient to natural
disasters, especially flooding. The project involved the remote mapping of Alogboshie, Akweteyman and
Alajo. These are areas of focus in a larger resilience project, Greater Accra Resilience and Integrated
Development (GARID), and are all located along the Odaw River which is prone to floods. Alogboshie
is a community that is plagued by perennial flooding affecting its residents and those in neighboring
communities. The area is usually flooded in the months of June and July during the peak times of the
rainy season. The effect of the flood on human life in the community is huge. Often after floods, some
community residents are displaced.

The Open Cities Accra team - led by Humanitarian OpenStreetMap Team (HOT), Mobile Web Ghana
and OpenStreetMap Ghana (OSM Ghana).

Project page: OPEN CITIES AFRICA - ACCRA CITY PROJECT - GHANA

Dates: June 2018 - February 2019

Status: Complete

Tools used:

• Field and Remote Data collection: OpenDataKit (ODK) Collect, OpenMapKit, JOSM, TileMill,
Mapillary

• Data Field Monitoring: OSMand and Maps.me
• Data Cleaning: JOSM
• Data Extraction and Visualization: HOT Export tool and QGIS

Field Mapping Workflow

1. Designing the project At the beginning of the project, HOT, Mobile Web Ghana, and OSM Ghana
met with local stakeholders and community members to assess mapping needs. With this information,
we were able to develop a data model that would be useful to local stakeholders but feasible to capture
with project constraints.

Steps used in this phase:

• Designing the Data Model

2. Remote Mapping Due to the density of the building in this project area of interest, and the lack of
high resolution, up-to-date satellite imagery, UAVs/Drones were flown to capture high resolution imagery
which was used in remote mapping. Following the drone imagery capture, imagery was loaded into
JOSM to be used by remote mappers.

Steps used in this phase:

• Remote digitization using HOT Tasking Manager
• Remote digitization using JOSM
• Validating with JOSM
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3. Field Mapping Technical Set-up The main data collection tool for this project was OpenMapKit.
This required technical set-up for OpenMapKit including: creation of ODK and OMK forms, creation of
mbtiles, creation of .osm layers. Once these files were created, all files were loaded onto devices and
an OpenMapKit server was set up by HOT.

Steps used in this phase:

• Creation of ODK & OMK Forms
• ODK set-up
• OMK set-up

– Creation of mbtiles using TileMill. (While this Toolbox does not include the TileMill process,
the same mbtiles can be created using the QGIS process).

– Creation of .osm layers used JOSM
• Set up devices for ODK and OMK
• Set up a POSM or online OMK Server for use in downloading forms and receiving field data
• Use of OMK Server and POSM

4. Field Mapping Management Field mappers grouped into teams with leaders. Each mapper used
OMK (full survey) and OSMAnd (tracking field movement) on a daily basis. At the end of each day, all
data was uploaded remotely to an online OpenMapKit Server, as well as manually to a POSM device
for back-up.

Steps used in this phase:

• Creation of mapping sections in QGIS
• Creation of mapping sections for use in OSMAnd

5. Data Cleaning Download data from the OpenMapKit server then manually divided into small sec-
tions that could be cleaned in a few hours by local data cleaners. Data was cleaned in JOSM, then
uploaded into OSM.

Steps used in this phase:

• Data Cleaning with JOSM
• Validating with JOSM

6. Data Visualization All mapped data was uploaded to OSM, and was later used to develop map
products to be used by stakeholders. This data was downloaded into QGIS using QuickOSM, then large
wall maps and atlases were developed to be provided back to stakeholders and community members.

Steps used in this phase:

• Downloading data with QuickOSM
• Creating Maps and Atlases in QGIS
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8.2 Mapping POI with ODK + KoboToolbox Server

The following workflow showcases the tools and processes used in a simple field mapping project during
which HOT trained local NGOs to integrate mapping into existing programs using OpenDataKit and
KoboToolBox Server.

Project Overview

Bridging Gaps in Development and Emergency for the Refugee Crisis in East Africa

East Africa (and Uganda specifically) continues to be the center of one of the world’s largest and fastest
growing refugee crises. Uganda’s progressive open-door policy alone has led to an influx of approxi-
mately 1.4 million refugees into the country. High mobility of refugees means distribution and size of
refugee settlements changes constantly and the need for standardized accessible information to make
timely informed decisions about where services need to be planned and built becomes more crucial than
ever. Through the use of open-source technical tools combined with a community-based methodology,
HOT has been able to address the critical data gap in these contexts by increasing real-time compre-
hensive data production on infrastructure and services where refugees and host communities reside. To
ensure that government and organizations involved in the refugee response know that, first, this data
exists and, second, how to effectively use it, HOT has worked extensively to support and train actors on
how to systematically incorporate citizen-generated data into their programs to address and fill existing
gaps.

Project page: BRIDGING DATA GAPS: MAPPING REFUGEE CONTEXTS IN EAST AFRICA

Dates: June 2018 - May 2019

Status: Complete

Tools used:

• Field and Remote Data collection: OpenDataKit (ODK) Collect, Kobo server, HOT Tasking Man-
ager (ID Editor, JOSM)

• Data Field Monitoring: OSMand and Maps.me
• Data Cleaning: OpenRefine, Excel, JOSM, Python scripts
• Data Extraction and Visualization: HOT Export tool, OSM Analytics, QGIS, Overpass Turbo,
Umap, HDX

Field Mapping Workflow

1. Identifying Partners’ Need and Area of Interest/Operation Through regular interactions and
planned meetings with various stakeholders & partners - including UNHCR, OPM, LWF, etc. - the
Project Manager and/or Country Manager would work to understand the technical gaps and needs that
institutions were facing in strengthening their contributions to the national refugee response. From this
point, we would identify data gaps and the institutional skills needed to fill these areas and co-devise an
implementation plan to train the group/organization over multiple days to achieve the intended results
and outcomes.

Steps used in this phase:

• Defining Needs and Requirements

2. Trainings and Capacity-building Exercises After the extensive consultation process, trainings
would be planned and conducted in house or at a partners’ premise. The main objective of these train-
ings would be to introduce - and attempt to instil - GIS tools and support capacity building with refugee
response partners through custom lessons over a short number of days. These training materials were
all specifically designed for each partner organization to ensure the resources matched their level of
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skill/understanding and enable them to adequately improve their practical knowledge. Trainings gener-
ally lasted between 2-5 days and covered topics including data collection, storage, extraction, analysis
and visualization.

Steps used in this phase:

• Trainings and Workshops

Trainings provided to partners included:

• Introduction to OSM
• Mapping with JOSM
• Mapping with ID editor
• Mobile Data Collection Tools
• Introduction to QGIS
• Downloading data from OSM (Hot Export Tool and Quick OSM)

3. Data collection Data collection activities were consultative and participatory in nature, where data
collectors were chosen from the local communities that we were interested in generating data to sup-
port the refugee response. Data collectors used their personal smartphones and those who didn’t have
proper functioning smartphones were equipped with one by HOT. OpenDatakit was the main data col-
lection tool/application used and 6 unique forms - incl. Health, Education, Water, Sanitation - would be
implemented by surveyors and used for mapping in every village visited both in and around the refugee
settlements.

Steps used in this phase:

• Choosing a Data Collection Application: OpenDataKit (ODK)
• Setting up OpenDataKit
• Using ODK Collect

4. Data Storage and Monitoring The data from the field was stored on the online UNHCR kobo server
space. This allowed for different UNHCR and OPM implementing partners to access the data easily and
effectively. The data was uploaded by the field data collector at the end of each working day. Uploading
ODK requires as low as a 2G connection to send the files to the server. The surveyors were always
provided with at least 50 MB of data to accomplish such tasks. The Kobo server was also used as a
monitoring tool to determine the number of data points collected and quickly assess any data quality
gaps in the field.

Steps used in this phase:

• Data Collection Servers

5. Data Cleaning and Analysis After storing the data on Kobo, the data would be downloaded then
cleaned and uploaded using JOSM.

Steps used in this phase:

• Data Cleaning with JOSM

6. Data Visualization For this project, HOT used a number of methods to visualize data; from using
QGIS to create static maps and atlases to using tools such as Overpass turbo, Umap andMapbox Studio
to create dynamic & informative map products. The types of visualizations were mainly developed in-
cluded distance matrices, resource gap identifiers, location and navigation maps and proximity indicator
maps.

Steps used in this phase:

• Downloading data with HOT Export Tool
• Creating Maps and Atlases in QGIS
• Web & Interactive Maps
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Data Use and Analysis

There are a handful of free tools available to extract and utilize OSM data for decision-making. By either
using OSM data in conjunction with free population data sets from, for example, World Pop or other
thematic datasets from the Humanitarian Data Exchange or even combining it with your own generated
data, various tools can be used to clean, analyze and visualize information to inform project planning
and decision-making.

This section covers:

1. QGIS - a cross-platform desktop geographic information system (GIS) software that allows you to
analyze and edit spatial information, as well as compose and export geographic maps.

Level: Advanced

qgis.org

2. uMap lets you create maps with OSM layers quickly. The platform features sample maps to inspire
your use of layers, points of interest, design and licensing.

Level: Beginner

umap.openstreetmap.fr

3. Overpass TurboQuery is a web-based data filtering tool for OSM. You can run queries and analyse
the resulting OSM data interactively on a map. There is an integrated Wizard that makes creating
queries easy.

Level: Beginner/Intermediate

overpass-turbo.eu

Additional tools not detailed in this section:

1. MyHeatMap allows you to view your geographic data interactively. Combining geospatial data with
a colour-coded gradient makes it easier for your audience to quickly interpret your information.

Level: Beginner/Intermediate

openheatmap.com

2. Data Wrapper allows you to quickly create beautiful and responsive charts - in seconds. It is a
three step process: copy/paste your data, visualize your data by choosing from many charts and
map types and then publish your final creation into your format of choice.

Level: Intermediate

datawrapper.de
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Data Cleaning, Upload, and Quality Assurance

Data Cleaning, Upload, and Quality Assurance is a critical step in any mapping workflow. This process
covers cleaning raw field data for errors and mistakes, uploading clean data to OpenStreetMap, and
using various quality control tools to monitor data that has been uploaded. Regardless of how (and
if) you are collecting field data, any project that results edits in OpenStreetMap should have a quality
assurance and control plan.

• 6.1 Management of Collected Data covers the best practices and recommend workflows for man-
aging data that is collected in the field.

• 6.2 Data Cleaning and Validation Workflows provides examples of technical workflows used by
HOT in the field for various types of projects.

• 6.3 Data Cleaning in JOSM covers the process and steps required to clean field data and the
uploading process using JOSM.

• 6.4 Quality Assurance Tools provides a guide to tools HOT uses for monitoring and checking data
quality of data uploaded to OpenStreetMap.

If your project… * Involves field data collection using OpenMapKit and/or OpenDataKit, start with section
6.1. * Does not involve field data collection using OpenMapKit and/or OpenDataKit, jump ahead to
section 6.4.
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Digitization and Editing in OSM

Digitization, or remote mapping, is the process of tracing features such as buildings and roads from
aerial or satellite imagery to create map data. OpenStreetMap relies heavily on users generating data
through digitization.

With OpenStreetmap at the core of our tools and workflows, mapping projects using HOT tools and
workflows will likely incorporate digitization or editing of OSM data during one, in not multiple phases in
the project timeline. While numerous resources exist to teach new users how to use OpenStreetMap for
the first time, this section is largely designed to guide project managers and community members through
the digitization process from the perspective of leading trainings and managing teams conducting OSM
editing. Users looking for guidance on individuals mapping in OSM should look to LearnOSM.org as a
resource.

• 3.1 Introduction to OSM contains a brief overview of OpenStreetMap with the purpose of being
distributed as supplemental training guides.

• 3.2 Organized Editing Guidelines covers considerations project managers and communities
should make when organizing focused digitization or editing campaigns.

• 3.3Workingwith the HOT TaskingManager provides an overview of HOT’s tool for crowdsourcing
OpenStreetMap edits, as well as a guide for setting up tasks in the Tasking Manager.

• 3.4 Editing with iD and JOSM Editor provides guidance on selecting the appropriate OSM editing
tool for your project or event, and training materials using both tools.

• 3.5 Validating with JOSM dives into the validation process step-by-step.
• 3.6 Resolving conflicts in JOSM provides additional assistance for teams conducting advanced
OSM editing.

HOT presentations included in this section for use by communities and projects:

• Introduction to OSM
• Introduction to HOT Tasking Manager
• Mapping with iD Editor
• Mapping with JOSM
• Validating with JOSM

113

https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.1_introduction_to_openstreetmap/
https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.2_organized_osm_editing/
https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.3-working-with-the-hot-tasking-manager/
https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.4-editing-with-id-and-josm/
https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.5_validating_with_josm/
https://hotosm.github.io/toolbox/pages/digitization-and-editing/3.6-data-conflict-in-josm/


Designing and Coordinating a Mapping Project

There is no one way to collect data in the field and it will vary by context. However, there are some essen-
tial topics and questions all project managers and OSM communities should consider when Designing
and Coordinating a Mapping Project.

• 2.1 Defining Needs and Requirements poses questions to answer when defining the scope of
the project, such as purpose, geographic scale, and what features to map, as well as ensuring that
the project takes into account the various contexts and stakeholders involved in the project.

• 2.2 Safety, Security, and Logistics for Field Operations contains guiding questions to help plan
for project logistics and security concerns. As all field operations involve some level of risk and
can involve many moving parts, it is vital to conduct a safety, security, and logistics review before
beginning field work on any project, regardless of experience.

These first two sections provide guiding questions and considerations, however, it is important to under-
stand that each project will have different variables that might not be covered. When designing a project,
be sure to use past experience, consult with other organizations, and meet with stakeholders to ensure
that you are covering all variables.

• 2.3 Selecting Hardware provides a guide on the various hardware, such as phones and laptops,
that could be needed for a project. Additionally, HOT has provided lists of specific models that
have been used in HOT field projects that have proven suitability.

• 2.4 Trainings and Workshops covers the requirements for running trainings as well as providing
resources such as example agendas and materials to provide.

Further resources and reading

In addition to this Toolbox, there exists several guides that were developed to help teams in the project
planning process, some of which were borrowed from to develop this Toolbox.

• Open Maping for the SDGs - Humanitarian OpenStreetMap Team (HOT) published a guide for
launching and growing open mapping initiatives at the national and local levels to achieve the Sus-
tainable Development Goals (SDGs). This guide can be found at: https://hotosm.github.io/gpsdd-
documentation/

• Open Cities Project Guide - the World Bank Global Facility for Disaster Reduction and Recovery
(GFDRR) and Humanitarian OpenStreetMap Team (HOT) published a guide that can be down-
loaded at http://www.opencitiesproject.org/guide/.

• Participatory Mapping Toolkit - Humanitarian OpenStreetMap Team (HOT) published a guide
for open mapping projects in the context of refugees. The full toolkit can be downloaded at
https://www.hotosm.org/downloads/Toolkit-for-Participatory-Mapping.pdf
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How to use the HOT Toolbox

The HOT Toolbox is designed to take a project manager or community through the entire mapping
workflow, from planning, through initial mapping, data use and analysis. Not every mapping project is
the same. Some projects involve extensive field data collection components, others might not even
conduct field mapping activities but run desktop-based digitization projects instead.

The Toolbox has seven sections (overview below) that can be used in the order presented, or combined
to suit your individual project training needs.

If you do not want to go through each section, use the left-hand navigation, or the search bar to look for
a particular guide.

If you are not sure where to begin a project use the Mapping Project Workflows section to find an
example workflow that best suits your project’s goals and resources. Each example will guide you
through the exact steps, while linking to the relevant sections in the Toolbox and highlighting the tools
and processes used.

Overview of the Toolbox Sections

1. Designing and Coordinating a Mapping Project provides readers with an introduction to the
components that project managers should consider and take into account before beginning their
mapping projects.

2. Digitization and Editing in OSM provides project managers with training materials and guides on
managing the digitization process and which remote mapping tools are best for a project.

3. Field Mapping Technical Set-up provides project managers with the technical steps for selecting
which mobile data collection application is best for their project, setting up those applications (such
as ODK and OMK) for use in the field, and whether or not data collection servers are necessary
for their project.

4. Field Mapping Management provides steps and guides for field mappers and supervisors to use
mobile data collection applications, as well as providing tips for managing teams in the field.

5. Data Cleaning Upload and Quality Assurance covers the process of taking field mapped data
through cleaning and upload to OpenStreetMap while ensuring strong data quality.

6. Data Export Tools covers the various tools used for exporting data fromOpenStreetMap and which
tools are best for different use cases.

7. Data Use and Analysis provides an introduction to how data can be turned into effective maps for
decision making.

Toolbox Guides and Resources

Sections in this toolbox contain different types of guides, depending on their user and purpose. We’ve
made it easy to determine the type of guide or resource with the following icons.

This icon represents presentation slides that can be used to lead a training or workshop.

This icon represents step-by-step instructions that are designed to serve as self-paced material that can
be used both during trainings, and by self-guided learners.

This icon represents guides that are designed to assist project managers with making decisions that
impact project design and implementation.

This icon indicates additional resources that are recommended for reading outside of the HOT Toolbox.
These may or may not be resources created by or in partnership with HOT.

This icon indicates additional resources that are recommended for watching outside of the HOT Toolbox.
These may or may not be resources created by or in partnership with HOT.
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